# Table of Contents

**Chapter 1: Introduction iii**
- Document Assumptions iii
- Document Conventions iv
- About the Telnet Client iv
  - Telnet Client Overview v
  - Deployment Methods v
  - Telnet Client Components v
    - About Host Profiles vi
    - About Emulation Parameters vi
    - About Localization vi
    - About SSL vi
    - About Scripting vii
    - About Keyboard Creator vii
    - About Screen Reformatter vii
  - Telnet Client Functionality vii
- Voice-Enabled Emulation viii
- Terminology viii

**Chapter 2: Installation and Configuration ix**
- Installing the Telnet Client ix
  - Cold Boot Recovery x
- Configuring the Telnet Client x
  - Configuration Overview x
  - Configuration Support Matrix xii
  - Using Avalanche Console to Configure the Telnet Client xiii
  - Using Microsoft ActiveSync to Configure the Telnet Client xvi
- Deploying Configurations xvii
  - Deploying Configurations via Avalanche Console xvii
  - Preparing for Updates xvii
  - Downloading the Configuration to the Mobile Device xx
  - Deploying Configurations via Microsoft ActiveSync xxi

**Chapter 3: Host Profiles xxiii**
- Overview of Host Profiles xxiii
- Configuring a Host Profile xxv
  - Adding a Host Profile xxvi
  - Modifying an Existing Host Profile xxvii
  - Deleting a Host Profile xxviii
  - Subnet-Specific Addresses xxix
- Using Host Profile Command Prompts xxx
  - Launching Telnet via Command Prompt xxx
  - Creating a Command-Line URL Host Profile xxx
- Host Profiles and SSL xxxi
Installing the SSL Support Package on the Host System xxxi
Installing the SSL Support Package on the Mobile Device xxxi
Enabling SSL xxiii
Enabling Certificate Verification xxxiv
Host Profiles and Wavelink TermProxy xxvii
   Configuring a TermProxy-Only Connection xxvii
   Configuring TermProxy Failover xxviii
Host Profiles and WWAN Settings xli
Host Profile Settings xli
   Host Settings xlii
   TermProxy Settings xlv
   IBM Settings xlviii
   VT Settings lv
   WEB Settings lii
   Autologin Settings lii
   AutoLaunch Settings lv
   Configuration Settings lvii
   Language Settings lvii
   Modem Settings lviii
      Modem Advanced Settings (TCP/IP Properties) lxii

Chapter 4: Emulation Parameters lxvii
About Emulation Parameters lxvii
   About Per-Host Emulation Parameters lxvii
   About Global Emulation Parameters lxviii
Configuring Emulation Parameters lxviii
   Overview of Configuring Emulation Parameters lxviii
   Accessing Global Emulation Parameters lxviii
      Using Microsoft ActiveSync lxix
      Using Avalanche Console lxi
   Accessing Per-Host Emulation Parameters lxiii
      Using Microsoft ActiveSync lxiii
      Using Avalanche Console lxv
Using Configuration Manager lxvi
   Modifying Emulation Parameters lxviii
      Using the Find Function lxix
      Switching to Alphabetized View lxx

Chapter 5: Scripting lxxviii
Overview of Scripting lxxviii
Launching the Script Editor lxxiv
Creating Scripts Using the Script Editor lxxvi
   Configuring the Script Name lxxvi
   Selecting the Activation Method lxxvii
      Select from Menu lxxvii
      On Key Combination lxxviii
Table of Contents

When Session Connects lxxix
On Barcode, MSR or RFID Scan xc
On Screen Update xci
Creating the Script Code xcii
Creating Variables xcii
Persistent Variables xciii
Selecting Host Profiles xciv
Performing Script Capturing xcvi
Field Data ID Button xc
Editing Scripts xc
Importing Scripts xci
Saving and Exporting Scripts xii
Deploying Scripts xiii
Executing Scripts xiii
Select from Menu xiv
On Key Combination xv
When Session Connects xv
On Barcode, MSR, or RFID Scan xv
On Screen Update xv

Chapter 6: Keyboard Creator cvii
Overview of Keyboard Creator cvii
Launching the Keyboard Creator cvii
Selecting Keyboard Files cix
Creating Keyboards cx
Adding a new keyboard cx
Sizing Keyboards cxii
Deleting Keyboards cxii
Importing Keyboard Graphics cxiii
Creating and Configuring Keys cxiii
Adding a new key cxiv
Sizing and Positioning Keys and Rows cxvi
Deleting Keys cxvii
Deploying the Keyboard to the Telnet CE Client cxvii

Chapter 7: Resource Editor cxix
Overview of Resource Editor cxix
Launching the Resource Editor cxix
Using the Resource Editor cxx
Adding a Bitmap cxxi
Adding a Sound cxxi
Playing Sounds cxxi
Editing Files cxxii
Deploying Files to the Telnet CE Client cxxiii

Chapter 8: Licensing cxxv
Overview of Licensing  cxxv
  Authorization Methods cxxvi
Types of Licenses  cxxvii
  About Platform Licenses cxxvii
  About Maintenance Licenses cxxvii
Licensing Methods  cxxvii
  Manually Licensing the Telnet Client cxxviii
  Using License Server to License the Telnet Client cxxix
    Using a Local License Server cxxix
    Using a Remote or Specific License Server cxxx
  Using the Demo License cxxxi

Chapter 9: Using the Telnet Client cxxxiii
Using the Telnet Client and Connecting to Hosts  cxxxiii
  Launching the Telnet Client cxxxiii
    Launching the Telnet Client From Windows cxxxiv
    Launching the Telnet Client from Avalanche cxxxv
  Initiating a Telnet Session cxxvii
  Disconnecting a Telnet Session cxxxix
  Exiting the Telnet Client cxl
Working with Multiple Concurrent Telnet Sessions  cxli
  Overview of Multiple Concurrent Sessions cxli
  Initiating an Additional Telnet Session cxli
  Switching Between Active Telnet Sessions cxliii
  Disconnecting a Session cxliv
Using the Standard Virtual Emulation Keyboard  cxlv
  Using the Basic Virtual Emulation Keyboard cxlvi
  Using the 5250/3270 Virtual Emulation Keyboard cxlvii
  Using the VT/HP Virtual Emulation Keyboard cxlix
  Using the WEB Virtual Emulation Keyboard cli
Using Screen Panning  cliii
Using ActiveText  cliii
  Simple Number Menu Item cliv
  AS/400-Style Function Key cliv
Using the Telnet Client Diagnostics Utility  clv
  Accessing the Telnet Client Diagnostics Utility clv
  Performing a Keyboard Test clvi
  Performing a Scan Test clviii
  Performing a Windows Keyboard Test clix
Using the Telnet Client Options Menu  clx
Using the Screen Reformatter clxii

Chapter 10: Industrial Browser (WEB Emulation) clxv
Overview of the Industrial Browser  clxv
Licensing  clxv
Industrial Browser Host Profile Settings  clxvi
HTTP Proxy Tab clxvi
HTTPS Proxy Tab clxvii
Access List Tab clxix
Configuration Tab clxx

Using the Industrial Browser clxxi
Basic Navigation clxxii
Specifying the Home Page clxxii
Developing Web Pages for the Industrial Browser clxxiii

Chapter 11: Avalanche Integration clxxv
Overview of Avalanche Integration clxxv
Using Session Monitor clxxvi
Enabling Session Monitor clxxvi
Configuring Session Monitor clxxvi
Launching Session Monitor clxxviii
Session Override clxxix
Tracing Sessions clxxx
Using Real-Time Statistics clxxxi
Viewing Real-Time Statistics clxxxi
Modifying Real-Time Statistics clxxxv

Chapter 12: Manually Configuring the Telnet Client clxxvii
Manually Configuring Host Profiles clxxvii
Accessing Host Profiles clxxvii
Creating a New Host Profile clxxviii
Modifying an Existing Host Profile clxxxix
Deleting an Existing Host Profile cxc
Host Profile Settings cxci
  Edit Host Profile Parameters cxci
  More 5250 Options cxcii
  More VT Options cxciii
  Edit AutoLogin cxciv
Manually Configuring Emulation Parameters cxcv
Accessing and Modifying Per-Host Emulation Parameters cxcvi
Per-Host Emulation Parameters cxcvii
  VTXX Settings cxcvii
  IBM Host Settings cxcviii
  WEB Settings cxcix
  Message Settings cci
  Font Settings cciii
  Display Settings ccv
  View Settings ccvi
  Cursor Settings ccviii
  Beeps Settings ccx
  Telnet Settings ccx
  Printer Settings ccxi
Requirements ccxv
Overview of Creating a Partnership ccxv
Selecting the Microsoft ActiveSync Connection Method on the Mobile Device ccxv
Selecting the Microsoft ActiveSync Method on the Host System ccxvi
Freeing a COM Port ccxix
Creating a Partnership ccxix
   Creating a Standard Partnership ccxix
   Creating a Guest Partnership ccxiv
Configuring Passwords ccxxix
Configuring the Number of Concurrent Sessions ccxxx
Configuring IP Printing ccxxxii
Configuring License Server IP Address ccxxxiii
Configuring Telnet Client Display Settings ccxxxiv
Configuring Telnet Client Lockdown ccxxxv
Configuring Key Macros ccxxxvi
Configuring Screen Panning ccxxxviii
Configuring ActiveText ccxxxix
Configuring Scan Handlers ccxl
Configuring Autologin for VT Emulation ccxli
Configuring Autologin for 5250 Emulation ccxliv
Configuring Telnet Negotiation Strings for VT Emulation ccxlv
Configuring Workstation IDs for 5250/3270 Emulation ccxliv
Enabling Battery Strength and Signal Strength Icons ccxlvi
   Configuring Indicator Settings ccxlviii

Glossary ccliii

Index 1
Chapter 1: Introduction

This document provides information about installing, configuring, and using the Wavelink Telnet Client for Windows CE-based mobile devices.

This section provides the following information:

- Document Assumptions
- Document Conventions
- About the Telnet Client
- Terminology

Document Assumptions

This document assumes that the reader has the following:

- Familiarity with Windows CE operating systems and the mobile device to which you are deploying the Wavelink Telnet Client.

- Knowledge of wireless networks and wireless networking protocols (IEEE 802.11b).

- Knowledge of TCP/IP, including IP addressing, subnet masks, routing, BOOTP/DHCP, WINS, and DNS.

- Knowledge of Telnet services and terminal emulation, including IBM 5250/3270, HP, and VT100/220.

- Knowledge of Wavelink Avalanche Console and Avalanche Enablers (optional, for users that intend to install and configure the Telnet Client via Avalanche Console).
Document Conventions

The following table lists the document conventions used in this manual.

<table>
<thead>
<tr>
<th>Text Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Courier New</td>
<td>Any time you type specific information into a text box (such as a file name), that option appears in the Courier New text style. This text style is also used for any keyboard commands that you might need to press.</td>
</tr>
<tr>
<td>Bold</td>
<td>Any time you interact with an option (such as a button or descriptions of different options in a dialog box), that option appears in the Bold text style.</td>
</tr>
<tr>
<td>Italic</td>
<td>Any time this document refers to another section within the document, that section appears in the Italic text style. This style is also used to refer to the titles of dialog boxes.</td>
</tr>
</tbody>
</table>

Examples:

Courier New:
- Type Enter to continue.
- Press CTRL+ALT+DELETE.

Bold:
- Click Open from the File Menu.
- Select the Update option.

Italic:
- See Installing the Telnet Client on page 13 for more information.
- The Script Editor dialog box appears.

About the Telnet Client

This section provides an overview of the Telnet Client.
Telnet Client Overview

The Telnet Client is a Windows-based application that facilitates IBM 5250/3270, VT 100/220, HP Telnet, and WEB emulation.

Deployment Methods

Currently, you can use one of the following methods to install and configure the Telnet Client on a mobile device:

- **Microsoft ActiveSync.** You can install the Telnet Client configuration utility on a host PC. The configuration utility uses an ActiveSync connection between the host PC and the mobile device to deploy the Telnet Client and Telnet Client configurations to the mobile device.

- **Wavelink Avalanche Console.** If your mobile device is running the Avalanche Enabler, you can use Avalanche Console to deploy the Telnet Client and Telnet Client configurations to a mobile device.

- **Third-Party Applications.** Wavelink supports some third-party deployment applications. For more information about supported deployments for your device, please see the Telnet Client installation guide for your mobile device.

Telnet Client Components

The Telnet Client has a number of configurable components, including:

- Host profiles
- Emulation parameters
- Localization
- SSL settings
- Scripts
- Virtual keyboards
**NOTE** Scripts and virtual keyboard settings may only be deployed to mobile devices via Avalanche Console. If you are using Microsoft ActiveSync or a third-party application to deploy the Telnet Client and Telnet Client configurations to your mobile devices, you will need to manually transfer the script files and virtual keyboard files to each mobile device.

---

**About Host Profiles**

A host profile contains all of the information that a mobile device needs to connect to a particular host, including the IP address of the host, the TCP port number on which the host is listening for Telnet requests, the emulation type, and login information.

Host profiles provide an easy way for users at a mobile device to establish a connection with a host without having to remember the parameters that are required to establish the session.

**About Emulation Parameters**

The configuration utility allows you to configure the emulation parameters for Telnet sessions. For example, you can change the way the virtual screen displays on the mobile device, the type and size of font that is used, and the type of printer to which the mobile device may be connected.

You can configure global and per-host emulation parameters.

Global emulation parameters apply to terminal emulation with hosts for which you have not configured a per-host profile.

Configuring per-host emulation parameters allows you to specify the emulation parameters for terminal emulation sessions with a particular host.

**About Localization**

Localization allows you to deploy language profiles with the Telnet Client. The language profile allows you to convert common textual strings into a different language. The Telnet Client will then display the converted string rather than the native string.

**About SSL**

The Telnet Client allows SSL-encrypted Telnet connections between a mobile device and a host system. The Telnet Client also provides certificate verification for SSL connections. You may import your own trusted certificates into the Telnet Client, or you may use the Telnet Client installation
and configuration utility to create your own certificates, which you can then import to your Telnet server or Wavelink TermProxy server.

**About Scripting**

The Telnet Client provides automated services through scripting. For example, you might create a user-login script. Telnet Client scripting provides for the automatic generation of scripts through script recording. Alternatively, use the Script Editor to create your own scripts or to modify recorded scripts.

**About Keyboard Creator**

Use the Telnet Client Keyboard Creator to modify the standard Telnet Client virtual keyboards to meet the needs of your production environment. The Keyboard Creator allows you to completely modify the layout of the virtual keyboard for each emulation type. Additionally, import your own graphic files (bitmaps) to create your own unique buttons for the keyboard.

**About Screen Reformatter**

The Screen Reformatter (included in Telnet Client 7.1 and later versions) is an application that allows you to modify the appearance of Telnet Client emulation screens. You can create a screen layout that includes items you want the mobile device user to see, and does not include items that should not be visible to the user.

**Telnet Client Functionality**

The Telnet Client provides the following functionality:

- Use host profiles to initiate Telnet sessions with hosts.
- Connect to a host through Wavelink TermProxy.
- Engage in up to four simultaneous Telnet sessions.
- Configure Wavelink licensing.
- Configure new host profiles.
- View and modify certain per-host emulation parameters, including scan codes and symbologies.
- View the current device wireless and IP settings.
• View Telnet Client version information.

• Integration with the Avalanche framework to provide session monitoring and viewing of real-time statistics from the Avalanche Console.

• Use WEB Emulation to connect to web pages with your mobile device.

**Voice-Enabled Emulation**

Telnet Client version 7.0 and later supports Voice-Enabled Emulation, which is available in separate Avalanche packages. Voice-Enabled Emulation is a verbal communication system that facilitates real-time voice communication between a host computer and a mobile device user. For more information, refer to *Wavelink Telnet Client Voice-Enabled Emulation Reference Guide*.

---

**NOTE** To obtain Voice-Enabled Emulation packages, please contact Wavelink Customer Service. *Appendix C: Wavelink Contact Information* on page 247 provides Wavelink contact information.

---

**Terminology**

For conciseness and clarity, the term *Avalanche Console* applies to both Avalanche MC and Avalanche SE. This document will reference Avalanche Console for both products. For more information about each product, refer to the specific user guide.

For a complete list of Telnet Client terms and components, refer to the *Glossary* on page ccliii.
Chapter 2: Installation and Configuration

This section provides the following information:

• Installing the Telnet Client
• Configuring the Telnet Client
• Deploying Configurations

Installing the Telnet Client

This section provides an overview of the Telnet Client.

Currently, you can use one of the following methods to install the Telnet Client on a mobile device:

• Microsoft ActiveSync. You can install the Telnet Client configuration utility on a host PC. The configuration utility uses an ActiveSync connection between the host PC and the mobile device to deploy the Telnet Client and Telnet Client configurations to the mobile device.

• Wavelink Avalanche Console. If your mobile device is running the Avalanche Enabler, you can use Avalanche Console to deploy the Telnet Client and Telnet Client configurations to a mobile device.

• Third-Party Applications. Wavelink supports some third-party deployment applications. For more information about supported deployments for your device, please see the Telnet Client reference guide for your mobile device.

Because installation methods vary across mobile devices, each mobile device has its own reference guide. For information about installing the Telnet Client on your mobile device, please see the reference guide for that mobile device.

NOTE To obtain the reference guide for your mobile device, please contact Wavelink customer service. Appendix C: Wavelink Contact Information on page 247 contains Wavelink contact information.
**Cold Boot Recovery**

Telnet Client installations are designed to survive a device cold boot. Additionally, the Telnet Client is configured to automatically re-install in the event of a cold boot. The cold boot recovery process ensures that not only the Telnet Client application survives a cold boot, but also the Telnet Client configuration. Any deviation or exception to this process will be noted in the reference guide for your mobile device.

**NOTE** The Generic Telnet Client will not survive a cold boot.

To allow the Telnet Client to survive a cold boot, a backup copy of the Telnet Client is stored in the non-volatile (Flash) memory of the device. A copy of any configuration files for the Telnet Client are also stored in this location when they are downloaded to the mobile device.

Cold boot recovery processes vary across mobile devices. Each Telnet Client is designed to use the recovery method of the mobile device for which it has been designed.

**Configuring the Telnet Client**

This section provides the following information:

- Configuration Overview
- Configuration Support Matrix
- Using Microsoft ActiveSync to Configure the Telnet Client
- Using Avalanche Console to Configure the Telnet Client

**Configuration Overview**

Under most circumstances, you will use the same installation/configuration application to configure the Telnet Client that you used to deploy the Telnet Client to your mobile device.

The following tasks describe the process of configuring the Telnet Client:
1 Use the installation and configuration application to create and store Telnet Client configuration files on the host system.

2 Use the installation and configuration application to download the configuration files to the mobile device.

For example, if you installed the Telnet Client to a mobile device using the Microsoft ActiveSync installation and configuration utility, then you would also use the same utility to create the Telnet Client configuration files. After creating and saving the configuration files on the host system, you would then use the installation and configuration utility to push the configuration files down to the mobile device over an ActiveSync connection between the host system and the mobile device.

![Wavelink Product Configuration - WW000](image)

**Figure 2-1. ActiveSync Installation and Configuration Utility**

You may configure the following parameters and options for the Telnet Client:

- **Host Profiles.** A host profile contains all of the required information for a mobile device to connect to a host system, including an alias, IP address, TCP port, and other emulation-specific parameters. The Telnet Client
supports multiple host profiles to allow a user at the device to easily create a Telnet session with a host system.

- **Emulation Parameters.** Emulation parameters provide control over many aspects of an emulation session, including key macros, text and screen display, and barcode scanning. You may control the settings of an emulation session on a global level or on a per-host level.

- **Localization.** Localization allows you to convert strings of text from one language to another. Use the Localization tool to create conversions, then configure the Telnet Client to use the appropriate language. For example, you might create support files to convert server strings from English to Spanish.

- **SSL and SSL Certificates.** Some versions of the Telnet Client support encryption-protected Telnet connections via SSL. You may also configure the Telnet Client for SSL certificate validation. SSL is configured via host profiles. You may also use the configuration and installation utility to import certificates from trusted servers or to generate new certificates that you can then export to your Telnet or Wavelink TermProxy server(s).

- **Scripting.** Scripting allows you to automate functions within the Telnet Client. For example, you might create a login script for users. You may record scripts, or you may use the Script Editor to create new scripts or modify existing scripts.

- **Keyboard Builder.** Use the Keyboard Builder to generate virtual keyboards for your Telnet Client. You may create any number of virtual keyboards to meet the needs of your production environment.

- **Resource Editor.** The Resource Editor allows you to import graphic and sound files that can be deployed to your mobile devices. You may add, modify and deploy any .bmp or .wav file using the Resource Editor.

**Configuration Support Matrix**

Depending on the Telnet Client installation and configuration utility that you are using, the applications and tools that allow you to configure Telnet Client features may not be available. Table2-1 provides information about the
configuration tools that are available for your chosen installation and configuration method:

<table>
<thead>
<tr>
<th>Deployment Method</th>
<th>Host Profiles</th>
<th>Emulation Parameters</th>
<th>Localization</th>
<th>SSL Support</th>
<th>Scripting*</th>
<th>Keyboard Builder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avalanche</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ActiveSync</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Third-Party Application</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

* You may configure scripting through the Telnet Client interface on the mobile device

Table 2-1: Telnet Client Configuration Support Matrix

Using Avalanche Console to Configure the Telnet Client

You can use the Avalanche Console to update the Telnet Client configuration.

To configure the Telnet Client through Avalanche Console:

1. Ensure that the Telnet Client Avalanche package is installed in the Avalanche Console.

   **NOTE** For more information about installing the Telnet Client in Avalanche Console, see the reference guide for your mobile device.

2. Launch the Avalanche Console.

3. In the **Software Profiles** tab, locate the profile that contains the Telnet Client package.

4. In the **Software Packages** tab, select the Telnet Client software package and click **Configure**.

   The **Configure Software Package** dialog box appears.
5 From the menu list, select the component of the Telnet Client that you want to configure:

- Select **Host Profiles** to access the *Host Profiles* dialog box, which will allow you to configure host profiles and SSL settings for the Telnet Client.

**NOTE** For more information about configuring host profiles, see *Chapter 3: Host Profiles* on page 29.

- Select **Emulation Parameters** to access Configuration Manager, which will allow you to modify emulation parameters for the Telnet Client.

**NOTE** For more information about configuring emulation parameters, see *Chapter 4: Emulation Parameters* on page 63.

- Select **Script Editor** to access the script editor, which will allow you to import and configure scripts for the Telnet Client.
Chapter 2: Installation and Configuration

NOTE For more information about configuring scripts, see Chapter 5: Scripting on page 79.

- Select **Keyboard Creator** to access the Keyboard Creator, which will allow you to create and import virtual keyboards for the Telnet Client.

NOTE For more information about using the Keyboard Creator, see Chapter 6: *Keyboard Creator* on page 103.

- Select **Resource Editor** to access the Resource Editor, which will allow you to import and deploy graphic and sound files.

NOTE For more information about using the Resource Editor, see Chapter 7: *Resource Editor* on page 115.

- Select **Screen Reformatter** to access the Screen Reformatter, which will allow you to modify the appearance of Telnet Client emulation screens.

NOTE For more information about using the Screen Reformatter, see *Using the Screen Reformatter* on page clxii.

- Select **Localization** to configure the Localization settings for the Telnet Client.

- Select **Import/Export Settings** to save the current emulation settings or load a saved emulation settings file.

6 After you have configured the new settings for the Telnet Client, use the Avalanche Console to deploy the new configuration to the mobile device.

NOTE For information about deploying Telnet Client configurations to the mobile device, see *Deploying Configurations* on page xvii.
Using Microsoft ActiveSync to Configure the Telnet Client

Use the Microsoft ActiveSync installation and configuration utility to configure host profiles, emulation parameters, and localization. After you have created the configuration, push the configuration files to the mobile device over a Microsoft ActiveSync connection between the host system and the mobile device.

To configure the Telnet Client using Microsoft ActiveSync:

1 Ensure that the Microsoft ActiveSync Telnet Client installation and configuration utility is installed on the host system.

NOTE For more information about installing and using the Microsoft ActiveSync installation and configuration utility, see the Telnet Client reference guide for your mobile device.

2 Launch the installation and configuration utility on the host system.

   The Wavelink Product Configuration dialog box appears.

3 Click the icon button for the Telnet Client component that you want to configure:

   • Click the Host Profiles icon button to access the Host Profiles dialog box, which will allow you to configure host profiles and SSL settings for the Telnet Client.

   NOTE For more information about host profiles, see Chapter 3: Host Profiles on page 29.

   • Click the Emulation Parameters icon button to access Configuration Manager, which will allow you to configure emulation settings for the Telnet Client.

   NOTE For more information about emulation parameters, see Chapter 4: Emulation Parameters on page 63.
• Click the **Localization** icon button to access the *Localization* dialog box, which will allow you to configure localization settings for the Telnet Client.

4 After you have created the new configuration for the Telnet Client, use the installation and configuration utility to download the new configuration files to the mobile device over an ActiveSync connection between the host system and the mobile device.

---

**NOTE** For more information about deploying configuration, see *Deploying Configurations* on page xvii.

---

**Deploying Configurations**

This section provides the following information:

• Deploying Telnet Client configurations via Avalanche Console

• Deploying Telnet Client configurations via Microsoft ActiveSync

**Deploying Configurations via Avalanche Console**

Use the Avalanche Console to deploy new Telnet Client configurations to the mobile device.

Deploying Telnet Client configurations to the mobile device involves the following tasks:

1. Prepare Avalanche Console and the Avalanche Enabler on the mobile device for the update.

2. Create a connection to download the configuration to the mobile device.

**Preparing for Updates**

Avalanche Console provides communication between the Avalanche Server and the Avalanche Enabler on the mobile device over the following media:

• Serial port

• RAPI (Microsoft ActiveSync)
• IP

Before you can create a connection between the Avalanche Server and the mobile device over which the new configuration will be download, you must prepare both the mobile device and Avalanche Console for the update media.

Before you install the Telnet Client on a mobile device, ensure that the host system and the mobile device are properly configured.

Preparing the host system and the mobile device depends on the type of media that you are using to connect the host system to the mobile device.

Avalanche Console allows serial connections and RF connections.

**Preparing for Serial Updates**

Use the following guidelines to prepare the serial connection between the mobile device and Avalanche Console:

• Ensure that the Avalanche Enabler is installed and functioning properly on the mobile device.

• Ensure that the Avalanche Enabler on the mobile device is configured properly. If you have problems, verify the following:
  • The Avalanche Enabler is configured to use serial updates.
  • The Avalanche Enabler is configured with the IP address of the Avalanche Console.

• Ensure that the software profile in which you have installed the Telnet Client software package is configured to allow RF updates.

• Ensure that Avalanche Console is configured to use the serial port on the host system that is connected to the mobile device.

**Preparing for RAPI Updates**

Use the following guidelines to prepare the RAPI connection between the mobile device and the Avalanche Console:

• Ensure that your Avalanche Console supports RAPI gateways. (RAPI gateways are available in Avalanche Manager 3.5 and greater versions; and all versions of Avalanche MC and Avalanche SE.)
• Ensure that the Avalanche Enabler on the mobile device supports RAPI connections. (RAPI connections are supported in Avalanche Manager 3.5 and greater versions; and all versions of Avalanche MC and Avalanche SE.)

• RAPI support is only available for ActiveSync 3.8 and earlier versions.

• Because RAPI gateways use Microsoft ActiveSync, ensure that you can create a Microsoft ActiveSync connection between the mobile device and the host system (that is, the system that hosts the Avalanche Server).

• Ensure that you have created a RAPI gateway in Avalanche Console.

Preparation for IP Updates
Use the following guidelines to prepare the IP connection between the mobile device and the Avalanche Console:

• Ensure that the Avalanche Enabler is installed and functioning properly on the mobile device.

• Ensure IP connectivity between the mobile device and the host system. If you have problems, verify the following:
  • The host system has a valid IP address.
  • The mobile device has a valid IP address.
  • The mobile device is configured with the correct ESSID.
  • The mobile device is using the correct encryption key, if any type of encryption is enabled on the wireless LAN.
  • The host system has a valid IP route to the mobile device.
  • The mobile device has a valid IP route to the host system.
  • Any firewalls between the host system and the mobile device are configured to allow TCP traffic to port 1779 (the port that Avalanche uses for TCP communication).

• Ensure that the Avalanche Enabler on the mobile device is configured with the correct IP address of the Avalanche Console.
**Downloading the Configuration to the Mobile Device**

After you have prepared the synchronization medium, create a connection between the Avalanche Server and the mobile device to download the new configuration.

**To deploy the new configuration to the mobile device:**

1. Launch the Avalanche Console.

2. In the **Software Profiles** tab, select the profile that contains the Telnet Client package.

3. In the **Software Packages** tab, select the Telnet Client software package and click **Enable**.

   The software package is enabled and ready to download to mobile devices.

4. Use one of the following methods to update the client:

   - From the Avalanche Enabler on the mobile device, select **File > Connect**.

   - From the Avalanche Console, use the Task Scheduler to deploy the new configuration to your devices.

   - Wait for the mobile device to perform a periodic update according to the Avalanche Enabler configuration on the mobile device.

   - Wait until Avalanche Console instructs the mobile device to perform an update, which occurs according to the Scheduled Updates configuration of Avalanche Console.

   - For RAPI updates, connect the mobile device to the host system in a manner that will initiate a Microsoft ActiveSync connection between the mobile device and the host system.

When you create the connection between the host system and the mobile device, the configuration files are downloaded to the mobile device.
NOTE Only the configuration files that have changed are pushed down to the mobile device. The new configuration files replaced (overwrite) the existing configuration files on the device.

Deploying Configurations via Microsoft ActiveSync

Use a Microsoft ActiveSync connection between the host system and the mobile device to download new Telnet Client configurations to the mobile device.

To deploy a new configuration to the mobile device using Microsoft ActiveSync:

1. Ensure that you have a Microsoft ActiveSync between the host system and the mobile device.

NOTE For more information about using Microsoft ActiveSync, see Appendix A: Using Microsoft ActiveSync on page 211.

2. Launch the Microsoft ActiveSync Telnet Client installation and configuration utility.

   The Wavelink Product Configuration dialog box appears.

3. Click Config Only.

   The new configuration is downloaded to the mobile device. Any existing Telnet Client configuration files on the mobile device are overwritten.

NOTE All configuration files, including those for host profiles, emulation parameters, and localization settings are downloaded to the mobile device when you click the Config Only button.
Chapter 3: Host Profiles

This section provides the following information:

• Overview of Host Profiles
• Configuring a Host Profile
• Host Profiles and SSL
• Host Profiles and Wavelink TermProxy
• Host Profiles and WWAN Settings
• Host Profile Settings

Overview of Host Profiles

A host profile defines the parameters that the Telnet Client should use when it attempts to initiate a Telnet connection with a specific host. You may configure as many host profiles for the Telnet Client as you wish.

When a user at the mobile device attempts to use the Telnet Client to initiate a Telnet session with a host, the Telnet Client displays a list of available host profiles.
The user selects the host to which they wish to connect, and the Telnet Client uses the host profile settings to attempt to establish a session with the host.

You may configure the following settings for a host profile:

- **Alias.** This is the alias of the connection. Use a name that adequately describes the host system to which the user is connecting.

- **Emulation Type.** This is the emulation type that the Telnet Client should use when connecting to the host system.

- **IP Address.** This is the IP address of the host system to which the user is connecting.

- **Port.** This is the TCP listening port of the host system.

- **SSL Settings.** You may select to protect the Telnet connection to the host system via SSL. You may also configure the SSL connection for certificate validation and import trusted certificates.
• **TermProxy Settings.** You may configure the Telnet Client to connect to a Wavelink TermProxy server. You may define up to three TermProxy connections for failover purposes. You may configure the TermProxy connection to use SSL with certificate validation.

• **Language.** If your Telnet Client supports the language feature, you may configure the Telnet Client to display a certain set of characters while connected to the host system.

• **Workstation ID.** If you have configured the host profile for IBM-type emulation, then you may configure a unique and/or dynamic workstation ID that the Telnet Client will use when connecting to the host system.

• **Telnet Negotiation String.** If you have configured the host profile for VT-type emulation, then you may configure a Telnet negotiation string that the Telnet Client will use when connecting to the host system.

• **Autologin.** If you have configured the host profile for VT-type emulation, then you may configure autologin settings that the Telnet client will use when connecting to a host system.

• **Host-Specific Emulation Parameters.** You may configure host-specific emulation parameters. These parameters will override global emulation parameter settings during Telnet connections to the host system that the host profile specifies.

• **Modem.** You may configure the Telnet connection to use a cellular modem for when the wireless LAN is not available. The cellular modem may use a GPRS service or a modem connection. This option is available on Windows Mobile 5 devices and later. Windows CE devices are not supported.

### Configuring a Host Profile

Use the Host Profiles dialog box to configure host profiles. See Chapter 2: Installation and Configuration on page 13 for information about using your specific installation and configuration utility to access the Host Profiles dialog box.
Each host profile that you configure appears in the left panel of the Host Profiles dialog box. Use the arrow buttons at the bottom of the left panel to reorder profiles in the list.

The following tasks outline the process of configuring host profiles for the Telnet Client:

1. Access the Host Profiles dialog box.

2. Add, modify, or remove host profiles and save the changes.

3. Download the configuration to mobile devices.

When you save the host profiles that you have configured, the changes you have made are saved to a configuration file.

**Adding a Host Profile**

You can use the Host Profiles dialog box to create a new host profile.
To create a new host profile:

1. Access the Host Profiles dialog box.

2. In the Host Profiles dialog box, click New.

   Various tabs appear in the Host Profiles dialog box that allow you to configure the parameters for a new host profile. The tabs that appear are dependent on the type of emulation that you select for the host profile. The Host Profiles dialog box automatically defaults to an IBM 5250 emulation type.

3. Use the tabs in the Host Profiles dialog box to configure the host profile.

   The name (alias) of the host profile appears in the left text box of the Host Profiles dialog box.

   NOTE For information about the various tabs in the Host Profiles dialog box, see Host Profile Settings on page xli.

4. After you have finished configuring the host profile, click OK.

   The new host profiles configuration is saved to the host system.

5. Download the new host profiles configuration to the mobile device.

   NOTE For information about using the Microsoft ActiveSync utility or the Avalanche Telnet Client to download configurations to mobile devices, see Deploying Configurations on page 20.

   NOTE To exit the Host Profiles dialog box without saving the changes that you have made, click Cancel.

Modifying an Existing Host Profile

You can use the Host Profiles dialog box to modify an existing host profile.

To modify an existing host profile:

1. Access the Host Profiles dialog box.
2 From the list of host profiles in the text box in the left of the dialog box, select the host profile that you want to modify.

3 Use the various tabs in the Host Profiles dialog box to configure the host profile.

**NOTE** For information about the parameters in the various tabs of the Host Profiles dialog box, see Host Profile Settings on page xli.

4 After you have finished modifying the host profile, click OK.

   The new host profiles configuration is saved to the host system.

5 Download the new host profiles configuration to the mobile device.

**NOTE** For information about using the Microsoft ActiveSync utility or the Avalanche Telnet Client to download configurations to mobile devices, see Deploying Configurations on page 20.

**NOTE** To exit the Host Profiles dialog box without saving the changes that you have made, click Cancel.

### Deleting a Host Profile

You can use the Host Profiles dialog box to delete an existing host profile.

1 Access the Host Profiles dialog box.

2 In the text box on the left side of the Host Profiles dialog box, select the host profile that you want to remove.

3 Click Delete.

   The host profile is removed from the Host Profiles dialog box.

4 After you have finished configuring the host profile, click OK.

   The new host profiles configuration is saved to the host system.
5  Download the new host profiles configuration to the mobile device.

**NOTE** For information about using the Microsoft ActiveSync utility or the Avalanche Telnet Client to download configurations to mobile devices, see *Deploying Configurations* on page 20.

**NOTE** To exit the Host Profiles dialog box without saving the changes that you have made, click **Cancel**.

**Subnet-Specific Addresses**

When creating a host profile, you may enter a subnet-specific address rather than an IP address or a DNS name. A subnet-specific Telnet address will have the following format: 0.X.X.X/X. The specified address is combined with the mobile device IP address to determine the host’s address. The number after the slash determines the number of bits of the subnet-specific address that should be ignored. This is usually the same as the number of bits at the start of the subnet mask.

Examples:

For a mobile device with an IP address of 10.20.30.40:

- When connecting to a subnet-specific address of 0.1.2.3/8, the device will look for a host at 10.1.2.3.
- When connecting to a subnet-specific address of 0.0.2.3/16, the device will look for a host at 10.20.2.3.
- When connecting to a subnet-specific address of 0.0.0.3/24, the device will look for a host at 10.20.30.3.

Subnet-specific addressing is also available for WEB emulation. However, you should use a | character instead of a / character to denote the number of bits.

Examples:

For a mobile device with an IP address of 10.20.30.40:
• When connecting to a subnet-specific address of http://0.1.2.3|8, the device will look for a host at http://10.1.2.3/.

• When connecting to a subnet-specific address of https://0.0.0.3|24:8080/start.asp, the device will look for a host at https://10.20.30.3:8080/start.asp.

**Using Host Profile Command Prompts**

The Telnet Client supports two command-line arguments: one that launches the Telnet Client from the command line, and one that creates a host profile which connects to a specific URL.

**Launching Telnet via Command Prompt**

You can use the command prompt to launch the Telnet Client.

**To launch Telnet:**

1. Open a command prompt.

2. Type `TelnetCE /profile` followed by the name of the host profile to which you want to connect.

3. Press Enter.

   The Telnet session is launched and connects to the specified host profile.

**Creating a Command-Line URL Host Profile**

You can use the command prompt to create a new host profile that connects to a specified URL.

**To create a command-line URL host profile:**

1. Open a command prompt.

2. Type `/url` followed by the URL to which you want to connect.

3. Press Enter.

   A new Telnet session is launched, and a new Command-Line URL host profile is created.
Host Profiles and SSL

The Telnet Client supports encryption-protected Telnet sessions via SSL. The Telnet Client supports SSL Telnet connections to host servers, as well as to the Wavelink TermProxy server.

**NOTE** Wavelink TermProxy provides SSL support for connections between the mobile device and the TermProxy server. Wavelink TermProxy does not support SSL connections between the TermProxy server and host systems.

The Telnet Client also supports certificate validation for SSL connections.

To enable and use SSL for the Telnet Client requires the following:

- Install the SSL support package on the host system.
- Install the SSL support package on the mobile device.
- Enable SSL for the host profile.
- Enable certificate validation for the host profile and import server certificates (optional, if you want to use SSL with certificate verification).

**Installing the SSL Support Package on the Host System**

Before you can begin configuring SSL and SSL certificates from the installation and configuration utility that you are using, you must install the SSL support package on the host system.

The SSL support package is a self-extracting executable that installs the required files that will allow you to configure SSL and SSL certificates.

**NOTE** To obtain the SSL support package, please contact Wavelink customer service. Appendix C: Wavelink Contact Information on page 247 contains Wavelink contact information.

**Installing the SSL Support Package on the Mobile Device**

The Telnet Client will not be able to initiate SSL connections with hosts until you install the SSL support package on the mobile device.
Use one of the following methods to deploy the SSL support package to the mobile device:

- **Avalanche Console.** The SSL support package is available as an Avalanche software package.

- **Microsoft ActiveSync.** The SSL support package is available as a bundled package that you can deploy over a Microsoft ActiveSync connection between a host system and the mobile device.

- **Third-Party Application.** The SSL support package is available for some third-party deployment applications.

**NOTE** To obtain the SSL support package for the mobile device, please contact Wavelink customer service. *Appendix C: Wavelink Contact Information* on page 247 contains Wavelink contact information.

**Enabling SSL**

SSL is enabled via the *Host Profiles* dialog box. It enabled on a per-host profile basis.

When you configure a host profile to use SSL, the TCP port for the host profile is automatically changed to 992, which is the well-known port number for SSL Telnet communication. If the host system uses a different port, then change the port to the correct setting.

**To configure a host profile to use SSL:**

1 Access the *Host Profiles* dialog box.

2 From the left panel of the dialog box, select the host profile that you want to configure.

3 Depending on the connection requirements for the host profile, select one of the following:
   - If the host profile specifies a direct connection to a server, then enable the *Use SSL/TLS Encryption* option box in the *Host* tab.
   - If the host profile specifies a connection to a Wavelink TermProxy server, then enable the *Use SSL/TLS Encryption* option box in the *TermProxy* tab.
NOTE You will not be able to configure the **Use SSL/TLS Encryption** option box in the TermProxy tab until you select an option from the TermProxy Server menu list.

![Host Profiles](image)

**Figure 3-3. Enabling SSL for a Host Profile**

4 After you have finished configuring the host profile, click **OK**.

The new host profiles configuration is saved to the host system.

5 Download the new host profiles configuration to the mobile device.

NOTE For information about using the Microsoft ActiveSync utility or the Avalanche Telnet Client to download configurations to mobile devices, see *Deploying Configurations* on page 20.
Enabling Certificate Verification

When SSL is enabled, you may configure the Telnet Client to perform certificate verification. This prevents the Telnet Client from connecting to unauthorized servers.

Use the Host Profiles dialog box to import trusted certificates, which you can then download to the mobile device using the installation and configuration utility. When certificate verification is enabled for a host profile, the Telnet Client will test the credentials of the host system against the imported certificates and will refuse connections with host systems that present a certificate that is not in its list of imported certificates.

To enable certificate validation and import valid certificates:

1. Access the Host Profiles dialog box.
2. From the left panel of the dialog box, select the host profile that you want to configure.
3. Depending on the connection requirements for the host profile, select one of the following:
   • If the host profile specifies a direct connection to a host, then enable the Verify Server Certificates option box in the Host tab.
   • If the host profile specifies a connection to a Wavelink TermProxy server, then enable the Verify Server Certificates option box in the TermProxy tab.
4 Click the corresponding Select Verification Certificates button. The Certificate Manager dialog box appears.

5 Click Insert Certificate... to browse to and import a server certificate.

6 Click Create Certificate... to create a certificate and private key that you can then export to a TermProxy server or other host system.
NOTE The certificates that you import and/or configure are available for all host profiles that you configure. The imported certificates should be considered a database or list of certificates against which the Telnet Client will check when initiating an SSL Telnet session with a host. If the host does not present a certificate that is in the list, then the Telnet Client will not establish a connection with the host.

7 After you have finished importing/configuring certificates, click OK.

The Certificate Manager dialog box closes.

8 Click OK to close the Host Profiles dialog box and save your new host profile settings.

9 Download the new host profiles configuration to the mobile device.
**Host Profiles and Wavelink TermProxy**

The Telnet Client provides integration with Wavelink TermProxy. TermProxy provides proxy services, mainly for session persistence, between the Telnet Client and host systems.

---

**NOTE** For more information about Wavelink TermProxy, refer to *Wavelink TermProxy Version 4.0 User Guide*.

---

You may use the *Host Profiles* dialog box to configure the following:

- TermProxy-only connections
- TermProxy-failover connections

---

**NOTE** TermProxy support (via the *Host Profiles* dialog box) is only available in version 5.0 (and greater) of the Telnet Client. While TermProxy 2.x allows connections from any type of Telnet Client, TermProxy 3.x requires connections from a 5.0 (or greater) Telnet Client.

---

**Configuring a TermProxy-Only Connection**

By default, if the Telnet Client cannot connect to the specified TermProxy server, then it will attempt a direct connection to the host. You may, however, configure the Telnet Client to only connect to a host through a Wavelink TermProxy server.

**To configure a TermProxy-only connection to a host system:**

1. Access the *Host Profiles* dialog box.
2. Select the host profile that you want to configure.
3. In the *Host* tab, enable the *Only Use TermProxy Connections* checkbox.
4 Use the TermProxy tab to configure the settings for the TermProxy server.

NOTE For more information about settings in the TermProxy tab, see Host Profile Settings on page xli.

5 After you have finished configuring the host profile, click OK.

The new host profiles configuration is saved to the host system.

6 Download the new host profiles configuration to the mobile device.

Configuring TermProxy Failover

Use the TermProxy tabs in the Host Profiles dialog box to configure host and TermProxy failover. You may configure up to three failover connections for a host profile.

When the Telnet Client attempts to use the host profile to initiate a connection with a host, it will attempt connections in the following order:
• Host specified in the **Host** tab of the host profile. (If you have specified a TermProxy-only connection, then it will attempt the host specified in the **TermProxy 1** tab.)

• Host specified in the **TermProxy 1** tab

• Host specified in the **TermProxy 2** tab

• Host specified in the **TermProxy 3** tab

If the Telnet Client is unable to contact any of the specified host, then it will return an error message.

**To configure TermProxy failure for a host profile:**

1. Access the *Host Profiles* dialog box.

2. Select the host profile for which you want to configure TermProxy failover.

3. Configure the **Host** tab.

4. Configure the **TermProxy 1** tab.
5 Configure the **TermProxy 2** tab

6 Configure the **TermProxy 3** tab

**NOTE** For more information about the settings in the **Host** and **TermProxy** tabs, see *Host Profile Settings* on page xli.

7 After you have finished configuring the host profile, click **OK**.

   The new host profiles configuration is saved to the host system.

8 Download the new host profiles configuration to the mobile device.

**NOTE** For information about using the Microsoft ActiveSync utility or the Avalanche Telnet Client to download configurations to mobile devices, see *Deploying Configurations* on page 20.
Host Profiles and WWAN Settings

You can configure WWAN settings for your host profiles. This is only if you are using GPRS connections or a modem. The options you configure for WWAN are dependent on your network environment as well as your cellular carrier.

Refer to *Modem Settings* on page lviii for details about each option available.

![Host Profiles](image)

**Figure 3-8. WWAN Settings**

Host Profile Settings

This section describes the parameters of each tab in the *Host Profiles* dialog box.
Host Settings

Use the Host tab in the Host Profiles dialog box to configure the basic settings of the host profile.

Figure 3-9. Configuring Host Settings
The following list describes the options and configurable parameters in the **Host** tab.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Indicates the name of the host profile, which should be synonymous with the name (alias) of the host system to which the mobile device connects when the host profile is used.</td>
</tr>
<tr>
<td></td>
<td>Possible Values: 1 - 50 alpha-numeric characters</td>
</tr>
<tr>
<td></td>
<td>Default Value: New Host</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Indicates the type of emulation that the mobile device uses when connected to the host system.</td>
</tr>
<tr>
<td></td>
<td>Possible Values: &lt;IBM-5251-11&gt; &lt;IBM-3278-2&gt; &lt;IBM-3279-2&gt; &lt;IBM-3279-2-E&gt; &lt;VT100&gt; &lt;VT220&gt; &lt;HP&gt; &lt;WEB&gt;</td>
</tr>
<tr>
<td></td>
<td>Default Value: &lt;IBM-5251-11&gt;</td>
</tr>
<tr>
<td><strong>Address</strong></td>
<td>Indicates the IP address or host name of the host system to which the mobile device will connect.</td>
</tr>
<tr>
<td></td>
<td>Possible Values: Any valid IP address, host name, or web address.</td>
</tr>
<tr>
<td></td>
<td>Default Value: &lt;None&gt;</td>
</tr>
<tr>
<td><strong>Port</strong></td>
<td>Indicates the TCP port number on which the host system is listening for Telnet requests from clients.</td>
</tr>
<tr>
<td></td>
<td>Possible Values: 0 - 65535</td>
</tr>
<tr>
<td></td>
<td>Default Value: 23</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Only Use TermProxy Connections</td>
<td>Indicates whether the Telnet Client should only connect to the host through a TermProxy server. If you enable this checkbox, you must configure the host information (name, IP address, emulation type, and port) and you must also configure the TermProxy tab.</td>
</tr>
<tr>
<td>Use SSL/TLS Encryption</td>
<td>Indicates whether the Telnet Client should use SSL to connect to the host system. When you enable SSL/TLS, the port will automatically change to 992, which is the well-known port for SSL Telnet communication.</td>
</tr>
<tr>
<td>Verify Server Certificates</td>
<td>Indicates whether the Telnet Client should use certificate verification before allowing a connection to the host. If you enable certificate verification, then use Certificate Manager to import trusted server certificates and/or to create your own server certificates.</td>
</tr>
<tr>
<td>Select Verification Certificates</td>
<td>Click this button to access the Certificate Manager, which allows you to import trusted server certificates and/or create your own server certificates for SSL certificate verification.</td>
</tr>
</tbody>
</table>
Use SSH encryption

Enable this option if you want to use SSH to encrypt the data between TermProxy and the host. If you enable this option, the Use SSL/TLS encryption option will disable.

NOTE Telnet supports both SSH and SSH2.

Tunnel Telnet using SSH Local Port Forwarding

Enable this option if you want to connect to a standard Telnet by tunneling through a SSH server.

Address

Enter the IP address of the SSH host that will perform the tunneling.

Port

Enter the port of the SSH host that will perform the tunneling.

TermProxy Settings

You may configure up to three TermProxy connections. Use the TermProxy tabs to specify the parameters of the TermProxy connection.
The following list describes the configurable options in the **TermProxy** tab:

**TermProxy Server**
Select the TermProxy server to which the Telnet Client will connect.

**Possible Values:**
- **None.** Specifies no TermProxy or alternate host is used.
- **Version 2.x.** Specifies TermProxy 2.x. TermProxy 2.x will accept connections from any Telnet Client.
- **Version 3.x.** Specifies TermProxy 3.x. TermProxy 3.x will only accept connections from 5.x (or greater) Telnet Clients.
- **Version 4.x.** Specifies TermProxy 4.x.
- **Alternate Telnet Host.** Specifies an alternate host system for failover purposes.

**Default Value:** <None>

**Address**
Indicates the IP address of the TermProxy server or alternate host system.

**Possible Values:** Any valid IP address

**Default Value:** None

**Port**
Indicates the TCP listening port of the TermProxy server or alternate host system.

**Possible Values:** 0 - 65535

**Default Value:** 4430
**Terminate TermProxy Session**

Indicates when the Telnet Client should terminate the connection to the TermProxy server.

**Possible Values:**

- **Never.** The Telnet Client never terminates the session established with the TermProxy server. The TermProxy server is responsible for terminating the session.

- **On Network Error.** The Telnet Client terminates the session with the TermProxy server when a network error occurs, such as a loss of network connectivity.

- **On Session Exit.** The Telnet Client terminates the session with the TermProxy server when it disconnects from the host system.

- **Always.** The Telnet Client will terminate the session with the TermProxy server on a network error or when it disconnects from the host system.

**Default Value:** <On Session Exit>

**Reconnect String**

Specifies the reconnect string that the mobile device should use when connecting to the host. (You may also configure reconnect strings in TermProxy.)

**Possible Values:** Any valid reconnect string

**Default Value:** None

**Use SSL/TLS Encryption**

Specifies whether the Telnet Client should use SSL to connect to the TermProxy server or alternate Telnet host. (TermProxy 2.x does not support SSL connections.)

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>
Verify Server Certificates

Indicates whether the Telnet Client should use certificate verification before allowing a connection to the TermProxy server or alternate Telnet host. If you enable certificate verification, then use Certificate Manager to import trusted server certificates and/or to create your own server certificates.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Select Verification Certificates

Click this button to access the Certificate Manager, which allows you to import trusted server certificates and/or create your own server certificates for SSL certificate verification.

Use Custom encryption

Enable the Use Custom encryption option to encrypt data between the mobile device and the TermProxy server.

Key

Once you enable the Use Custom encryption option, the Key text box is active. Type the password specified in the TermProxy configuration in the text box.

IBM Settings

Use the IBM Settings tab of the Host Profiles dialog box to configure the creation of a dynamic name for mobile devices that are loaded with this host profile.

The IBM Settings tab only appears you have configured the host profile for an IBM-type emulation in the Host tab.
Figure 3-10. Configuring IBM Settings
The following list provides information about the configurable parameters in the IBM Settings tab.

**Workstation ID**

Indicates the workstation ID that mobile devices use to connect to the host system. This includes static characters and the following switches, which are used to capture dynamic data that is specific to each mobile device:

- **%a - %d.** Captures specific octets of the IP address of the mobile device. For example, use %a%b%c%d to capture all four IP octets of the address of the mobile device, or use %d to capture only the last octet of the IP address of the mobile device.

- **%m - %r.** Captures specific octets of the MAC address of the mobile device. (For example, use %p%q%r to capture the last three octets of the MAC address of the mobile device.)

- **%s.** Captures the session number.

- **%t.** Captures the Avalanche terminal ID of the mobile device. (If the mobile device is not an Avalanche client, then this parameter is not valid.)

**Possible Values:** 0 - 20 alpha-numeric characters plus switches (see above)

**Default Value:** None

**NOTE:** IBM hosts usually truncate workstation IDs that are more than 10 characters. Also, the workstation ID should not begin with a numeric character.

**VT Settings**

Use the VT Settings tab in the Host Profiles dialog box to configure a Telnet negotiation string for the host connection.
A Telnet negotiation string allows you to specify the function or type of mobile device that is sending the Telnet request to the host system. The host system can then supply information to the mobile device based on Telnet negotiation string (for example, menus or display options).

The **VT Settings** tab only appears if you have configured the host profile for VT- or HP-type emulation in the **Host** tab.

![Host Profiles](image)

**Figure 3-11. Configuring VT Settings**

The following list describes the configurable parameters in the **VT Settings** tab.

- **Telnet Negotiation String**
  - Specifies the Telnet negotiation string that the client should use when connecting to the host system.
  - **Possible Values:** 0 - 20 alpha-numeric characters
  - **Default Value:** <None>
WEB Settings

When you configure the host profile for WEB-type emulation, various tabs appear offering different options for WEB settings.

Figure 3-12. Configuring WEB Settings

For instructions on configuring each WEB Settings tab, see Industrial Browser Host Profile Settings on page 162.

Autologin Settings

Use the Autologin tab in the Host Profiles dialog box to configure autologin parameters for the mobile device, such as a user name and password.
Figure 3-13. Configuring Autologin Settings

The following list describes the configurable options Autologin tab.

**Name - Prompts**

Indicates the user name prompt that the host system uses.

**Possible Values:** 0 - 60 alpha-numeric characters

**Default Value:** login:

**Name - CFG in terminal**

Indicates whether users should configure the response to the login prompt at the mobile device.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>
<table>
<thead>
<tr>
<th>Name - Responses</th>
<th>Indicates the response that the mobile device should send to the login prompt.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values:</strong></td>
<td>0 - 30 alpha-numeric characters</td>
</tr>
<tr>
<td><strong>Default Value:</strong></td>
<td>&lt;None&gt;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Password - Prompts</th>
<th>Indicates the password prompt that the host system uses.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values:</strong></td>
<td>0 - 60 alpha-numeric characters</td>
</tr>
<tr>
<td><strong>Default Value:</strong></td>
<td>&lt;None&gt;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Password - CFG in terminal</th>
<th>Indicates whether users should configure the response to the password prompt at the mobile device.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values:</strong></td>
<td>&lt;Enabled&gt; &lt;Disabled&gt;</td>
</tr>
<tr>
<td><strong>Default Value:</strong></td>
<td>&lt;Disabled&gt;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Password - Responses</th>
<th>Indicates the password that the mobile device should send to the host system at the password prompt.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values:</strong></td>
<td>0 - 30 alpha-numeric characters</td>
</tr>
<tr>
<td><strong>Default Value:</strong></td>
<td>&lt;None&gt;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command - Prompts</th>
<th>Indicates the command prompt that the host system sends to the Telnet Client after the login is complete.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Values:</strong></td>
<td>0 - 60 alpha-numeric characters</td>
</tr>
<tr>
<td><strong>Default Value:</strong></td>
<td>&lt;None&gt;</td>
</tr>
</tbody>
</table>
Chapter 3: Host Profiles

**Command - CFG in terminal**
Indicates whether users should configure the response to the command line prompt at the mobile device.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>

**Command - Responses**
Indicates the command that the mobile device should send the host system at the command prompt.

**Possible Values:** 0 - 30 alpha-numeric characters

**Default Value:** <None>

**AutoLaunch Settings**
Use the **AutoLaunch** tab in the *Host Profiles* dialog box to configure the host profile to automatically launch when Telnet starts.

![Host Profiles Dialog](image)

**Figure 3-14. Configuring AutoLaunch Settings**
The following options are available:

**No AutoLaunch**    Select this option to disable AutoLaunch.

**Session 1**    Select this option to automatically launch the Session 1 host profile.

**Session 2**    Select this option to automatically launch the Session 2 host profile.

**Session 3**    Select this option to automatically launch the Session 3 host profile.

**Session 4**    Select this option to automatically launch the Session 4 host profile.

Telnet will automatically launch the first profile in the host profiles list that is configured for AutoLaunch. If you want to automatically launch more than one profile, you must increase the number of sessions specified in the emulation parameters. For more information, see *Configuring the Number of Concurrent Sessions* on page 227.

To launch the next host profile in the list, select **Term** and then the desired session from the Telnet main menu.

---

**NOTE** Each host profile is automatically launched only once each time the program runs.

---

**Configuration Settings**

Use the **Configuration** tab in the *Host Profiles* dialog box to access and configure per-host emulation parameters.

---

**NOTE** For more information about global and per-host emulation parameters, see *Chapter 4: Emulation Parameters* on page 63.
Figure 3-15. Configuring Per-Host Emulation Settings

The following list describes the options in the Configuration tab.

Modify
Click this button to access Configuration Manager and modify the emulation parameters for the host connection.

Reset
Click this button to reset the emulation parameters for the host connection back to the default settings.

Language Settings
Use the Language tab in the Host Profiles dialog box to configure Telnet Client language support.
The following list describes the options in the Language tab:

**Display Language**  Indicates the language to be used for the Telnet Client display.

**Server Language**  Indicates the language to be used for the server.

**Keyboard Type**  Indicates the keyboard to be used with the specified language.

**Modem Settings**

Modem settings are based entirely upon your carrier as well as the way you want to set up your system. The following list provides information about each of the settings available in the Modem tab, however you may need to contact your cellular provider and network administrator for information regarding specific setup.
Figure 3-17. Modem Options
The following list describes the options in the **Modem** tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection name, or blank to not use modem</strong></td>
<td>Indicates the name of the modem connection. Leave the connection name blank if the host profile does not use a modem connection.</td>
</tr>
<tr>
<td></td>
<td>If the profile will be using one of the device’s existing modem connections, then specify the name of that connection. Each different connection must have a unique connection name.</td>
</tr>
<tr>
<td></td>
<td>Possible Values: 1 - 20 alpha-numeric characters</td>
</tr>
<tr>
<td></td>
<td>Default Value: &lt;None&gt;.</td>
</tr>
<tr>
<td><strong>Overwrite this connection if it exists on the device</strong></td>
<td>Indicates whether the Telnet Client should overwrite the connection if the connection is already on the device.</td>
</tr>
<tr>
<td></td>
<td>Enable this option if anything about the connection must be changed.</td>
</tr>
<tr>
<td></td>
<td>Disable this option if the profile will be using one of the device’s existing modem connections.</td>
</tr>
<tr>
<td></td>
<td>Possible Values: &lt;Enabled&gt; &lt;Disabled&gt;</td>
</tr>
<tr>
<td></td>
<td>Default Value: &lt;Disabled&gt;</td>
</tr>
<tr>
<td><strong>Auto-disconnect modem when all sessions end</strong></td>
<td>Indicates whether the Telnet Client should disconnect this modem connection after all Telnet sessions that use it have ended.</td>
</tr>
<tr>
<td></td>
<td>This option works with GPRS connections (that have an Access Point Name) when the <strong>Use wireless LAN if available</strong> is disabled.</td>
</tr>
<tr>
<td></td>
<td>This option also works with PPP connections (that use Dialing Instructions).</td>
</tr>
<tr>
<td></td>
<td>Possible Values: &lt;Enabled&gt; &lt;Disabled&gt;</td>
</tr>
<tr>
<td></td>
<td>Default Value: &lt;Enabled&gt;.</td>
</tr>
</tbody>
</table>
Chapter 3: Host Profiles

Use wireless LAN if available
When enabled and the device has a wireless LAN connection, the Telnet Client does not make the modem connection.

When disabled, the Telnet Client always uses the modem connection.

Possible Values: <Enabled> <Disabled>
Default Value: <Enabled>

Select connection details
To use a GPRS service for the connection, select Access Point Name.

To use a dial-up modem connection, select Dialing Instructions.

Possible Values: <Access Point Name> <Dialing Instructions>
Default Value: <Access Point Name>

Access Point Name (APN) or Number
If the connection details is set to Access Point Name, then specify the APN. (The name of the GPRS gateway, obtained from the cellular service provider.)

If the connection details is set to Dialing instructions, enter the number exactly as it should be dialed

Possible Values: 1 - 150 alpha-numeric characters
Default Value: <None>

User name
The user name to be used during authentication.

Possible Values: 1 - 30 alpha-numeric characters
Default Value: <None>
Password

The password to be used during authentication.

Possible Values: 1 - 100 alpha-numeric characters
Default Value: <None>

Domain

The domain to be used during authentication. This should be provided by the ISP or network administrator.

Possible Values: 1 - 150 alpha-numeric characters
Default Value: <None>

Modem Advanced Settings (TCP/IP Properties)

You can get IP settings assigned automatically if your network supports this capability. Otherwise, you need to ask your network administrator for the appropriate IP settings:

- Obtain an IP address automatically
- Use the following IP address:
  - IP address:

- Obtain DNS server address automatically
- Use the following DNS server addresses:
  - Preferred DNS server:
  - Alternate DNS server:
  - Preferred WINS server:
  - Alternate WINS server:

Software Compression  IP Header Compression

Figure 3-18. TCP/IP Properties
You can get IP settings assigned automatically if your network supports this capability. Otherwise, specify the IP settings in this dialog.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Possible Values</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Obtain an IP address automatically</strong></td>
<td>If this option is enabled, the IP address of the device is assigned by the network the device connects to.</td>
<td>&lt;Enabled&gt; &lt;Disabled&gt;</td>
<td>&lt;Enabled&gt;</td>
</tr>
<tr>
<td></td>
<td>If this flag is not set, the value of the IP address field is ignored.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Use the following IP address</strong></td>
<td>If this option is enabled, the device's IP address for the connection is specified by the IP address field.</td>
<td>&lt;Enabled&gt; &lt;Disabled&gt;</td>
<td>&lt;Disabled&gt;</td>
</tr>
<tr>
<td><strong>IP address</strong></td>
<td>This field specifies the IP address to be used while this connection is active.</td>
<td></td>
<td>&lt;None&gt;</td>
</tr>
<tr>
<td></td>
<td>This field is ignored unless &quot;Use the following IP address&quot; is enabled.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Obtain DNS server address automatically</strong></td>
<td>If this option is enabled, the connection's DNS and WINS server addresses are assigned by the network the device connects to.</td>
<td>&lt;Enabled&gt; &lt;Disabled&gt;</td>
<td>&lt;Enabled&gt;</td>
</tr>
<tr>
<td><strong>Use the following DNS server addresses</strong></td>
<td>If this option is enabled, the connection uses the DNS and WINS server addresses.</td>
<td>&lt;Enabled&gt; &lt;Disabled&gt;</td>
<td>&lt;Disabled&gt;</td>
</tr>
</tbody>
</table>
**Preferred DNS server**  The IP address of the DNS server to be used while this connection is active.

This field is ignored unless "Use the following DNS server addresses" is enabled.

Possible Values: 1 - 50 alpha-numeric characters
Default Value: <None>

**Alternate DNS server**  The IP address of a secondary or backup DNS server to be used while this connection is active.

This field is ignored unless "Use the following DNS server addresses" is enabled.

Possible Values: 1 - 50 alpha-numeric characters
Default Value: <None>

**Preferred WINS server**  The IP address of the WINS server to be used while this connection is active.

This field is ignored unless "Use the following DNS server addresses" is enabled.

Possible Values: 1 - 50 alpha-numeric characters
Default Value: <None>

**Alternate WINS server**  The IP address of a secondary WINS server to be used while this connection is active.

This field is ignored unless "Use the following DNS server addresses" is enabled.

Possible Values: 1 - 50 alpha-numeric characters
Default Value: <None>
Software Compression If this option is enabled, software compression is negotiated on the connection link.

Possible Values: <Enabled> <Disabled>
Default Value: <Enabled>

IP Header Compression If this option is enabled, IP header compression is negotiated on the connection link.

Possible Values: <Enabled> <Disabled>
Default Value: <Disabled>
Chapter 4: Emulation Parameters

This section provides the following information:

• About Emulation Parameters
• Configuring Emulation Parameters
• Using Configuration Manager

About Emulation Parameters

The Telnet Client allows you to configure emulation parameters for host connections.

You make changes to emulation parameters with the Configuration Manager utility, which provides an organized list of the emulation parameters that you can modify.

Emulation parameters are divided into two groups:

• Per-host
• Global

About Per-Host Emulation Parameters

Per-host emulation parameters apply only to a specific host connection, as dictated by the host profile the Telnet Client is using to connect to the host system. You can access the emulation parameters for a specific host profile through the Host Profiles dialog box.

When you choose to modify per-host emulation parameters, you access and use Configuration Manager to modify the Hostcfg.bin configuration file. Configuration Manager displays the name of the file that it is modifying in the title bar.

NOTE Per-host parameters are a subset of parameters. Not all Telnet Client emulation parameters are available for modification on a per-host basis.
About Global Emulation Parameters

Global emulation parameters apply to all of the host profiles with which you have configured a client. Per-host emulation parameter configurations preempt global emulation parameter configurations.

When you choose to modify global emulation parameters, you access and use Configuration Manager to modify the Termcfg.bin configuration file. Configuration Manager displays the name of the file that it is modifying in the title bar.

Configuring Emulation Parameters

This section provides information about accessing Configuration Manager to modify global and per-host emulation parameters.

Overview of Configuring Emulation Parameters

The following tasks outline the process of configuring emulation parameters:

1. Use the product configuration utility or the Telnet Client Avalanche software package to access the Configuration Manager.

2. Use the Configuration Manager to modify emulation parameters and save the new emulation parameters configuration file.

3. Download the new configuration file to the mobile device.

When you download the configuration file to the mobile device, any existing configuration file is overwritten.

Accessing Global Emulation Parameters

This section provides the following information:

- Using the Microsoft ActiveSync installation utility to access the Configuration Manager for global and parameters

- Using the Avalanche software package to access the Configuration Manager for global emulation parameters
Using Microsoft ActiveSync

If you used the product installation and configuration utility to install the Telnet Client to the mobile device via a Microsoft ActiveSync connection, use the same product installation and configuration utility to access the Configuration Manager and modify global emulation parameters.

To access global emulation parameters from the Microsoft ActiveSync utility:

1. On the host system, launch the Microsoft ActiveSync installation utility.

   The Wavelink Product Configuration dialog box appears.

   ![Wavelink Product Configuration Dialog Box](image)

   Figure 4-1. Wavelink Product Configuration Dialog Box

2. Click the Emulation Parameters icon button.

   The Configuration Manager appears.
Figure 4-2. Configuration Manager

3 Use the Configuration Manager to configure the global emulation parameters for the Telnet Client.

**NOTE** For information about using Configuration Manager, see *Using Configuration Manager* on page lxxvi.

4 After you have configured the emulation parameters, use one of the following methods to save the configuration to the host system:

- Click the **Save** icon button in the Configuration Manager tool bar.
- Select **File > Save**.

5 Close the Configuration Manager.

6 Download the new emulation parameters to the mobile device.
NOTE For more information about downloading configuration to mobile devices, see Deploying Configurations on page 20.

Using Avalanche Console

If you used Avalanche Console to install the Telnet Client on the mobile device, use Avalanche Console to access the Configuration Manager and modify global emulation parameters.

To access global emulation parameters from Avalanche Console:

1. On the host system, launch the Avalanche Console.

2. In the Software Profiles tab, select the profile that contains the Telnet Client package.

3. In the Software Packages tab, select the Telnet Client software package and click Configure.

   The Configure Software Package dialog box appears.

4. From the menu list, select Emulation Parameters and click OK.

   The Configuration Manager appears.
5 Use the Configuration Manager to configure the global emulation parameters for the Telnet Client.

**NOTE** For information about using the Configuration Manager, see *Using Configuration Manager* on page lxxvi.

6 After you have configured the emulation parameters, use one of the following methods to save the configuration to the host system:

- Click the **Save** icon button in the Configuration Manager tool bar.
- Select **File > Save**.

7 Close the Configuration Manager.

8 Download the new emulation parameters to the mobile device.
NOTE For more information about downloading configuration to mobile devices, see Deploying Configurations on page 22.

Accessing Per-Host Emulation Parameters

This section provides the following information:

- Using the Microsoft ActiveSync installation utility to access the Configuration Manager for per-host settings
- Using the Avalanche Telnet Client software package to access the Configuration Manager for per-host settings

Per-host emulation parameters are specific to a host connection and are accessed through the corresponding host profile in the Host Profiles dialog box.

Using Microsoft ActiveSync

If you used the product configuration utility to install the Telnet Client on the mobile device via a Microsoft ActiveSync connection, use the same product configuration utility to access and configure per-host emulation parameters.

To access per-host emulation parameters from the Microsoft ActiveSync utility:

1. On the host system, launch the Microsoft ActiveSync installation utility.

   The Wavelink Product Configuration dialog box appears.

2. Click the Host Profiles icon button.

   The Host Profiles dialog box appears.

3. From the list of host profiles, select the host profile that you want to configure.

4. Select the Configuration tab.
5 Click Modify.

The Configuration Manager appears.

6 Use the Configuration Manager to configure emulation parameters for the host profile that you have selected.

**NOTE** For information about using Configuration Manager, see *Using Configuration Manager* on page lxxvi.

7 After you have configured the emulation parameters, use one of the following methods to save the configuration to the host system:

- Click the Save icon button in the Configuration Manager tool bar.
- Select File > Save.

8 Close the Configuration Manager.
9 Close the Host Profiles dialog box.

10 Download the new emulation parameters to the mobile device.

NOTE For more information about downloading configuration to mobile devices, see Deploying Configurations on page 20.

Using Avalanche Console

If you used Avalanche Console to deploy the Telnet Client to the mobile device, use the Telnet Client software package in Avalanche Console to access and configure per-host emulation parameters.

To access per-host emulation parameters from Avalanche Console:

1 On the host system, launch the Avalanche Console.

2 In the Software Profiles tab, select the profile that contains the Telnet Client package.

3 In the Software Packages tab, select the Telnet Client software package and click Configure.

   The Configure Software Package dialog box appears.

4 From the menu list, select Host Profiles and click OK.

   The Host Profiles dialog box appears.

5 From the list of host profiles, select the host profile that you want to configure.

6 Select the Configuration tab.

7 Click Modify.

   The Configuration Manager appears.

8 Use the Configuration Manager to configure emulation parameters for the host profile that you have selected.

NOTE For information about using Configuration Manager, see Using Configuration Manager on page lxxvi.
After you have configured the emulation parameters, use one of the following methods to save the configuration to the host system:

- Click the **Save** icon button in the Configuration Manager tool bar.
- Select **File > Save**.

**10** Close the Configuration Manager.

**11** Close the *Host Profiles* dialog box.

**12** Download the new emulation parameters to the mobile device.

**NOTE** For more information about downloading configuration to mobile devices, see *Deploying Configurations* on page 20.

## Using Configuration Manager

This section provides the following information:

- An overview of Configuration Manager
- Using the Configuration Manager to modify emulation parameters
- Using the Configuration Manager find function

The Configuration Manager is the utility that allows you to modify global and per-host emulation parameters.
Chapter 4: Emulation Parameters

Figure 4-5. Configuration Manager

The left pane of the Configuration Manager displays the emulation parameters that you can modify. The emulation parameters are grouped by category.

The following list describes the different categories:

**COM** Parameters in this category configure the function of the COM port on mobile devices.

**Emulation** Parameters in this category configure terminal emulation functions on mobile devices.

**Indicators** Parameters in this category configure the function of indicators on mobile devices.

**Scanner** Parameters in this category configure the function of bar code scanners on mobile devices.
When you select a parameter in the left pane, information about the parameter displays in the right pane.

![termcfg.bin - Emulation Parameters](image)

**Com Port Baud Rate**

Select the Baud Rate to be used for Com Port communications. Options are:

- 1200
- 2400
- 4800
- 9600
- 19200
- 38400
- 57600
- 115200

*Default = 9600*

![Figure 4-6. Emulation Parameter Information](image)

**Modifying Emulation Parameters**

Determine the emulation parameters that you want to modify and use the Configuration Manager to make modifications.

**To modify an emulation parameter:**

1. Access the Configuration Manager.
2. In the left pane of the Configuration Manager, locate the parameter that you want to modify.
3. Double-click the emulation parameter or right-click the emulation parameter and choose **Edit** from the menu list.

A dialog box appears that allows you to modify the parameter configuration.
Figure 4-7. Modifying an Emulation Parameter

4 Use the dialog box to configure the parameter.

5 After you have configured the parameter, click OK to keep the setting.

NOTE Click Cancel or the Close button to cancel any changes you have made.

6 Use one of the following methods to save the new configuration:

   • Click the Save icon button.
   • Select File > Save.

7 Close the Configuration Manager.

8 Download the new configuration to the mobile device.

NOTE For more information about deploying new Telnet Client configurations to mobile devices, see Deploying Configurations on page 20.

Using the Find Function

Use the Find function of the Configuration Manager to locate parameters or information by supplying a partial or full string that the Configuration Manager can use to locate the parameter or information that you want to find.

To use the find function:

1 From the Configuration Manager Edit menu, select Find.

   The Find dialog box appears.
2  Input a partial or full string for the parameter or information that you want to find.

![Find dialog box with password entered](image)

**Figure 4-8. Inputting a String to Find**

3  Enable the **Search all text** checkbox to search not only the parameters, but also the help files.

4  Click **Find Next** to begin the search.

   Continue to click **Find Next** until you locate the parameter or information for which you are searching.

**Switching to Alphabetized View**

By default, emulation parameters are displayed in a hierarchical tree view. You may switch to an alphabetized view, if you desire. When the alphabetized view is enabled, the Configuration Manager displays the emulation parameters in alphabetical order.

**To switch to the alphabetized view in Configuration Manager:**

1  In the Configuration Manager, access the **View** menu.

2  In the **View** menu, disable the **Tree Mode** option.

   The Configuration Manager now displays the emulation parameters in an alphabetized list.
Figure 4-9. Alphabetized View in the Configuration Manager
Chapter 5: Scripting

This section provides the following information

- Overview of Scripting
- Launching the Script Editor
- Creating Scripts Using the Script Editor
- Performing Script Capturing
- Field Data ID Button
- Editing Scripts
- Importing Scripts
- Saving and Exporting Scripts
- Deploying Scripts
- Executing Scripts

Overview of Scripting

Wavelink Telnet Client includes a Script Editor that gives you the ability to create and execute scripts that automate processes on the Telnet Client.

**NOTE** The Script Editor is included in Telnet Client 5.1 and later versions.

The following steps outline the process of creating scripts using the Script Editor:

1. **Launch the Script Editor.** You can launch the script editor from Avalanche Console.

2. **Create a script using the Script Editor.** You can use the Script Editor to manually create the script code.

- Or-
Create a script using the Script Capture option. You can turn on Screen Capture and perform the actions you want included in your script.

3 Configure an execution method for your script. You need to select from the available options the way you want to execute your script.

4 Execute your script from the Telnet Client. Using the activation method you selected for the script, you can activate and execute your script.

Telnet Client allows one active script per emulation session. While one script is running, other scripts are not allowed to run. Scripts should be designed to do their action and then immediately exit. This allows the next script to run.

Scripts can only be run while a session is connected to a host. When a connection is dropped, the script is terminated. If you switch between sessions, the script running in the first session will be suspended until that session is returned to being active.

**NOTE** For detailed information about the using the Script Editor in Telnet Client, refer to the *Telnet Client Scripting Reference Guide*.

---

**Launching the Script Editor**

If you are using Avalanche Console to deploy the Telnet Client, you can launch the Script Editor from the Avalanche Console. Then scripts created by or imported into the Avalanche Script Editor will automatically be deployed to the remote devices.

To launch the Script Editor from Avalanche Console:

1 Ensure the Telnet Client package is installed in Avalanche Console.

2 In the Software Profiles tab, select the profile that contains the Telnet Client package.

3 In the Software Packages tab, select the Telnet Client software package and click **Configure**.

   The Configure Software Package dialog box appears.

4 Select **Script Editor** and click **OK**.
The Script Editor opens.

![Script Editor](image)

**Figure 5-1. Script Editor**

5. Click **Add** to open the *Script Editor* configuration dialog box.

![Script Editor Configuration Dialog Box](image)

**Figure 5-2. Script Editor Configuration Dialog Box**
Creating Scripts Using the Script Editor

This section provides information on how to create scripts manually using the Script Editor and includes the following information:

- Configuring the Script Name
- Selecting the Activation Method
- Creating the Script Code
- Creating Variables
- Selecting Host Profiles

Use the following steps to create a script manually:

1. Enter a script name and select an activation method.

2. Use the Actions tab to select actions and build the script code.

3. Use the Boolean Variables, Number Variables, or String Variables tabs to create Variables as needed to complete the script (not required).

4. Use the Host Profile tab to select host profiles that will be associated with this script.

Configuring the Script Name

The script name is the name you will select from when activating the scripts.
Selecting the Activation Method

You need to select how you want to activate your script, once it is created. A script with no activation method selected can still be called by another script, but it cannot be activated by itself.

This section provides information about assigning a method of activation to a script. The following is a list of the activation methods:

- Select from Menu
- On Key Combination
- When Session Connects
- On Barcode, MSR, or RFID Scan
- On Screen Update

Select from Menu

Scripts with the Select from Menu option selected can be run using the menu option in the Telnet Client.
To configure the Select from Menu method:

1. Select the **General** tab or the **Activate** tab in the Script Editor.

2. Enable the **Select from Menu** option.

![Figure 5-4. Select from Menu](image)

3. Click **OK**.

**On Key Combination**

This option lets you launch a script whenever a specific key combination is pressed.

**NOTE** Use the Diagnostics utility to obtain the key value. Refer to *Using the Telnet Client Diagnostics Utility* on page 151 for more information.

To configure the On Key Combination method:

1. Select the **General** tab or **Activate** tab in the Script Editor.

2. Enable the **On Key Command** option.
Figure 5-5. On Key Combination

3 Use the drop-down menu and text box to assign a key combination to the script.

When Session Connects

This option causes the script to activate when the host profile it supports is activated.

If you use this option, it is strongly recommended that you limit the script to the appropriate host profiles. Since the script will be activated before any information appears on the emulation screen, you will need to have your script wait for the appropriate screen to appear before it does anything. You should not have more than one script set to start when a session begins because the first script started will prevent any other scripts from running while it waits for the initial screen.

Refer to Selecting Host Profiles on page xciv for more information.

To configure the When Session Connects method:

1 Select the General tab or Activate tab in the Script Editor.

2 Enable the When Session Connects option.
3 Click OK.

**On Barcode, MSR or RFID Scan**

This option allows the script to run with each barcode, MSR or RFID scan.

For detailed information on configuring scripts for barcode, MSR or RFID scan refer to the *Telnet Client Scripting Reference Guide*.

**To configure the On Barcode, MSR, or RFID Scan method:**

1 Create the **Scan_String** and **Scan_Type** variables.

   Once you create these variables, the **On Barcode, MSR or RFID Scan** options becomes available.

   You will need to create these variables in the **String Variables** and **Number Variables** tabs. Refer to *Creating Variables* on page xcii for information on creating variables.

1 Select the **General** tab or **Activate** tab in the Script Editor.

2 Enable the **On Barcode, MSR, or RFID Scan** option.

3 From the drop-down menu, select the **Scan_String**.
From the drop-down menu select the **Scan_Type**.

5 Click OK.

**On Screen Update**

This option will cause the script to be activated (if activation is allowed) every time the text on the emulation screen changes. This includes updates from the Telnet host or when the user presses a key and the key value is shown on the screen. It is recommended that you limit the host profiles that the script supports.

For detailed information on configuring scripts for on screen update execution refer to the *Telnet CE Client Scripting Reference Guide*.

**NOTE** This option should be used carefully, since it can cause a script to be executed very frequently.

**To configure the On Screen Update method:**

1 Select the **General** tab or **Activate** tab in the Script Editor

2 Enable the **On Screen Update** option.

![Figure 5-7. Selecting the On Screen Update Method](image-url)
3 Click OK.

Creating the Script Code

Once you have named your script and selected an activation method, you can use the Actions tab in the Script Editor to build the script.

For detailed information and examples about building the script code refer to the Telnet CE Client Scripting Reference Guide.

Creating Variables

There are three types of values recognized by scripting: booleans (TRUE or FALSE values only), numbers (integers), and strings. Every argument for every action is one of these three value types. Every action that returns a value returns one of these types. Variables provide a way to save the result of an action for use later as an argument for another command.

Variables can be created and edited under the appropriate Variable tab while editing the script. It is also possible to create new variables while editing an action.

When a script first starts, all the variables will have known values: boolean variables will be FALSE, number variables will be 0, and string variables will be empty. One possible exception to this is when a script activates another script.

To create a variable:

1 Determine which type of variable you want to create: boolean, number or string.

2 From the Script Editor, select the tab that corresponds with the type of variable you want to create.

3 Click Add.

4 In the Edit Variable dialog box, enter the name of the new variable.
5 If you would like the variable to be a persistent variable, enable the **Make this variable persistent** checkbox. For more information, refer to the following **Persistent Variables** section.

6 Click **OK**.

The new variable appears in the corresponding tab.

**Persistent Variables**

When a variable is persistent, the value remains after the script exits. Persistent variables are not script or session specific; once a value is assigned,
any script in any Telnet session can use a persistent variable to access that value.

Two scripts are considered to be referencing the same persistent variable if both scripts contain persistent variables of the same type and same name.

Because writing new values to persistent variables will slow your application, they should only be used when necessary. If you want to use a persistent variable that will change values frequently, write your script with a regular variable that only changes the value of the persistent variable before the script pauses or exits.

**Selecting Host Profiles**

For each script, you can specify which host profiles will be supported by that script. You may select host profiles from the **Host Profiles** tab.

If the script is generated by script capturing, it is a good idea to limit that script to a host profile that was in use when the script was captured. The default - no host profile - allows the script to be run when any host profile is used.

**To select host profiles:**

1. From the Script Editor, select the **Host Profiles** tab.

![Host Profiles Tab](image)
2 Click **Add**.

The **Select Host** dialog box opens.

![Select Host dialog box](image)

**Figure 5-11. Selecting Host Profiles**

3 Select which host you want to use from the list of hosts.

**NOTE** If you have not created any host profiles, this dialog box will be empty.

4 Click **OK**.

The host appears in the **Host** tab.
Performing Script Capturing

Script capturing is an easy way to generate a script that will automate doing something you can do manually. While script capturing is turned on, it will capture the key presses and mouse/pen cursor movements so they can be replayed with the script is activated.

To perform a script capture:

1. Position your mouse or cursor at the emulation screen you want to be at when the automated process starts.

2. From the Term or Options menu, select Scripting > Start Capture.
3 At the prompt, select **Yes** to verify the current screen text.

Select **No** if you do not want to verify the current screen text.
Selecting **Yes** makes the captured script start with an `If_not` command that tells the script to exit if the correct screen is not currently shown. Unless you know that your script will only run from the correct screen (for example, a script that is run only when a session first starts, or a script called by another script), you should select **Yes**.

**NOTE** If you select **No**, click **Verify Screen Contents** and **Save Cursor Position** buttons when you start your script capture. This will cause your script to wait for Telnet to finish updating the screen before processing script actions.

4. Perform any actions you want to include in the script.

5. Each time the screen changes, click **Verify Screen Contents** button.
NOTE Some devices may only display buttons labeled Screen, Cursor, ID, and Stop. The Screen button refers to the Verify Screen Contents button. The Cursor button refers to the Save Cursor Position button. The ID button refers to the Field Data ID button. The Stop button refers to the Stop Capture button.

Figure 5-15. Verify Screen Contents and Save Cursor Position Buttons

NOTE Clicking the Verify Screen Contents button will cause the generated script to pause and wait for the screen to be updated. The pauses are necessary because the scripts can run much faster than the interaction with the Telnet host.

6 When you are finished capturing the behaviors you want in the script, click Stop Capture.

Once you have captured a script, Script Editor opens. This allows you to name the script and select an activation method. You would also use the
Actions tab to add actions for any error condition that the user may encounter.

Field Data ID Button

The Field Data ID feature allows you to use scripting to configure Field Data Identifiers. Field Data Identifiers assign a unique ID, such as a letter, to each field on the screen. Any time a barcode beginning with that ID is scanned, the information is automatically populated in the corresponding field. For detailed information and examples about the Field Data ID feature, refer to the Telnet CE Client Scripting Reference Guide.

Editing Scripts

You can edit scripts that are created manually and scripts that are generated from the script capture option.

To edit scripts:
1  Launch the Script Editor.
2  Select the script you want to edit from the Script Editor script list.
3  Click Edit.
4  Make the desired changes in the Script Editor configuration dialog box.
5  Click OK to save your changes.

Once you have completed editing the script you have two options:

- Export the script to a specified location using the Export button in the Script Editor. Refer to Saving and Exporting Scripts on page cii for more information.

- Execute the script by launching the Telnet CE Client and performing the activation method you assigned to this script. Refer to Executing Scripts on page ciii for more information.
Importing Scripts

You can use the import button in the Script Editor to import previously created scripts.

**NOTE** You can only import scripts that have been created using the Script Editor.

**To import a script:**

1. From the Script Editor, click the **Import** button.

   The *Select the Script File* dialog box opens.

2. Navigate to and select the script file.

3. Click **Open**.

   The name of the file is imported into the Script Editor.
Once you have imported the file, you can edit the script. Refer to *Editing Scripts* on page c for more information.

**Saving and Exporting Scripts**

After you finish building a script, your script is automatically saved in the Script Editor. You can also export a script and save it in a specific location on the network.

*NOTE* Scripts are saved as `.wls` files. Scripts cannot be viewed outside the Script Editor and must be imported back in to the Script Editor to view or edit.

**To export a script:**

1. From the Script Editor script list, select which script you want to export.
2. Click the **Export** button.
   
   The Create the Script File dialog box opens.
Deploying Scripts

Scripts are deployed to the Telnet Client the next time the client syncs with the Avalanche Console.

Executing Scripts

When you create a script, you configure an activation method for that script. This section provides information about activating scripts using each of the following activation methods:

- Select from Menu
- On Key Combination

Figure 5-18. Exporting a Script

3 Navigate to the location to which you want to export your script.

4 Click Save.

To view an exported script you will need to import that script into the Script Editor. Refer to Importing Scripts on page ci for more information.
• When Session Connects

• On Barcode, MSR, or RFID Scan

• On Screen Update

For information on assigning an activation method to a script, refer to Selecting the Activation Method on page lxxxvi.

NOTE Screen captures may differ according to device type.

Select from Menu

This option allows you to activate a script from the menu.

To activate a script using the Select from Menu option:

1. Launch the Telnet Client.

2. From the Term menu, select Scripting > Execute Script (Figure 5-19).

![Figure 5-19. Executing a Script from the Menu](image)
3 If more than one script is available for the current host profile, select which script you want to use from the list.

**NOTE** This option will not be available while a script is running for the current session or if the session is not connected.

**On Key Combination**

This option lets you launch a script whenever a specified key combination is pressed (as long as it is currently possible for script to run).

To execute a script on key combination:

1. Launch the Telnet Client.
2. Enter the key combination you assigned to execute the script.

**When Session Connects**

This option causes the script to activate when the host profile it supports is activated.

To execute when the session connects:

1. Launch the Telnet Client.
2. From the Term or Options menu, select Connect.
3. Select to which host you want to connect.
4. Click OK.

The script will run upon connection.

**On Barcode, MSR, or RFID Scan**

When this option is assigned to a script, the script will activate with each barcode, MSR, or RFID scan.

**On Screen Update**

This option causes the script to be activated (if activation is allowed) every time the text on the emulation screen changes. This includes updates from the
Telnet host or when the user presses a key and the key value is shown on the screen.
Chapter 6: Keyboard Creator

This section provides the following information:

- Overview of Keyboard Creator
- Launching the Keyboard Creator
- Selecting Keyboard Files
- Creating Keyboards
- Importing Keyboard Graphics
- Creating and Configuring Keys
- Sizing and Positioning Keys and Rows
- Deploying the Keyboard to the Telnet CE Client

Overview of Keyboard Creator

The Keyboard Creator allows you to create or modify the Telnet Client virtual keyboard.

Use the following steps to create a keyboard using Keyboard Creator:

1. Launch the Keyboard Creator.
2. Select the appropriate keyboard file.
3. Create a new keyboard.
4. Import a keyboard graphic, if desired.
5. Create and configure the keys of the keyboard.
6. Deploy the keyboard to the Telnet Client.

Launching the Keyboard Creator

The Keyboard Creator is installed as part of the Telnet Client Avalanche software package.
**NOTE** The Keyboard Creator is only available in the Avalanche Telnet Client. You will not be able to access the Keyboard Builder from the ActiveSync install utility or any other third-party Telnet Client installation and configuration utilities.

To launch from Avalanche:

1. Launch the Avalanche Console.

2. In the **Software Profiles** tab, select the profile that contains the Telnet Client package.

3. In the **Software Packages** tab, select the Telnet Client software package and click **Configure**.

   The *Configure Software Package* dialog box appears.

4. Select **Keyboard Creator** and click **OK**.

   The Keyboard Creator opens.

---

**Figure 6-1. Launching the Keyboard Creator**
Selecting Keyboard Files

Keyboard files contain all the keyboards needed for a given emulation (5250, 3270, VT100, VT220, HP, or WEB). Use Table 6-1 to determine the name of the keyboard file that should be edited for a particular emulation.

<table>
<thead>
<tr>
<th>Emulation</th>
<th>File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>5250</td>
<td>EM5250.KB</td>
</tr>
<tr>
<td>3270</td>
<td>EM3270.KB</td>
</tr>
<tr>
<td>VT100, VT220</td>
<td>EMVT.KB</td>
</tr>
<tr>
<td>HP</td>
<td>EMHP.KB</td>
</tr>
<tr>
<td>WEB</td>
<td>EMWEB.KB</td>
</tr>
</tbody>
</table>

Table 6-1: Emulation Types and File Names

There are two additional keyboards:

- EMNONE.KB are the keyboards displayed when a session is not connected to a host.

- EMNUM.KB are the keyboards displayed for the Numeric keyboard option.

When the keyboard file is saved, a matching file with the .KBB extension will also be saved. This file is a binary representation of the keyboard file and will be used by the terminal to display the keyboards. (Telnet Client ignores the .KB files if they are present.)

To select a keyboard file:

1. Determine the name of the Keyboard file you are creating.

2. Select the file type from the drop-down list.
Creating Keyboards

There are two default keyboards: the default alpha keyboard and the default numeric keyboard. The default alpha keyboard is displayed by default. The default numeric keyboard is displayed when in a numeric field (5250 and 3270 only).

This section provides the following keyboard information:

- Adding a new keyboard
- Sizing Keyboards
- Deleting Keyboards

**Adding a new keyboard**

Multiple keyboards can be included in each keyboard file. The keyboards are linked together by shift keys (special keys which display another keyboard).

**To add a keyboard:**

1. Launch the Keyboard Creator.
2 Select Keyboard > New Keyboard from the menu.

3 Enter a new name for the keyboard.

![Figure 6-3. Creating a New Keyboard](image)

**NOTE** Keyboard names must start with a letter, may only contain numbers or letters, and can only be 11 characters long.

![Figure 6-4. Creating a New Keyboard](image)

4 Use the Key configuration options to configure each key of the keyboard.

Refer to Creating and Configuring Keys on page cxiii for more information.
**Sizing Keyboards**

You can use the mouse to resize a keyboard. As you increase the size of the keyboard, the size of the application area will decrease.

**To resize the keyboard:**

1. Mouse over the top border, right-side border, or the upper-right corner of the keyboard.

2. When the double-sided arrows appear, click and drag the keyboard to the desired size.

**Deleting Keyboards**

When deleting a keyboard that has keys which connect to it, an option will be presented for dealing with any connections to the keyboard. Keys that are references to the keyboard being deleted can be deleted, set to an empty value or redirected to another keyboard.

**To delete a keyboard:**

1. Select **Keyboard > Delete Keyboard** from the menu.

2. Select what action to take for referenced keys.

![Deleting Keyboard](image.png)

*Figure 6-5. Deleting a Keyboard*
Importing Keyboard Graphics

The default keyboard draws the keys on the computer screen. However, you can import a graphic to be displayed instead of the created keys. An imported graphic will be embedded in the .KB and .KBB files, so you will not need to save the imported graphic file.

Key locations and values will still be used to determine which key was selected when you click on the keyboard graphic. You will need to create and position keys in the same position as the buttons on the imported graphic. Use the slider bar change how dark the graphic and buttons are while editing so that you can size and position the buttons correctly.

NOTE Be sure to label the buttons you create. If the mobile device is unable to use the bitmap image, the labeled buttons will still appear.

To import a graphic:

1. In the Keyboard Creator, click Import.

2. Navigate to the location of the bitmap image you want to import.

3. Click Open.

4. Click the Size Keyboard to Graphic button to make the keyboard the same size as the imported graphic.

5. Use the slider bar to adjust the how dark and how light the graphics and buttons appear when editing.

Creating and Configuring Keys

There are three types of keys that can be on a keyboard:

- Normal keys represent letters, numbers, or other characters in the emulation and can also represent special emulation specific function keys.

- Shift keys can point to any other keyboard in the current keyboard file.

- Hide keys hide the keyboard and allows an unobstructed view of the emulation screen.
This section provides the following information:

- Adding a new key
- Sizing and Positioning Keys and Rows
- Deleting Keys

**Adding a new key**

You can add new keys to a keyboard and configure the key values and configure the following options:

- **Label.** Enter the text that will appear on the virtual key when it is displayed.

- **Reverse.** Enable this option for a key that indicates the active keyboard type.

- **Key Value.** Select from Key, Normal, Keyboard (shift), or Hide. Key values allow you to select emulation-specific actions to be assigned to the keys. The list of keys available will vary depending on the emulation type selected.

**NOTE** Normal key values can be displayed or entered as a character value (the actual character created by the keystroke is shown), a decimal value (for characters which cannot be shown), or a hexadecimal value (for scan codes of special function keys).

To add a new key:

1. Select **Keyboard > Add Key.**

   The new key will appear in the top left corner of the keyboard, or directly to the right of a selected key (if it will fit).
Figure 6-6. Adding a New Key

2 Modify the values for the key using the key configuration options.
3 Repeat to create additional keys for the keyboard.

### Sizing and Positioning Keys and Rows

You can use the configuration options in the Key region of the Keyboard Creator to modify the size and position of the keys on the keyboard.

The Fine Adjustments drop-down menu allows you to select what object you want to modify:

- **Key Position.** Select this option to move a selected key on the keyboard. You can also adjust the key position by clicking on the key and dragging it to the desired position.
- **Row Position.** Select this option to move an entire row.
- **Keyboard Position.** Select this option to move all the keys on the keyboard.
- **Key Size.** Select this option to adjust the size of the key.

Once you select the object you want to modify, you can use the arrow buttons to position or size the keys and rows. The Adjust Distance slider...
determines the distance that the arrow buttons move or adjust the keys or rows. You can use the slider to change the distance from 1-10 pixels.

**To position a key:**
1. Click **New Key**.
2. From the Fine Adjustments drop-down menu, select **Key Position**.
3. Use one of the following methods to move the key:
   - Use the arrow buttons to position the key in the desired location.
   - Drag and drop the key to the desired location.

**To position a row:**
1. Click a key in the row you want to position.
2. From the Fine Adjustments drop-down menu, select **Row Position**.
3. Use the arrow buttons to position the row in the desired location.

**To resize a key:**
1. Click **New Key** or select an existing key.
2. From the Fine Adjustments drop-down menu, select **Key Size**.
3. Use the arrows to adjust the size.

**Deleting Keys**
You can delete keys that you do not want from the keyboard.

**To delete a key:**
1. Select the key you want to delete.
2. Select **Keyboard > Remove Key**.

**Deploying the Keyboard to the Telnet CE Client**

Once you have completed creating your keyboard and keys, click the Save icon to save your keyboard, and then exit the Keyboard Creator. Your Telnet Client will update with the new keyboard the next time the mobile device syncs with Avalanche Console.
Chapter 7: Resource Editor

This section provides the following information:

- Overview of Resource Editor
- Launching the Resource Editor
- Using the Resource Editor
- Deploying Files to the Telnet Client

Overview of Resource Editor

The Resource Editor allows you to import sound and picture files that can be deployed to your mobile devices through the Avalanche Console.

Use the following steps to deploy sound and picture files to mobile devices:

1. Launch the Resource Editor.
2. Add bitmap and sound files.
3. Deploy bitmap and sound files to the Telnet Client.

Launching the Resource Editor

The Resource Editor is installed as part of the Telnet Client Avalanche software package.

NOTE The Resource Editor is only available in the Avalanche Telnet Client. You will not be able to access the Resource Editor from the ActiveSync install utility or any other third-party Telnet Client installation and configuration utilities.

To launch from Avalanche:

1. Launch the Avalanche Console.
2. In the Software Profiles tab, select the profile that contains the Telnet Client package.
3 In the Software Packages tab, select the Telnet Client software package and click Configure.

The Configure Software Package dialog box appears.

4 From the menu list, select Resource Editor and click OK.

The Resource Editor opens.

![Resource Editor](image)

**Figure 7-1. Launching the Resource Editor**

### Using the Resource Editor

There are two file types that can be imported into the Resource Editor: .bmp and .wav files. All files can be edited and removed as desired.

This section provides the following information:

- Adding a Bitmap
- Adding a Sound
- Playing Sounds
• Editing Files

**Adding a Bitmap**

Any graphic file with a `.bmp` extension can be added to the Resource Editor.

**To add a bitmap:**

1. Launch the Resource Editor.

2. From the right pane of the Resource Editor, click Add new bitmap.

   The Open dialog box appears.

3. Navigate to the desired file and click Open.

   The file appears beneath the Bitmaps folder in the left pane of the Resource Editor.

**Adding a Sound**

Any sound file with a `.wav` extension can be added to the Resource Editor.

**To add a sound:**

1. Launch the Resource Editor.

2. From the right pane of the Resource Editor, click Add new sound.

   The Open dialog box appears.

3. Navigate to the desired file and click Open.

   The file appears beneath the Sounds folder in the left pane of the Resource Editor.

**Playing Sounds**

You can play your `.wav` files from the Resource Editor.

**To play a .wav file:**

1. Launch the Resource Editor.

2. In the left pane, expand the Sounds folder and select the desired file.

3. In the right pane of the Resource Editor, click Play.
The sound plays.

**Editing Files**

You can use the Resource Editor to rename or remove files.

**To rename files:**

1. Launch the Resource Editor.
2. In the left pane, expand the appropriate folder and select the desired file.
3. In the right pane of the Resource Editor, click **Rename**.
   
   The **Rename Resource** dialog box appears.

![Rename Resource Dialog Box](image)

   **Figure 7-2. Rename Resource Dialog Box**

4. Enter the new file name in the available text box.
5. Click **OK**.

   The new file name appears in the left pane of the Resource Editor.

**To remove files:**

1. Launch the Resource Editor.
2. In the left pane, expand the appropriate folder and select the desired file.
3. In the right pane of the Resource Editor, click **Remove**.

   The **Resource Editor** dialog box appears.
Chapter 7: Resource Editor

Figure 7-3. Resource Editor Dialog Box

4 Click Yes.

The file is removed from the Resource Editor.

Deploying Files to the Telnet Client

Once you have finished adding bitmap and sound files, click the Save icon to save your changes, and then exit the Resource Editor. Your Telnet Client will update with the new files the next time the mobile device syncs with Avalanche Console.
Chapter 8: Licensing

This section provides the following information:

- Overview of Licensing
- Types of Licenses
- Licensing Methods

Overview of Licensing

The Telnet Client requires a license for full functionality. You can use the Telnet Client without a license, but you will be limited to the demo version, which does not provide full Telnet Client functionality.

Telnet Client licensing is on a per-client basis, not on a per-connection basis. This means that a single license allows the Telnet Client to engage in the maximum number of Telnet sessions that the Telnet Client is configured to support (up to four concurrent sessions).

When the Telnet Client does not have a valid license, it operates in demo mode. When the Telnet Client is operating in demo mode, it will behave as followings:

- **Attempt to contact a license server.** Each time that you attempt to initiate a terminal emulation session, the Telnet Client will begin broadcasting in an attempt to locate a license server. At that point, you are prompted to either enter a license or to initiate the session in demo mode.

- **Prematurely disconnect emulation sessions.** While in demo mode, you may initiate terminal emulation sessions with hosts. However, each terminal emulation session that you initiate will automatically time out after one hour.
Authorization Methods

There are three ways to license (authorize) the Telnet Client:

• **Pre-licensing.** The Telnet Client may come pre-installed and pre-licensed on your mobile device. For pre-licensing information, please consult the Telnet Client reference guide for your mobile device manufacturer.

• **Manually.** You may manual input licensing information at the mobile device through the Telnet Client interface.

• **License Server.** You may use License Server to automatically provide Telnet Client licenses to the mobile devices on your network.

**NOTE** To obtain Telnet Client licenses, please contact Wavelink customer service. *Appendix C: Wavelink Contact Information* on page 247 provides Wavelink contact information.
Types of Licenses

There are two types of Telnet Client licenses:

- Platform
- Maintenance

**NOTE** Maintenance licenses were added to the 5.0 version of the Telnet Client. Only platform licenses are available for 4.x Telnet Clients.

About Platform Licenses

A platform license authorizes you to the version of the Telnet Client that you purchased and any builds associated with that version. For example, if you purchased a 5.0 Telnet Client license, then you are entitled to use 5.00-xx Telnet Client builds. If you want to use the features available in the 6.00-xx Telnet Client, then you must either buy a 6.0 platform license for your mobile devices, or you must purchase a maintenance license for your devices.

A platform license provides for minor upgrades and code changes, but does not allow major upgrades and updates to the Telnet Client.

Platform licenses do not expire, but they do not allow you to upgrade to a greater version of the Telnet Client.

About Maintenance Licenses

A maintenance license allows you to upgrade your Telnet Client when new major versions of the Telnet Client become available. For example, a maintenance license allows you to upgrade from Telnet Client 5.x to Telnet Client 6.x.

Maintenance licenses are valid only through a specific date. After the expiration date, if you upgrade the Telnet Client, it will revert to operating in demo mode.

Licensing Methods

This section provides the following information:
• Manually Licensing the Telnet Client

• Using License Server to License the Telnet Client

**Manually Licensing the Telnet Client**

You may key in your authorization information manually through the Telnet Client interface.

**To manually configure a Telnet Client license:**

1. Obtain the Telnet Client licensing information from Wavelink Corporation.

2. On the mobile device, launch the Telnet Client.

3. Attempt to establish a connection to a host.

**NOTE** For information about connecting to a host, see *Using the Telnet Client and Connecting to Hosts* on page 129.

If the Telnet Client has not attained a license, when you attempt to connect to a host, the *Authorizing Terminal* dialog box appears.

4. In the *Authorizing Terminal* dialog box, select *Add License*.

   The *Authorization* dialog box appears.

5. In the **License Name** text box, type the name of the license.

6. In the **Serial #** text box, type the serial number for the license.

7. In the **Exp. Date** text box, type the expiration date of the license, in the format of MMDDYYYY.

8. In the **Code** text box, type the authorization code for the license.

9. In the **User #** text box, enter a user number.

**NOTE** The user number can be any number between 1 and the number of users (the limit) for which the license provides. Each Telnet Client should be configured with a unique user number.
10 In the **Limit** text box, enter the user limit for the license.

11 Click **Authorize**.

The license type appears in the **Platform** text box.

**Using License Server to License the Telnet Client**

License Server is a Wavelink application that runs on a host system. The license server is responsible for supplying licenses to mobile devices that are using the Telnet Client.

**NOTE** The Telnet Client license server should not be confused with the Avalanche license server. Both are separate Wavelink applications.

**NOTE** For information about installing and using the Telnet license server, refer to the *Wavelink Client License Server Reference Guide*.

**Using a Local License Server**

When you attempt to initiate a Telnet session with a host, if the Telnet Client is not already licensed, it will automatically attempt to obtain a license from a license server by using the following steps:

1 The Telnet Client broadcasts a request for a license on the local IP network.

   The **Authorizing Terminal** dialog box displays on the mobile device while the Telnet Client attempts to locate a license server.
2 Any license servers on the local IP network with an available license respond by offering a license.

3 The Telnet Client accepts the first license that it receives and sends back a reply to the license server.

The *Authorizing Terminal* dialog box on the mobile device indicates that a license has been obtained.

If no license server responds to the request for a license, then the *Authorizing Terminal* dialog box continues to display until you close the dialog box, elect to use a demo license, or elect to manually add a license.

**Using a Remote or Specific License Server**

If the license server is on a remote IP network or you want to specify the license server from which the Telnet Client should request a license, you must configure the Telnet Client with the IP address of the license server.
When you attempt to initiate a Telnet session with a host, if the Telnet Client is not already licensed, it will automatically attempt to obtain a license from the specified license server using the following steps:

1. The Telnet Client sends a request for a license to the specified license server.
   The Authorizing Terminal dialog box displays on the mobile device while the Telnet Client attempts to locate a license server.

2. The license server on the local IP network respond by sending the Telnet Client a license.

3. The Telnet Client accepts the first license that it receives and sends back a reply to the license server.

### Using the Demo License

If you cannot obtain a license for the Telnet Client, you may use the demonstration license.

The demonstration license automatically disconnects an active Telnet session after one hour.

**To use the Telnet Client demo license:**

1. Launch the Telnet Client.

2. Use the Telnet Client to initiate a Telnet session with a host.

3. The Select Host dialog box appears.

4. In the Select Host dialog box, select the host with which you want to establish a Telnet session.
The Authorizing Terminal dialog box appears in the Authorizing Terminal dialog box, select **Start Demo**.

The Telnet Client uses the demonstration license and attempts to connect to the host that you selected. Before displaying the host emulation screen, the Telnet Client displays a screen that indicates that you are using a demonstration license.

![Figure 8-3. Telnet Client Running in Demonstration Mode](image_url)
Chapter 9: Using the Telnet Client

This chapter provides the following information:

- Using the Telnet Client and Connecting to Hosts
- Working with Multiple Concurrent Telnet Sessions
- Using the Standard Virtual Emulation Keyboard
- Using Screen Panning
- Using ActiveText
- Using the Telnet Client Diagnostics Utility
- Using the Telnet Client Options Menu
- Using the Screen Reformatter

Using the Telnet Client and Connecting to Hosts

This section provides the following information:

- Launching the Telnet Client
- Initiating a Telnet Session
- Disconnecting a Telnet Session
- Exiting the Telnet Client

Launching the Telnet Client

Depending on the method that you used to install the Telnet Client, you will have different options for launching the Telnet Client.

If you installed the Telnet Client through Microsoft ActiveSync or another third-party application, then you will be able to launch the application from the Windows CE Start menu or from the desktop.
If you installed the Telnet Client through Avalanche Console, then you will also be able to launch the Telnet Client from the Avalanche Enabler interface on the mobile device.

**Launching the Telnet Client From Windows**

You can launch the Telnet Client from the Programs menu or, in some instances, from the desktop.

**To launch the Telnet Client:**

1. On the mobile device, access the Windows CE Start menu.

2. In the Windows CE Start menu, access the Programs group.

3. In the Programs folder, double-click the Telnet Client shortcut icon.

![TelnetCE](image)

**Figure 9-1. Telnet Client Shortcut Icon**

The Telnet Client launches on the mobile device and displays the default screen.
Launching the Telnet Client from Avalanche

If you used Avalanche Console to install the Telnet Client, then a shortcut icon for the Telnet Client appears in the Programs screen of the Avalanche Enabler.

To launch the Telnet Client from the Avalanche Enabler:

1. On the mobile device, launch the Avalanche Enabler.

2. If the Programs view is not available in the Avalanche Enabler, access the View menu and enable the Programs view.

   The Telnet Client shortcut icon appears in the Programs view of the Avalanche Enabler.
3 In the Programs view of the Avalanche Enabler, double-click the Telnet Client icon.

The Telnet Client launches on the mobile device and displays the default screen.
Initiating a Telnet Session

Use the Telnet Client to initiate a Telnet session with any host for which you have configured a host profile.

NOTE For more information about host profiles and configuring host profiles for the Telnet Client, see Chapter 3: Host Profiles on page 29.

To initiate a Telnet session with a host:

1. On the mobile device, launch the Telnet Client.

   The Telnet Client launches and displays the default screen.

2. Press the Enter key.

   The Select Host dialog box appears.
If you have configured only one host profile for the Telnet Client, the Select Host dialog box does not appear. Instead, the Telnet Client automatically attempts to connect to the host for which you have configured the single host profile.

3 In the Select Host dialog box, select the host to which you want to connect.

4 Click OK.

The Telnet Client attempts to establish a Telnet session with the host.

If the client does not have a license, then the Authorizing Terminal dialog box appears. For more information about Telnet Client licensing, see Chapter 8: Licensing on page 121.
**Disconnecting a Telnet Session**

Use the Telnet Client **Options** menu to disconnect from an active Telnet session.

**To disconnect from a Telnet session:**

1. Access the Telnet **Options** menu.
2. In the **Options** menu, select **Disconnect Session [n]-[name]**, where:
   - `<n>` is the session number that you want to disconnect, as displayed in the **Options** menu.
   - `<name>` is the name of the host from which you want to disconnect, as displayed in the **Options** menu.

![Options Menu](image)

*Figure 9-6. Disconnecting a Telnet Session*

When you make the selection, the session that you selected is terminated.
Exiting the Telnet Client

You can use the Telnet Client Options menu to exit the Telnet Client. Depending on the configuration of the Telnet Client, you may be required to supply an exit password before you can exit the Telnet Client.

NOTE By default, the Telnet Client is not configured with an exit password. For more information about configuring an exit password for the Telnet Client, see Configuring Passwords on page 225.

To exit and close the Telnet Client:

1. Access the Telnet Client Options menu.

2. In the Telnet Client Options menu, select Exit.

If you have configured the Telnet Client with an exit password, the Input Password dialog box appears.
If you have not configured an exit password, the Telnet Client closes.

3 In the Input Password dialog box, type the exit password.

4 Select OK.

The Telnet Client closes.

Working with Multiple Concurrent Telnet Sessions

This section provides the following information:

• Overview of Multiple Concurrent Sessions
• Initiating an Additional Telnet Session
• Switching Between Active Telnet Sessions
• Disconnecting a Session

Overview of Multiple Concurrent Sessions

The Telnet Client supports up to four concurrent Telnet sessions. These may include simultaneous sessions to the same host or to different hosts.

By default, the Telnet Client is configured to allow a user to engage in only one Telnet session. To provide for more than one active Telnet session, you must configure the Telnet Client to allow multiple concurrent sessions.

NOTE For information about configuring the Telnet Client to support multiple concurrent sessions, see Configuring the Number of Concurrent Sessions on page 227.

When the Telnet Client is configured to support multiple sessions, then multiple connection options appear in the Telnet Client Options menu.

Initiating an Additional Telnet Session

If you have configured the Telnet Client to allow multiple Telnet sessions and the Telnet Client is engaged in one or more Telnet sessions, you may initiate a new Telnet session from the Options menu.
To initiate an additional Telnet session:

1. Ensure that the Telnet Client is configured to allow multiple concurrent sessions.

2. Access the Telnet Client Options menu.

   The Options menu displays the available sessions (between 1 and 4) and indicates which sessions are connected to a host and which are unconnected.

3. From the Options menu, select an unconnected session that you want to use to connect to the host.

   ![Options Menu](image)

   **Figure 9-8. Available Unconnected Telnet Session**

   The Telnet Client now displays the default screen. (The default screen prompts you to press **ENTER** to connect to a host.)

4. Press the Enter key.

   The Select Host dialog box appears.
5 Use the Select Host dialog box to select the host with which you want to establish a Telnet session.

6 Select OK.

The Telnet Client attempts to connect to the host that you have selected.

Switching Between Active Telnet Sessions

If the Telnet Client is engaged in more than one Telnet session, use the Options menu to switch between the sessions.

To switch between Telnet sessions:

1 In the Telnet Client, access the Options menu.

2 In the Options menu, select the active session that you want to view.

![Figure 9-9. Switching to a Different Telnet Session](image)

The Telnet Client switches the view to the Telnet session that you selected.
NOTE You can also use the Next Sess or Prev Sess keys in the virtual emulation keyboard to switch between sessions. For information about accessing the virtual emulation keyboard, see Using the Standard Virtual Emulation Keyboard on page cxlv.

Disconnecting a Session

Use the Options menu to disconnect a session. You must switch to the session that you want to disconnect, before you can disconnect it.

To disconnect a Telnet session:

1. In the Telnet Client, access the Options menu.

2. From the list of sessions in the Options menu, select the session that you want to disconnect.

   The Telnet Client switches the view to the session that you selected.

3. Access the Options menu again.

4. In the Options menu, select Disconnect Session [n], where [n] is the session number that is currently active.
Using the Standard Virtual Emulation Keyboard

The Telnet Client contains a default virtual emulation keyboard. You can access the keyboard through the Telnet Client Options... menu.

To access the virtual emulation keyboard:
1. Access the Telnet Client Options... menu.
2. Select View > Emulation Keyboard.
Figure 9-11. Accessing the Virtual Emulation Keyboard

The virtual emulation keyboard appears.

The type of emulation keyboard that displays is dependent on the emulation type of the current Telnet session. The VT/HP virtual emulation keyboard is different than the 5270/3270 virtual emulation keyboard. If there is not active session, then the basic virtual emulation keyboard appears.

**Using the Basic Virtual Emulation Keyboard**

The following figure shows the basic Telnet Client virtual emulation keyboard.

![Basic Virtual Emulation Keyboard](image_url)

**Figure 9-12. Telnet Client Virtual Emulation Keyboard**
The following list describes the function of the keys in the basic virtual emulation keyboard:

**TermConfig**
- Allows you to access and configure the emulation parameters for a specific host profile.

**Prog Info**
- Shows/hides the following information about the mobile device:
  - Telnet Client version information
  - MAC address
  - IP address
  - ESSID

**Next Session**
- Cycles to the next Telnet Client session.

**Host Config**
- Allows you to access and configure the host profiles for the Telnet Client.

**Prev Session**
- Cycles to the previous Telnet Client session.

**Keyclks**
- Turns keyclicks on/off.

**Quiet**
- Turns quiet mode on/off.

**Diags**
- Allows you to access the Telnet Client diagnostic tools.

**Enter**
- Connects the session.

**Close**
- Disconnects the session. (Only available when the session is connected.)

### Using the 5250/3270 Virtual Emulation Keyboard

The following figure shows the Telnet Client virtual emulation keyboard for 5250/3270 emulation.
The following list describes the function of the control keys that appear at the bottom of the virtual emulation keyboard:

**Alpha**

Displays the alpha keys for 5250/3270 emulation, including:

- a - z
- Tab, Caps Lock, Shft, Res, Backspace, FieldExit, Enter, Space, Alt

**Num**

Displays the numeric keys for 5250/3270 emulation, including:

- 0 - 10
- Mathematical symbols
- Reset, Backspace, FieldExit, Enter, Arrow Keys
- Tab, Shft, Space

**Func1**

Displays the function keys for 5250/3270 emulation, including:

- F1 - F24
- Roll Up, Roll Down, Enter
**Func2**
Displays other function keys for 5250/3270 emulation, including:

- Dup, Print, Clear
- Attn, Help, Home
- Insert, Roll Up, Roll Down
- Delete, SysRq, ErInp, Reset

**Punc**
Displays punctuation characters for 5250/3270 emulation, including:

- Various punctuation and mathematical symbols
- Reset, Field Exit, Enter

**Alt**
Displays the basic virtual emulation keyboard. For information about the keys in the basic virtual emulation keyboard, see *Using the Basic Virtual Emulation Keyboard* on page cxlvi.

**Off**
Hides the virtual keyboard.

**Using the VT/HP Virtual Emulation Keyboard**

The following figure shows the Telnet Client virtual emulation keyboard for VT/HP emulation.

![Keyboard Layout]

*Figure 9-14. Telnet Client VT/HP Virtual Emulation Keyboard*
The following list provides information about the various control keys that appear at the bottom of the VT/HP virtual emulation keyboard.

**Alpha**  
Displays the alpha keys for VT/HP emulation, including:

- a - z
- Esc, Caps lock, Tab, Space, Enter, Backspace
- Shft, Ctl, Alt

**Num**  
Display the numeric keyboard for VT/HP emulation, which contains the following keys:

- 0 - 9
- Esc, Tab, Ins, Rem, Backspace, Enter, Space
- Shft

**Func**  
Displays the function keys for VT/HP emulation, including:

- F1 - F10
- Esc, Tab, Prev, Next, Find, Sel, Space, Backspace, Enter
- Shft, Ctrl, Alt

**Punc**  
Display the punctuation keys for VT/HP emulation, including:

- Punctuation Keys
- Backspace, enter, Space

**Cfg**  
Display the basic virtual emulation keyboard. For information about the keys in the basic emulation keyboard, see *Using the Basic Virtual Emulation Keyboard* on page cxlvi.
Off

Hides the virtual keyboard.

Arrow Keys

Moves the cursor in the direction of the arrow key that you press.

**Using the WEB Virtual Emulation Keyboard**

The following figure shows the Telnet Client virtual emulation keyboard for WEB emulation.

![Figure 9-15. Telnet Client WEB Virtual Emulation Keyboard](image)

The following list describes the function of the keys in the WEB virtual emulation keyboard.

- **Back**
  - Returns the browser to the previous web page.

- **Fwd**
  - Returns to the screen displayed before Back was selected.

- **Stop**
  - Stops the web page from loading.

- **Refresh**
  - Reloads the current web page.

- **Home**
  - Returns the browser to the specified home page.

- **Prev Sess**
  - Cycles to the previous Telnet Client session.

- **Next Sess**
  - Cycles to the next Telnet Client session.

- **Close**
  - Disconnects the session. (Only available when the session is connected.)

- **Key Clicks**
  - Turns key clicks on/off

- **Quiet**
  - Turns quiet mode on/off.
<table>
<thead>
<tr>
<th><strong>Info</strong></th>
<th>Shows/hides the following information about the mobile device:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Telnet Client version information</td>
</tr>
<tr>
<td></td>
<td>• MAC address</td>
</tr>
<tr>
<td></td>
<td>• IP address</td>
</tr>
<tr>
<td></td>
<td>• ESSID</td>
</tr>
<tr>
<td><strong>Diags</strong></td>
<td>Allows you to access the Telnet Client diagnostic tools.</td>
</tr>
<tr>
<td><strong>Alpha</strong></td>
<td>Displays the alpha keys for WEB emulation, including:</td>
</tr>
<tr>
<td></td>
<td>• a-z</td>
</tr>
<tr>
<td></td>
<td>• Shift, Ctl, Alt</td>
</tr>
<tr>
<td></td>
<td>• Esc, Tab, Caps, Enter, Space</td>
</tr>
<tr>
<td><strong>Num</strong></td>
<td>Displays the numeric keyboard for WEB emulation, including:</td>
</tr>
<tr>
<td></td>
<td>• 0-9</td>
</tr>
<tr>
<td></td>
<td>• Shft</td>
</tr>
<tr>
<td></td>
<td>• Esc, Tab, Ins, Enter, Space</td>
</tr>
<tr>
<td><strong>Func</strong></td>
<td>Displays the function keys for WEB emulation, including:</td>
</tr>
<tr>
<td></td>
<td>• F1-F24</td>
</tr>
<tr>
<td><strong>Punc</strong></td>
<td>Displays the punctuation keys for WEB emulation, including:</td>
</tr>
<tr>
<td></td>
<td>• Punctuation keys</td>
</tr>
<tr>
<td></td>
<td>• Enter, Space</td>
</tr>
<tr>
<td><strong>Cfg</strong></td>
<td>Display the virtual emulation keyboard.</td>
</tr>
</tbody>
</table>
Using Screen Panning

By default, the screen panning feature of the Telnet Client is enabled.

Screen panning feature of the Telnet Client allows a user to use the stylus to move around an emulation screen. When screen panning is enabled, a user can tap-and-drag the stylus and scroll across the emulation screen.

Screen panning has two modes of operation:

- **Standard.** By default, standard screen panning is enabled on the Telnet Client. When standard screen panning is enabled, the screen scrolls in the direction that the user drags the stylus across the screen. Standard screen panning simulates the effect of dragging the display of the mobile device over the emulation screen.

- **Reversed.** When reversed screen panning is enabled, the screen scrolls in the opposite direction that the user drags the stylus. Reverse screen panning simulates the effect of dragging the emulation screen beneath a fixed view port (that is, mobile device display).

**NOTE** For information about configuring screen panning, see Configuring Screen Panning on page 234.

Using ActiveText

By default, the ActiveText feature of the Telnet Client is enabled.

ActiveText allows the Telnet Client to identify menu items and functions in an emulation screen and convert them to interactive objects that a user can double-click to execute.

When a string of text is turned into ActiveText, a user can perform the following actions on the ActiveText object:

<table>
<thead>
<tr>
<th>Off</th>
<th>Hides the virtual keyboard.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow Keys</td>
<td>Moves the web page up and down or from side to side.</td>
</tr>
</tbody>
</table>
• **Single-click.** A single click highlights the string of text and indicates that it has become an ActiveText object.

• **Double-click.** A double-click executes the menu item or the function that has been converted to an ActiveText object.

You can configure the Telnet Client to recognize two types of text strings that will be converted to ActiveText objects:

• Simple number menu item

• AS/400-style function key

---

**NOTE** For information about configuring ActiveText, see *Configuring ActiveText* on page 235.

---

### Simple Number Menu Item

The Telnet Client can recognize numbered options in a menu and convert them to an ActiveText object.

The Telnet Client recognizes a string of characters in the following list as a simple number menu item:

• A beginning of line or a space

• A number (a string of digits)

• A period (‘.’)

• A space

• A non-space character

For example, the Telnet Client would convert the menu item 90. **Sign Off** in an emulation to ActiveText. The user could then double-click the ActiveText to invoke the 90. **Sign Off** menu option.

### AS/400-Style Function Key

The Telnet Client can recognize AS/400-style function key commands in an emulation screen.
The Telnet Client recognizes the following string of characters as an AS/400-/ style function key:

- A beginning of line or a space
- The character ‘F’
- A number (string of digits)
- An equal-to character (‘=’)
- A non-space character

For example, the Telnet Client would convert the function key command F3=Exit to ActiveText. The user could then double-click the ActiveText to invoke the F3=Exit command.

**Using the Telnet Client Diagnostics Utility**

The Telnet Client diagnostics utility allows you to perform the following tasks:

- Capture scan codes for external keyboard character sequences
- Perform a scan test
- Capture scan codes for the Windows virtual keyboard

**Accessing the Telnet Client Diagnostics Utility**

Use the Telnet Client virtual keyboard to access the diagnostics utility.

**To access the diagnostics utility:**

1. In the Telnet Client, access the virtual emulation keyboard.
2. In the virtual keyboard, click **Diags**.

**NOTE** Diags appears in the basic virtual emulation keyboard. For VT/HP emulation, Diags appears in the Cfg display of the virtual keyboard. For 5250/3270 emulation, Diags appears in the Alt display of the virtual keyboard.
The *Program Diagnostics* screen appears in the Telnet Client.

![Program Diagnostics Screen](image.png)

**Figure 9-16. Telnet Client Diagnostics Utility**

3. Select one of the options in the Program Diagnostics screen:

   - Press **K** to perform a keyboard test, which allows you to obtain scan codes for the external keyboard and the Telnet Client virtual keyboard.
   
   - Press **S** to perform a scan test, which allows you to determine the type of barcode for a scan.
   
   - Press **W** to perform a Windows keyboard test, which allows you to obtain scan codes for the Windows virtual keyboard.
   
   - Press **Q** to quick the diagnostics utility.

**Performing a Keyboard Test**

Use the Telnet Client to obtain scan codes for the external keyboard and the Telnet Client virtual keyboard.
To perform a keyboard test:

1. Ensure that you have an active VT/HP or 5250/3270 Telnet session.

**NOTE** An active session is required to test the Telnet Client virtual keyboard. The virtual keyboard displays keys based on the current Telnet session type.

2. Use the Telnet Client virtual keyboard to access the *Program Diagnostics* screen.

3. Press ⌘ for Keyboard Test.

   The *Keyboard Test* screen appears.

4. Use the external keyboard or the virtual keyboard to submit a character sequence to the Telnet Client.

   The Telnet Client displays the scan code for the character sequence.

![Figure 9-17. Performing a Keyboard Test](image-url)
5 Press Q to exit the Keyboard Test screen.

6 Press Q to exit the Telnet Client diagnostics utility.

**Performing a Scan Test**

Use the Telnet Client diagnostics utility to perform a scan test. A scan test allows you to verify the type and value of scanned data. The scan test utility does not process any scan handlers, scan identifiers, or pre- or post-amble strings. However, scan identifiers that you have configured are added to the scan.

**To use the diagnostics utility to perform a scan test:**

1 In the Telnet Client, access the diagnostics utility.

   The Program Diagnostics screen appears.

2 Select S for Scan/MSR Test.

   The Scan/MSR Test screen appears.

3 Use the scanner on the mobile device to perform a test scan.

   The Scan/MSR Test screen displays the results of the scan.
Chapter 9: Using the Telnet Client

Figure 9-18. Performing a Scan Test

4 Press Q to close the Scan/MSR Test screen.

Performing a Windows Keyboard Test

Use the Telnet Client diagnostics utility to obtain scan codes for the Windows virtual keyboard.

To use the diagnostics utility to obtain Windows scan codes:

1 In the Telnet Client, access the diagnostics utility.

   The Program Diagnostics screen appears.

2 Select W for Windows Keyboard Test.

   The Windows Keyboard Test screen appears.

3 Access the Windows virtual keyboard.

4 Select a character sequence in the Windows virtual keyboard.
The diagnostics utility displays the scan code for the character sequence that you submitted to the Telnet Client.

![Figure 9-19. Performing a Windows Keyboard Test](image)

5  Press Q to exit the Windows Keyboard Test screen.

6  Press Q to exit the diagnostics utility.

**Using the Telnet Client Options Menu**

This section provides a description of each option in the Telnet Client Options menu.

- **Connect Session [n]**  Select this option to use the current session to initiate a Telnet connection with a host, where [n] is the session number that is currently active.

- **Disconnect Session [n]**  Select this option to disconnect the current session, where [n] is the session number that is currently active.
Session [n] - [name]unconnected
Select this option to switch between sessions, where:
- [n] indicates the session number
- [name] indicates that the session is currently connected to [name] host
- unconnected is a constant that indicates that the session is not currently in use

Web > Back
Select this option to return the browser to the previous web page.

Web > Forward
Select this option to return to the screen displayed before Back was selected.

Web > Stop
Select this option to stop the web page from loading.

Web > Refresh
Select this option to reload the current web page.

Web > Home
Select this option to return the browser to the specified home page.

Web > Text Size
Select this option to change the text size. The available options are:
- Largest
- Larger
- Medium
- Smaller
- Smallest

Scripting > Execute Script
Select this option to activate a script.

Scripting > Cancel Script
Select this option to stop a script that is running.

Scripting > Start Capture
Select this option to begin capturing keypresses and mouse/cursor movements for script generation.

Scripting > Stop Capture
Select this option to end script capturing.
Using the Screen Reformatter

The Telnet Client includes an application that allows you to modify the appearance of Telnet Client emulation screens. You can create a screen layout that includes items you want the mobile device user to see, and does not include items that should not be visible to the user.
The Screen Reformatter is included in Telnet Client 7.1 and later versions.

The following steps outline the process of modifying Telnet screens using the Screen Reformatter. For detailed instructions, refer to the Wavelink Telnet Client Screen Reformatter Reference Guide.

1. **Perform a screen capture.** Use the screen capture function within the Telnet Client or Session Monitor to capture any Telnet screen(s) you want to reformat.

2. **Launch the Screen Reformatter.** You can launch the Screen Reformatter from the Telnet Client, or Avalanche Console.

3. **Import the screen capture into the Screen Reformatter.** Import any captured screen(s) you want to reformat.

   - Or -

   **Import a master file into the Screen Reformatter.** You can also import a master file, which contains multiple screen captures.

4. **Reformat the Telnet screen.** Copy the regions of the Telnet screen which you would like to include on the modified screen. You can also modify the screen further by adding things like text, scripts, and speech.

5. **Assign verification items.** You can select a Telnet Host Profile and/or items on the Telnet screen which will be verified to determine whether the reformatted screen should be displayed.

6. **Save the reformatted screen.** After you have modified the screen as desired, you can click the Save icon to save your changes.

   - Or -

   **Export a master file.** If you have reformatted multiple Telnet screens, you can create a master file that contains all of the screens.

7. **Connect to the Telnet Client.** The file containing the reformatted screen is deployed to the Telnet Client the next time it syncs with the Avalanche Console.
Chapter 10: Industrial Browser (WEB Emulation)

This chapter provides information about using and developing for the Telnet Client Industrial Browser. This chapter includes the following information:

- Overview of the Industrial Browser
- Licensing
- Industrial Browser Host Profile Settings
- Using the Industrial Browser

Overview of the Industrial Browser

Wavelink Telnet Client includes an Industrial Browser interface that gives you the ability to access web-based applications from a mobile device. The Industrial Browser supports PocketPC 2003, Windows Mobile 5.0, Windows 2000/XP, and Windows CE .NET 4.2/5.0.

**NOTE** The Industrial Browser is included in Telnet Client 6.0 and later versions.

Licensing

The Telnet Client Industrial Browser requires a license for full functionality. There are two ways to license Telnet Client Industrial Browser:

- If you do not currently have a Telnet Maintenance license, you can purchase a Telnet Client 6.0 Standalone Browser license. (A separate Browser Maintenance license is also available.)
- If you currently have a Telnet Maintenance license, you can purchase an Industrial Browser add-on license. (Browser Maintenance is included.)

**NOTE** For more information on licensing, see Chapter 8: Licensing on page 121.
**Industrial Browser Host Profile Settings**

This section describes the parameters of each tab used to configure WEB emulation settings in the *Host Profiles* dialog box.

**NOTE** For more information on Host Profile Settings, see *Chapter 3: Host Profiles* on page 29.

**HTTP Proxy Tab**

Use the **HTTP Proxy** tab to configure proxy connections for WEB emulation.

![HTTP Proxy Tab](image)

*Figure 10-1. Configuring the HTTP Proxy tab*
The following list describes the options and configurable parameters in the HTTP Proxy tab.

**Connection Type**
Indicates the type of connection for the host profile to use.

**Possible Values:** <Direct Connection> <Use Explorer Default> <Use Proxy Server>

**Default Value:** <Direct Connection>

**Proxy Server**
Indicates the location of the proxy server.

**Possible Values:** Any valid IP address, host name, or web address.

**Default Value:** <None>

**Port**
Indicates the network port for the proxy server.

**Possible Values:** Any valid port number.

**Default Value:** <8080>

**Do not use the proxy server when contacting local hosts**
Indicates whether the Telnet Client should use the proxy server when contacting hosts that reside on the same network.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>

**HTTPS Proxy Tab**
Use the HTTPS Proxy tab to configure secure proxy connections for WEB emulation.
Figure 10-2. Configuring the HTTPS Proxy Tab

The following list describes the options and configurable parameters in the HTTPS Proxy tab.

**Connection Type**
Indicates the type of connection for the host profile to use.

**Possible Values:** <Direct Connection> <Use Explorer Default> <Use Proxy Server>

**Default Value:** <Direct Connection>

**Proxy Server**
Indicates the location of the proxy server

**Possible Values:** Any valid IP address, host name, or web address.

**Default Value:** <None>
Access List Tab

Use the Access List tab to configure which web addresses can be accessed by the Telnet Client Industrial Browser.

<table>
<thead>
<tr>
<th>Port</th>
<th>Indicates the network port for the proxy server.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Possible Values:</td>
<td>Any valid port number.</td>
</tr>
<tr>
<td>Default Value:</td>
<td>&lt;8080&gt;</td>
</tr>
</tbody>
</table>

Do not use the proxy server when contacting local hosts

Indicates whether the Telnet Client should use the proxy server when contacting hosts that reside on the same network.

| Possible Values: | <Enabled> <Disabled> |
| Default Value: | <Disabled> |

Figure 10-3. Configuring the Access List Tab
The following list describes the options and configurable parameters in the Access List tab.

**Allowed Web Server Addresses**
Lists the web addresses that the Telnet Client is permitted to connect with.

**Possible Values:** Any valid IP address, host name, or web address.

**Default Value:** <None>

**Allow web servers on the local network (subnet)**
Indicates whether the Telnet Client can connect with any web server or only with servers on the local network.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>

**Add Address**
Select this button to add a new IP or web address to the list of addresses that Telnet Client is permitted to connect with.

**Delete Address**
Select this button to delete any address in the list.

**Configuration Tab**
Use the Configuration tab to modify emulation parameters for the Host Profile.
**Using the Industrial Browser**

This section provides information about using the Telnet Client Industrial Browser, including the following:

- Basic Navigation
- Specifying the Home Page
- Developing Web Pages for the Industrial Browser
Basic Navigation

The Telnet Client Industrial Browser interface provides basic commands for navigating web pages.

To navigate within the Industrial Browser:

1. Connect to a WEB emulation session.

2. Tap and hold on the screen.

   A menu appears.

3. From this menu, you can select from the following options:

   Back  Returns the browser to the previous web page.

   Forward Returns to the screen displayed before Back was selected.

   Stop  Stops the web page from loading.

   Refresh Reloads the current web page.

   Home  Returns the browser to the specified home page.

   Text Size Displays a menu with the following text size options:

   • Largest
   • Larger
   • Medium
   • Smaller
   • Smallest

Specifying the Home Page

The home page is the first page users will see when connecting to the Industrial Browser; it is also the page users will be returned to when they select Home. The home page will be the location you set up in the Host Profile for WEB emulation. This can either be an IP address or a specific web address. Refer to Host Profile Settings on page 187 for more information.
Developing Web Pages for the Industrial Browser

The Telnet Client Industrial Browser supports various META tags and IDA commands. You can use these tags to develop custom web pages that enable specific functionality in the Industrial Browser. For detailed information about the supported tags and commands, refer to the Wavelink Telnet Client Industrial Browser Reference Guide.
Chapter 11: Avalanche Integration

This section provides the following information:

- Overview of Avalanche Integration
- Using Session Monitor
- Using Real-Time Statistics

Overview of Avalanche Integration

A number of additional features are available for the Telnet Client when you choose to install the Telnet Client via the Avalanche framework.

Avalanche-installed Telnet Clients offer the following Avalanche-integrated features:

- **Session Monitor**: Allows you to monitor and to take control of the Telnet Client remotely from the Avalanche Console.

- **Real-Time Statistics**: Allows you to view real-time statistics, including session length and number of scans, from the Avalanche Console.

To take advantage of the Avalanche features of the Telnet Client, your Avalanche environment must meet the following requirements:

- Avalanche Manager 3.5 (or greater version), Avalanche MC, or Avalanche SE for Session Monitor

- Avalanche Manager 3.4 (or greater version), Avalanche MC, or Avalanche SE for Real-Time Statistics

- Avalanche Enabler 3.x (or greater version)

- A valid Avalanche license for the mobile device running the Telnet Client

- A valid platform or maintenance license for the Telnet Client

- Telnet Client 5.x (or greater version)
Using Session Monitor

The Session Monitor utility allows you to view the Telnet Client on a mobile device from the Avalanche Console. Session Monitor includes an override feature that allows you to take control of the Telnet Client on the mobile device. Session Monitor also includes a logging feature that allows you to create a trace for Telnet sessions.

This sections provides the following information:

- Enabling Session Monitor
- Configuring Session Monitor
- Launching Session Monitor
- Session Override
- Tracing Sessions

**NOTE** Session Monitor requires Avalanche Console and a valid Avalanche license.

Enabling Session Monitor

The following tasks are required to enable Session Monitor.

1. Install the Telnet Client package in Avalanche Console.
2. Configure the Telnet Client to use Session Monitor.
3. Preform an Avalanche update to deploy the Telnet Client to the mobile device.
4. Launch the Telnet Client on the mobile device.
5. Launch Session Monitor from the Avalanche Console.

Configuring Session Monitor

Configure the following Session Monitor parameters in the Telnet Emulation Parameters:
• **Session Monitor Address.** These are the IP addresses of computers that the Telnet Client allows to do session monitoring. If no addresses are specified, the Telnet allows session monitoring from any computer.

• **Session Monitor Override Timeout.** This is the maximum number of minutes that Session Monitor is allowed to override the session. After the time expires, the override setting is disabled and control returns to the client device. The default time-out for override mode is set to 0 (never). This means the override mode will never time-out and the client regains control only if override mode is disabled manually.

• **Session Monitor Password.** This is the password required for Session Monitor connections. The password is loaded in the Emulation Parameters file and is never entered by the user. It has a 63 character limit. If no password is entered, the Telnet Client will not accept Session Monitor connections.

• **Session Monitor Port.** This is the port that the Telnet Client listens to for Session Monitor connections.

**To configure Session Monitor**

1. Launch the Avalanche Console.

2. In the **Software Profiles** tab, select the profile that contains the Telnet Client package.

3. In the **Software Packages** tab, select the Telnet Client software package and click **Configure**.

   The Configure Software Package dialog box appears.

4. Select **Emulation Parameters** and click **OK**.

   Configuration Manager launches.

5. Expand the Emulation folder.

6. Expand the Session Monitor folder.

7. Double-click the Session Monitor menu items to change the parameters.
NOTE The Session Monitor Password is the only required configuration. The other parameters are optional configurations.

8 Once you have configured the Session Monitor parameters, click the Save button.

9 Close the configuration utility.

10 Perform an Avalanche update to download the new configuration to the mobile device.

Launching Session Monitor

You can launch Session Monitor from the Avalanche Console.

To launch Session Monitor
1 Launch the Avalanche Console.

2 From the list of mobile devices, right-click the device you want to monitor.

   A menu list appears.

   ![Session Monitor menu]

   Figure 11-1. Launching Session Monitor

3 Select the Session Monitor option.

NOTE The client device and the Avalanche Console need to be communicating over the network.
The Telnet Session Monitor screen opens and connects to the session. The yellow-lined box represents what the device user can see.

![Image of Telnet Session Monitor]

**Figure 11-2. Connecting to Session Monitor**

**NOTE** If both the mobile device and the Avalanche PC have SSL support installed, the Session Monitor network information will be encrypted.

**Session Override**

Use the session override option of Session Monitor to take control of the Telnet Client. When you enable session override, the mobile device user will not be able to interact with the Telnet Client.

**To enable override mode**

1. In Session Monitor, access the **Monitor** menu.

2. Select the **Session Override** option.
The session remains in override mode until the override timeout minutes expire or until you manually disable the session override option.

**Tracing Sessions**

Use the *Log File Settings* dialog box to configure the Session Monitor log file to trace Session Monitor sessions.

**To trace a session**

1. In Session Monitor, access the *File* menu.
2. Select the *Log to File* option.
3. Configure the log file settings.
4. In the *Log File Path* text box, enter the path to the directory where you want to save the log file.
5. Click *OK*.
Figure 11-4. Configuring Log File Settings

**NOTE** The log file is saved as sessionlog.txt in the directory specified in Log File Path text box. If sessionlog.txt already exists, the log file will attempt to save as sessionlog2.txt, sessionlog3.txt, etc. until it finds a non-existing file name in the specified log file path.

**Using Real-Time Statistics**

The Telnet Client periodically transmits emulation-specific information to Avalanche Console. Avalanche Console displays the information it receives in the Properties tab of the Mobile Device Details dialog box for the mobile device.

The Avalanche Console displays Telnet session information including:

- **Telnet-Specific Information.** This includes information on the current Telnet Client version, the mobile device battery power, and SSL support and use.

- **Session-Specific Information.** This includes information on barcode, MSR and RFID scanning, session connect time, and running time of the current session.
By default, the Telnet Client transmits emulation-specific information to Avalanche Console every five minutes (300 seconds). You can modify this RealTimeStatsInterval property in the Properties tab of the Mobile Device Details dialog box.

This document provides the following information:

- Viewing real-time statistics
- Modifying real-time statistics

---

**NOTE** Real-Time Statistics requires Avalanche Console and a valid Avalanche license for the mobile device.

---

**Viewing Real-Time Statistics**

You can view the real-time statistics from the Properties tab of the Avalanche Client Controls dialog box.

**To view the statistics:**

1. Launch the Avalanche Console.

2. From the list of mobile devices, right-click the device you want to monitor.

3. Select Mobile Device Details.

   The Mobile Device Details dialog box opens.

4. Click the Properties tab.

   The Properties tab contains a number of entries specific to the Telnet Client.
Figure 11-5. Real-Time Statistics

The following list describes the Telnet Client real-time statistics that are displayed in the Properties tab.

**RealTimeStatsInterval**

Indicates how often the Telnet Client sends real-time statistics information to Avalanche Console. The interval is measured in seconds.

Default: 300 seconds

Note: It is recommended to change the time to five (5) seconds when you are monitoring a device.

**Telnet Version**

Displays the current version of the Telnet Client.

**Telnet SSL Supported**

Indicates whether SSL is supported.

**Telnet Battery Power**

Indicates the remaining battery power of the mobile device.

**Telnet Average Time Total**

Indicates the length of time the session statistics are tracked.

Default: 600 seconds
| **Telnet Average Time Display** | Indicates the interval time for barcode, MSR, and RFID scans and transactions. The default setting (60 seconds) means that scans display as a number of scans per minute. If you change this to property to 120 seconds, the scans display as number of scans per two minutes. |
| **Default:** 60 seconds |

| **Telnet Time Running** | Displays the current running time for the Telnet Client. |

| **Telnet Session <n> Connect Time** | Displays the amount of time the Telnet session has been running, where <n> indicates the Telnet session (1 - 4). |

| **Telnet Session <n> SSL in Use** | Indicates whether the Telnet session is using SSL, where <n> indicates the Telnet session (1-4). |

| **Telnet Session <n> Barcode Scans** | Displays the number of barcode scans per <<x>> seconds for the Telnet Session, where <n> indicates the Telnet session (1-4) and <<x>> indicates the time set in the Telnet Average Time Display property. |

| **Telnet Session <n> MSR Scans** | Displays the number of MSR scans per <<x>> seconds for the Telnet Session, where <n> indicates the Telnet session (1-4) and <<x>> indicates the time set in the Telnet Average Time Display property. MSR scan information displays only if the mobile device supports MSR scanning. |

| **Telnet Session <n> Transaction** | Displays the number of transactions per <<x>> seconds for the Telnet Session, where <n> indicates the Telnet session (1-4) and <<x>> indicates the time set in the Telnet Average Time Display property. |

| **Telnet Session <n> RFID** | Displays the number of RFID scans per <<x>> seconds for the Telnet Session, where <n> indicates the Telnet session (1-4) and <<x>> indicates the time set in the Telnet Average Time Display property. RFID scan information displays only if the mobile device supports RFID scanning. |
Modifying Real-Time Statistics

While many of the Telnet session parameters indicate they are changeable, you should only modify RealTimeStatsInterval, Telnet Average Time Total, and Telnet Average Time Display.

To modify a statistic:

1. Launch the Avalanche Console.
2. From the list of mobile devices, right-click the device you want to monitor.
3. Select Mobile Device Details.
   - The Mobile Device Details dialog box opens.
4. Click the Properties tab.
5. Click the Value column of the statistic you want to change.
6. Type the new Value.
7. Click the Apply Changes button.
8. Update the device to download the new property values to the device.

NOTE If the Telnet Client is currently running, modified real-time statistics will not display until the next real-time statistics transmit to the Avalanche Console. For example, if you modify the RealTimeStatsInterval property from 300 seconds to five (5) seconds, it may take the remaining seconds of the previous 300-second setting before the statistics begin to update every five seconds.
Chapter 12: Manually Configuring the Telnet Client

This section provides the following information:

You can configure certain Telnet Client parameters manually (that is, at the mobile device), including:

- Manually Configuring Host Profiles
- Manually Configuring Emulation Parameters

Manually Configuring Host Profiles

You can manually perform the following tasks with the Telnet Client interface:

- Creating a New Host Profile
- Modifying an Existing Host Profile
- Deleting an Existing Host Profile

NOTE When you download a new Telnet Client configuration to the mobile device using Microsoft ActiveSync or Avalanche Console, any manual changes that you have made will be overwritten.

NOTE For information about host profiles, see Chapter 3: Host Profiles on page 29.

Accessing Host Profiles

To add, modify, or delete host profile, you must access the Host Profiles dialog box.

To access the host profiles dialog box:
1. On the mobile device, launch the Telnet Client.
2. In the Telnet Client, access the Options menu.
3 From the **Options** menu, select **Configure > Host Profiles**.

The **Input Password** dialog box appears.

4 In the **Input Host Config Password** text box, type the RF Config Password.

**NOTE** The default RF Config Password is “system”. For information about modifying the RF Config Password, see *Configuring Passwords* on page 225. If no RF Config Password is configured, the Telnet Client will not prompt you for a password.

5 Press the **Enter** key.

The **Edit Host Profile** dialog box appears.

6 Use the **Edit Host Profile** dialog box to add, modify, or delete host profiles.

**Creating a New Host Profile**

You can use the **Edit Host Profile** dialog box to create a new host profile for the Telnet Client.

**To create a new host profile:**

1 On the mobile device, launch the Telnet Client.

2 Use the Telnet Client **Options** menu to access the **Edit Host Profiles** dialog box.

3 In the **Edit Host Profile** dialog box, click **Add**.

A new **Edit Host Profile** dialog box appears.

4 Use the **Edit Host Profile** dialog box to configure the basic parameters of the host profile (alias, IP address, TCP port number, and emulation type).

5 Select **More** to access and configure other configuration parameters that are specific to the emulation type that you have selected.

**NOTE** For more information about other configurable parameters for a host profile, see *Host Profile Settings* on page cxxi.
6 After you have finished configuring the host profile, select **Save** in the *Edit Host Profile* dialog box.

The *Edit Host Profiles* dialog box appears, and you are returned to the first *Edit Host Profile* dialog box, which now displays the new host profile.

7 Select **Done**.

The *Edit Host Profile* dialog box closes and you return to the primary Telnet Client interface.

---

**NOTE** To exit either of the *Edit Host Profile* dialog box without saving the changes that you have made, press **Esc**.

---

**Modifying an Existing Host Profile**

You can use the *Edit Host Profile* dialog box to modify the parameters of an existing host profile.

**To modify an existing host profile:**

1. On the mobile device, launch the Telnet Client.

2. From the Telnet Client **Options** menu, access the *Edit Host Profile* dialog box.

3. In the list of profiles in the *Edit Host Profile* dialog box, select the host profile dialog box that you want to modify.

4. Select **Edit**.

5. Use the *Edit Host Profile* dialog box to modify the basic parameters of the host profile (alias, IP address, TCP port number, and emulation type).

6. Select **More** to access and configure other emulation type-specific parameters for the host profiles.

---

**NOTE** For more information about the parameters in the *Edit Host Profile* dialog box and the parameters in the other emulation type-specific dialog boxes, see *Host Profile Settings* on page cxc.

7 After you have modified the parameters for the host profile, select **Save**.
The changes that you have made are applied to the host profile. The *Edit Host Profile* dialog box closes and you return to the first *Edit Host Profile* dialog box.

8 Select **Done**.

The *Edit Host Profile* dialog box closes and you return to the primary Telnet Client interface.

---

**NOTE** To exit either of the *Edit Host Profile* dialog boxes without saving the changes that you have made, press **Esc**.

---

**Deleting an Existing Host Profile**

You can use the *Edit Host Profile* dialog box to delete an existing profile.

**To delete an existing host profile:**

1 On the mobile device, launch the Telnet Client.

2 From the Telnet Client **Options** menu, access the *Edit Host Profile* dialog box.

3 From the list of host profiles in the *Edit Host Profile* dialog box, select the host profile that you want to delete.

4 Select **Delete**.

The host profile is deleted from the list of host profiles in the *Edit Host Profile* dialog box.

5 Select **Done**.

The *Edit Host Profile* dialog box closes and you return to the primary Telnet Client interface.

---

**NOTE** To exit the *Edit Host Profile* dialog box without saving the changes that you have made, press **Esc**.
**Host Profile Settings**

This section provides details about the configurable parameters that are available in the various host profile dialog boxes.

**Edit Host Profile Parameters**

The following list describes the options and configurable parameters in the *Edit Host Profile* dialog box.

**Alias**

Indicates the name of the host profile. Usually, this is the name or alias of the host system with which the mobile device creates a Telnet session.

*Possible Values:* 1 - 50 alpha-numeric characters

*Default:* <None>

**Address**

Indicates the IP address or host name of the host system.

*Possible Values:* Any valid IP address, host name, or web address

*Default:* <None>

**Port**

Indicates the TCP port on which the host system is listening for Telnet connections.

*Possible Values:* 0 - 65535

*Default:* 23

**Emulation**

Indicates the type of emulation that the host system uses.

*Available Options:* <IBM-5251-11> <IBM-3278-2> <IBM-3279-2> <IBM-3279-2E> <VT100> <VT220> <HP> <WEB>

*Default:* <IBM-5251-11>

**Save**

Select this button to save the host profile and close the *Edit Host Profile* dialog box.
More

Select this button to access other, emulation type-specific parameters for the host profile.

Config

Select this button to modify the emulation parameters for the host profile.

More 5250 Options

The More 5250 Options dialog box appears when the following criteria are met:

- You set the emulation type is to 5250 in the Edit Host Profile dialog box.
- You click More in the Edit Host Profile dialog box.
The following list describes the options and configurable parameters in the *More 5250 Options* dialog box.

**Device Name**
Indicates the workstation ID that mobile devices use to connect to the host system. This includes static characters and the following switches, which are used to capture dynamic data that is specific to each mobile device:

- **%a - %d.** Captures specific octets of the IP address of the mobile device. For example, use `%a%b%c%d` to capture all four IP octets of the address of the mobile device, or use `%d` to capture only the last octet of the IP address of the mobile device.

- **%m - %r.** Captures specific octets of the MAC address of the mobile device. (For example, use `%p%q%r` to capture the last three octets of the MAC address of the mobile device.)

- **%s.** Captures the session number.

- **%t.** Captures the Avalanche terminal ID of the mobile device. (If the mobile device is not an Avalanche client, this parameter is invalid.)

**Possible Values:** 1 - 20 alpha-numeric characters plus switches (see above)

**Default Value:** None

**NOTE:** IBM hosts usually truncate workstation IDs that are more than 10 characters. Also, the workstation ID should not begin with a numeric character.

**OK**
Select this button to save the changes that you have made and return to the *Edit Host Profile* dialog box.

**More VT Options**
The *More VT Options* dialog box appears when the following criteria are met:
• You have set the emulation type in the Edit Host Profile dialog box to VT100, VT220, or HP.

• You click More in selected in the Edit Host Profile dialog box.

The following list describes the options and configurable parameters in the More VT Options dialog box.

**Telnet Negotiation String**
Indicates the Telnet negotiation string that the mobile device should use when establishing a Telnet session with the host system.

**Possible Values:** Any valid Telnet negotiation string

**Default:** <None>

**OK**
Select this button to save the changes that you have made and return to the Edit Host Profile dialog box.

**Login**
Select this button to access the Edit AutoLogin dialog box, which allows you to configure auto login parameters for the host connection.

**Edit AutoLogin**
The Edit AutoLogin dialog box is accessed through the Login button in the More VT Options dialog box.

The following list describes the options and configurable parameters in the Edit AutoLogin dialog box.

**Name Prompt**
Indicates the user name prompt that the host system uses.

**Possible Values:** Any valid user name prompt

**Default:** <None>

**Name**
Indicates the user name that the mobile device supplies at the user name prompt.

**Possible Values:** Any valid user name

**Default:** <None>
Manually Configuring Emulation Parameters

You can manually configure certain Telnet Client emulation parameters on a per-host basis.

**Password Prompt** Indicates the password prompt that the host system uses.

*Possible Values:* Any valid password prompt

*Default:* <None>

**Password** Indicates the password that the mobile device supplies at the password prompt.

*Possible Values:* Any valid user password

*Default:* <None>

**Command Prompt** Indicates the command prompt that the host system uses.

*Possible Values:* Any valid command prompt

*Default:* <None>

**Command** Indicates the command that the mobile device supplies at the command prompt.

*Possible Values:* Any valid command

*Default:* <None>

**OK** Select this button to save the changes that you have made and return to the *More VT Options* dialog box.

**NOTE** For more information about global and per-host emulation parameters, see *Chapter 4: Emulation Parameters* on page 63.
NOTE You must use the Configuration Manager to modify most emulation parameters. For information about using Configuration Manager, see Using Configuration Manager on page 72.

**Accessing and Modifying Per-Host Emulation Parameters**

You can manually modify certain per-host emulation parameters.

**To access and modify per-host emulation parameters:**

1. On the mobile device, launch the Telnet Client.
2. Access the Telnet Client **Options** menu.
3. From the Telnet Client Options menu, select **Configure > Emulation**.

   The **Input Password** dialog box appears.
4. In the **Input Terminal Config Password** text box, type the term config password.

**NOTE** The default Term Config password is “config”. For information about modifying the Term Config password, see Configuring Passwords on page 235. If no Term Config password is configured, the Telnet Client will not prompt you for a password.

5. Select **OK**.

   The **Select Host** dialog box appears.
6. In the **Select Host** dialog box, select the host profile that contains the emulation parameters that you want to modify.
7. Select **OK**.

   The **Settings** dialog box appears for the host profile.
8. Use the various tabs in the **Settings** dialog box to modify the emulation parameters for the host profile.
NOTE For more information about the tabs and the configurable parameters in each tab of the Settings dialog box, see Per-Host Emulation Parameters on page cxvii.

9 After you have configured the emulation parameters for the host profile, select the OK button in the upper right corner of the Settings dialog box.

The Settings dialog box closes and you return to the primary Telnet Client interface.

Per-Host Emulation Parameters

This section provides information about the parameters in the various tabs of the Settings dialog box.

VTXX Settings

Use the VTXX tab in the Settings dialog box to configure parameters for VT-type emulation. If the host profile is configured for IBM-type emulation, you do not need to configure the VTXX tab.

The following list describes the parameters in the VTXX tab.

Local Echo Indicates whether the Telnet Client echoes characters that it received from a VT host.

Possible Values: <Enabled> <Disabled>

Default: <Disabled>
IBM Host Settings

Use the IBM Host tab in the Settings dialog box to configure parameters for IBM-type emulation. If the host profile is configured for VT-type emulation, you do not need to configure the IBM Host tab.

The following table describes the configurable options in the IBM Host tab.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 Bit Control Codes</td>
<td>Indicates whether to use 8-bit ANSI control codes for VT-type emulation.</td>
</tr>
<tr>
<td>Possible Values:</td>
<td>Possibilities: Enabled / Disabled</td>
</tr>
<tr>
<td>Default:</td>
<td>Disabled</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backspace Sends Delete</td>
<td>Indicates whether the Telnet Client should send a delete control character when a user presses the backspace key.</td>
</tr>
<tr>
<td>Possible Values:</td>
<td>Possibilities: Enabled / Disabled</td>
</tr>
<tr>
<td>Default:</td>
<td>Disabled</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5250 - Column Separator Dot</td>
<td>Indicates whether the Telnet Client displays a period or vertical line between each character when the host system uses a special column format mode.</td>
</tr>
<tr>
<td>Possible Values:</td>
<td>Possibilities: Enabled / Disabled</td>
</tr>
<tr>
<td>Default:</td>
<td>Enabled</td>
</tr>
</tbody>
</table>
WEB Settings
Use the WEB tab in the Settings dialog box to configure parameters for WEB emulation.

The following table describes the configurable options in the WEB tab.

- **WEB Allow Compression**
  Determines whether the browser will automatically decompress any compressed information it receives.
  
  **Possible Values:** <Yes> <No>
  
  **Default:** <Yes>

- **WEB Allow Cookies**
  Indicates whether the web server is able to access cookies on the client.
  
  **Possible Values:** <Yes> <No>
  
  **Default:** <Yes>

- **WEB Automatic SIP**
  Determines whether the SIP keyboard is automatically displayed when the cursor is moved to an edit field.
  
  **Possible Values:** <Enabled> <Disabled>
  
  **Default:** <Disabled>
WEB Default Scanner Auto Keys
Determine the default post-scan action for web pages without Tab or Enter key META tags

Possible Values: <No Keys> <Enter> <Tab> <Enter and Tab>

Default: <No Keys>

WEB Default Text Size
Indicates whether the default text size should be used when the browser first appears.

Possible Values: <Smallest> <Smaller> <Medium> <Larger> <Largest> <No Change>

Default: <No Change>

WEB Detect Out-Of-Range
Indicates whether Telnet will prevent the user from interacting with a web page if the Wireless LAN adapter is not associated with an access point.

Possible Values: <Enabled> <Disabled>

Default: <Enabled>

WEB Display Images
Determines if embedded images and/or placeholders should be displayed on web pages.

Possible Values: <Enabled> <Disabled>

Default: <Enabled>

WEB Engine Type
Indicates the type of web engine that should be used. The Enhanced engine is required to support several advanced features.

Possible Values: <Standard> <Enhanced>

Default: <Enhanced>
WEB Error 404 Override
Determines whether a custom or standard 404 error message is displayed.

Possible Values: <Display Standard 404 Error Messages> <Custom Message>

Default: <Display Standard 404 Error Messages>

WEB Error Messages
Determine whether server error messages relayed from the server are displayed.

Possible Values: <Server Error Messages> <Local Error Messages>

Default: <Server Error Message>

Message Settings
Use the Message tab of the Settings dialog box to configure the settings for messages that the mobile device receives from the host system. Certain parameters in the Message tab are applicable only to 5250- and 3270-type emulation.
The following list describes the configurable options in the **Message** tab.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Message Line</strong></td>
<td>Specifies the line from the host screen that the Telnet Client reads to display as the message line. The Telnet Client displays the message line each time its contents change. When the contents of the message line are not valid, the line appears in reverse video at the top of the display.</td>
</tr>
<tr>
<td><strong>Possible Values:</strong></td>
<td>0 - 24</td>
</tr>
<tr>
<td><strong>Default:</strong></td>
<td>24</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>Use a value of 0 to prevent the display message.</td>
</tr>
<tr>
<td><strong>Auto Reset Delay</strong></td>
<td>Indicates the amount of time (in seconds) the Telnet Client waits before sending a reset to the host when the <strong>Reset Required</strong> parameter is set to <strong>Never</strong>.</td>
</tr>
<tr>
<td><strong>Possible Values:</strong></td>
<td>0 - 5 (seconds)</td>
</tr>
<tr>
<td><strong>Default:</strong></td>
<td>2</td>
</tr>
<tr>
<td><strong>Message Beeps</strong></td>
<td>Indicates the number of additional beeps that occur on the mobile device when the Telnet Client receives a system message.</td>
</tr>
<tr>
<td><strong>Possible Values:</strong></td>
<td>Up to 255 characters, but only integer values are valid</td>
</tr>
<tr>
<td><strong>Default:</strong></td>
<td>0</td>
</tr>
</tbody>
</table>
**Reset Required**  
*(5250/3270 Only)*  
Indicates the situations that require the user to press the reset key.

Options include:

- **On All Messages.** Requires a reset on screens that display information on line 24 (the bottom display line).

- **On Errors.** Requires a reset on screens that have an error indicator.

- **Never.** Requires the user to use a reset, but Telnet Client automatically performs the reset when it detects an error indicator.

**Possible Values:** <OnErrors> <On All Messages> <Never>

**Default:** <Disabled>

**Use Enter As Reset**  
Indicates whether the enter key on the mobile device functions as the reset key when the mobile device is in an error state.

**Possible Values:** <Enabled> <Disabled>

**Default:** <Disabled>

**Font Settings**

Use the **Font** tab in the **Settings** dialog box to configure the way that text displays for the host connection.
The following list describes the configurable options in the Font tab.

**Name**
Indicates the font that the Telnet Client uses to display text in the emulation screen.

**Possible Values:** Any font installed on the mobile device

**Default Values:** <Courier New>

**Size**
Indicates the size (in points) in which text displays in the emulation screens.

**Possible Values:** 6 - 24

**Default Value:** 7

**Weight**
Indicates the weight that is applied to text in the emulation screens.

**Possible Values:** <Normal> <Bold>

**Default Value:** <Normal>

**Left (Clipping)**
Indicates the amount of white space (in font points) that the Telnet Client crops from the left of the font.

**Possible Values:** Up to 255 characters, but only integer values are valid

**Default Value:** 0

**Right (Clipping)**
Indicates the amount of white space (in font points) that the Telnet Client crops from the right of the font.

**Possible Values:** Up to 255 characters, but only integer values are valid

**Default Values:** 0
Chapter 12: Manually Configuring the Telnet Client

Display Settings

Use the Display tab in the Settings dialog box to configure how the Telnet Client displays.

The following list describes the configurable options in the Display tab.

**Top (Clipping)**
Indicates the amount of white space (in font points) that the Telnet Client crops from the top of the font.

**Possible Values:** Up to 255 characters, but only integer values are valid

**Default Value:** 0

**Bottom (Clipping)**
Indicates the amount of white space (in font points) that the Telnet Client crops from the bottom of the font.

**Possible Values:** Up to 255 characters, but only integer values are valid

**Default Value:** 0

**Menu**
Indicates whether the Telnet Client displays the Telnet Client menu during an active Telnet session.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Enabled>

**Hide Menu (Button)**
Click this button to access a dialog box that will allow you to configure a key sequence that will hide the Telnet Client menu during an active Telnet session.

**Hide Menu (Text Box)**
Indicates the key sequence that is configured to hide the Telnet Client menu during an active Telnet session.
**Vertical Scrollbar**
Indicates whether the Telnet Client displays the vertical scrollbar during a Telnet session.

*Possible Values:* <Enabled> <Disabled>

*Default Value:* <Disabled>

**Horizontal Scrollbar**
Indicates whether the Telnet Client displays the horizontal scrollbar during a Telnet session.

*Possible Values:* <Enabled> <Disabled>

*Default Value:* <Disabled>

**Hide Keyboard (Button)**
Click this button to access a dialog box that will allow you to configure a key sequence that hides/reveals the Telnet Client emulation keyboard.

**Hide Keyboard (Text Box)**
Indicates the key sequence that is configured to hide/reveal the Telnet Client emulation keyboard.

**View Settings**
Use the **View** tab in the **Settings** dialog box to configure how the view screen functions for the host connection.

The following list describes the configurable options in the **View** tab.

**Free Cursor**
Indicates whether a user is allowed to move the cursor into “protected” areas of the screen.

*Possible Values:* <Enabled> <Disabled>

*Default Value:* <Enabled>

**Scrolling (Full Screen Mode)**
Indicates whether the Telnet Client uses full-screen mode, which allows the user to scroll around the virtual display.

*Possible Values:* <Enabled> <Disabled>

*Default Value:* <Enabled>
**Scroll Offsets - Vert (Full-Screen Mode Only)**

Specifies the number of columns that the vertical display moves when the cursor crosses the vertical edge of the screen.

**Possible Values:** 0 - 80

**Default Value:** 0

**NOTE:** Use 0 to indicate the current vertical display size.

**Scroll Offsets - Horz (Full-Screen Mode Only)**

Specifies the number of rows that the virtual display moves when the cursor crosses the horizontal edge of the screen.

**Possible Values:** 0 - 24

**Default Value:** 0

**NOTE:** Use 0 to indicate the current horizontal display size.

**Fixed Screen Mode**

Indicates whether the Telnet Client fixes the display on the mobile device to a specific position in the virtual display. When fixed-screen mode is enabled, the same portion of the virtual display appears on the display screen without regard to the location of the cursor.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>

**NOTE:** If you enable fixed-screen mode, you must also specify the position in the Fixed Screen Window Origin group.
**Window Origin - Left**  
*(Fixed-Screen Mode Only)*  
Specifies the virtual screen column where the display screen of the mobile device is fixed.  

**Possible Values:** 1 - 79  

**Default Value:** 1  

**Window Origin - Top**  
*(Fixed-Screen Mode Only)*  
Specifies the virtual screen row where the display screen of the mobile device is fixed.  

**Possible Values:** 1 - 24  

**Default Value:** 1  

**Cursor Settings**  
Use the **Cursor** tab in the *Settings* dialog box to configure the function of the cursor in emulation screens for the host connection.  

The following list describes the configurable options in the **Cursor** tab.  

**Cursor Edge Zones - Left**  
Specifies the left border of the cursor zone in the virtual display. When the cursor moves outside of the border, the Telnet Client repositions the screen over the virtual display, centering the cursor on the display screen of the mobile device.  

**Possible Values:** Up to 255 characters, but only integer values are valid  

**Default Value:** 4  

**Cursor Edge Zones - Right**  
Specifies the right border of the cursor zone in the virtual display. When the cursor moves outside of the border, the Telnet Client repositions the screen over the virtual display, centering the cursor on the display screen of the mobile device.  

**Possible Values:** Up to 255 characters, but only integer values are valid  

**Default Value:** 1
Chapter 12: Manually Configuring the Telnet Client

Tiling - Vert Mode
Determine how the Telnet Client handles vertical tiling. Options include:

- None. The Telnet Client repositions the screen on the cursor.
- TopOnly: The Telnet Client repositions the screen in the uppermost row of tiles.
- All. The Telnet Client always tiles vertically.

Possible Values: <All> <None> <TopOnly>
Default Value: <TopOnly>

Tiling - Horz Mode
Determine how the Telnet Client handles horizontal tiling. Options include:

- None. The Telnet Client positions the screen around the cursor.
- LeftOnly. The Telnet Client positions the screen around the leftmost column of tiles.
- All. The Telnet Client always tiles horizontally.

Possible Values: <All> <LeftOnly> <None>
Default Value: <LeftOnly>

Tiling - Vert
Specifies the height of the logical screen in “tiles” for tiling mode.

Possible Values: 0 - screen height (in rows)
Default Value: 0

Tiling - Horz
Specifies the width of the logical screen in “tiles” for tiling mode.

Possible Values: 0 - screen width (in columns)
Default Value: 0
**Beeps Settings**

Use the Beeps tab in the *Settings* dialog box to configure the beeps that the mobile device plays when it receives messages or errors from the host system.

The following list describes the configurable options in the Beeps tab.

**Message Beep**
Indicates the sound that the mobile device generates when it receives a message from the host system.

**Possible Values:** <Default> <SystemAsterisk> <SystemExclamation> <SystemExit> <SystemHand> <SystemQuestion>

**Default Value:** <Default>

**Error Beep**
Indicates the sound that the mobile device generates when it receives an error from the host system.

**Possible Values:** <Default> <SystemAsterisk> <SystemExclamation> <SystemExit> <SystemHand> <SystemQuestion>

**Default Value:** <Default>

**Silent Mode**
Indicates whether silent mode is enabled. If silent mode is enabled, the mobile device will not play beeps when it receives messages or errors from the host system.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>

**Test**
Tests the beep settings that are configured. The mobile device will play the beeps that are configured for messages and errors, in that order.

**Telnet Settings**

Use the Telnet tab in the *Settings* dialog box to configure the Telnet auto-connect feature for connections to the host system.
The following list describes the configurable options in the Telnet tab.

**Auto Connect**
Indicates whether the mobile device should attempt to reconnect to the host system when the host system terminates the session.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>

**Printer Settings**
Use the Printer tab in the Settings dialog box to configure the printer that the mobile device is using for the host connection.

The following list describes the options and configurable parameters in the Printer tab.

**Printer**
Indicates the printer that the mobile device uses.

**Possible Values:** <PS1000> <PS1001> <PS1004> <LINEPRINTER> <DUMB> <COMTEC> <PATHFINDER> <RASCAL> <RENEGADE> <COMTECL_PS> <CODE_COURIER> <COMTEC_RF> <COMTEC_RF_960> <TEC> <User Defined>

**Default Value:** <PS1000>

**Port**
Indicates the COM port on the mobile device to which the printer is connected.

**Possible Values:** <COM1>

**Default Value:** <COM1>

**Baud**
Indicates the baud rate of the serial connection to the printer.

**Possible Values:** <9600> <14400> <19200> <38400> <57600> <115200>

**Default Value:** <9600>
| **Parity** | Indicates the parity of the serial connection to the printer. Possible Values: <None> <Even> <Mark> <Odd> <Space> Default Value: <None> |
| **Data** | Indicates the data bits (the number of bits in each octet) of the serial connection to the printer. Possible Values: <4> <5> <6> <7> <8> Default Value: <8> |
| **Stop** | Indicates the number of stop bits that the serial connection to the printer uses. Possible Values: <1> <2> Default Value: <1> |
| **Wakeup** | Indicates the string of characters that the mobile device sends to the printer as a wakeup. You can represent the wakeup string as an ASCII or hex value. Possible Values: Any valid wakeup string Default Value: <None> |

- **Hex Value.** Type the hex values of the characters that you want the mobile device to send to the printer. For example, 0000 sends two nulls to the printer.

- **ASCII Value.** Use “<>” to enclose ASCII hex values. For example, <00> <00> sends two nulls to the printer.
**Hardware Flow Control**  Indicates whether the serial connection to the printer uses hardware flow control.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>

**Software Flow Control**  Indicates whether the serial connection to the printer uses software flow control.

**Possible Values:** <Enabled> <Disabled>

**Default Value:** <Disabled>
Appendix A: Using Microsoft ActiveSync

This section provides information about creating Microsoft ActiveSync connections between host systems and mobile devices.

Requirements

Before you create a Microsoft ActiveSync partnership, ensure that you have the following:

- Microsoft ActiveSync 3.7 (or better) installed on the host system
- Serial cable or USB cable to connect the host system to the mobile device
- Device cradle for the mobile device

Overview of Creating a Partnership

Creating a partnership involves the following tasks:

- Selecting the Microsoft ActiveSync Connection Method on the Mobile Device.
- Selecting the Microsoft ActiveSync Method on the Host System.
- Freeing a COM Port.
- Creating a Partnership.

Selecting the Microsoft ActiveSync Connection Method on the Mobile Device

Most mobile devices allow Microsoft ActiveSync connections over a serial or USB connection. Before you can establish a Microsoft ActiveSync partnership, you must select the connection method (serial or USB) on the mobile device.

To select the Microsoft ActiveSync connection method on the mobile device:

1. On the mobile device, launch Microsoft ActiveSync.
2. From the Microsoft ActiveSync Tools menu, select Options.
NOTE The Options option is only available when the mobile device is not engaged in an active partnership with a host system.

The PC Synchronization dialog box appears.

3 In the PC tab of the PC Synchronization dialog box, enable the Sync with this PC during manual sync checkbox.

4 Click Options....

The PC Synchronization Options dialog box appears.

5 Enable the Enable PC sync using this connection checkbox.

6 From the Enable PC sync using this connection menu list, select the connection method.

   • If you are using a USB cable to connect the host system and the mobile device, then select USB Default.

   • If you are using a serial cable to connect the host system and the mobile device, select the appropriate baud rate.

7 Click OK.

The PC Synchronization Options dialog box closes.

8 Click OK.

The PC Synchronization dialog box closes and you are returned to the Microsoft ActiveSync interface.

The mobile device is now configured with the correct synchronization method.

Selecting the Microsoft ActiveSync Method on the Host System

Use the Microsoft ActiveSync interface on the host system to configure the connection method (USB or serial).
To configure the connection method on the host system:
1  On the host system, launch Microsoft ActiveSync.
2  From the Microsoft ActiveSync File menu, select Connection Settings.

The Connection Settings dialog box appears.
3  Use the Connection Settings dialog box to configure the connection method between the host system and the mobile device:

• If you are using a USB connection, then enable the Allow USB connection with this desktop computer checkbox.

• If you are using a serial connection, then enable the Allow serial or infrared connection to this COM port checkbox, and then use the corresponding menu list to select the COM port that you are using.

The following figure provides an example.
4 Click OK.

The Connection Settings dialog box closes and you are returned to the Microsoft ActiveSync interface.

The host system is now configured with the correct Microsoft ActiveSync connection method.
Freeing a COM Port

If you are using a serial cable to connect the host system and the mobile device, you may need to ensure that the COM port to which you connect the serial cable is available for Microsoft ActiveSync to use.

Applications, including Microsoft ActiveSync, contend for “ownership” or exclusive use of the COM ports on the host system. Before you attempt to create a partnership, ensure that no other applications are using the COM port through which you will establish the partnership with the mobile device.

To free the COM port for Microsoft ActiveSync, shut down the application or stop the service that has control of the COM port.

For example, if you have installed Avalanche Console on the host system and have used the Console to perform serial updates on the mobile device, then Avalanche Console may have exclusive control of the COM ports on the host system. To free the COM port(s), access the Services administrative tool on the host system and stop the Wavelink Avalanche Console service.

Creating a Partnership

Microsoft ActiveSync uses two types of partnerships:

- **Standard.** A standard partnership allows you to synchronize data (for example, scheduling information) between the host system and the mobile device. Additionally, when you create a standard partnership, you do not have to recreate the partnership each time you reconnect the host system and the mobile device, which is the case with guest partnerships.

- **Guest.** A guest partnership does not synchronize data between the host system and the mobile device, but it requires less setup time than a standard partnership. However, because no synchronization takes place, you must re-establish a partnership each time you reconnect the host system and the mobile device.

You may use either a standard or guest partnership to install the Telnet Client and to download Telnet Client configurations to the mobile device.

Creating a Standard Partnership

You may use a standard partnership to install the Telnet Client and download Telnet Client configurations to the mobile device.
A standard partnership synchronizes data and settings between the host system and the mobile device.

**To create a standard Microsoft ActiveSync partnership:**

1. Connect the mobile device to the host system with a serial or USB cable.

2. On the mobile device, ensure that you have selected the correct connection method.

---

**NOTE** For more information about selecting the connection method, see *Selecting the Microsoft ActiveSync Connection Method on the Mobile Device* on page ccxv.

3. On the host system, ensure that you have enabled the correct connection method.

---

**NOTE** For more information about configuring the connection method on the host system, see *Selecting the Microsoft ActiveSync Method on the Host System* on page ccxvi.

4. If you are using a serial port to connect to the mobile device, ensure that the serial port on the host system is free for Microsoft ActiveSync to use.

---

**NOTE** For more information about freeing a COM port on the host system, see *Freeing a COM Port* on page ccxix.

5. On the host system, launch Microsoft ActiveSync.

6. From the Microsoft ActiveSync **File** menu, select **Get Connected**...

   The **Get Connected** dialog box appears.
7 Click **Next**.

Microsoft ActiveSync attempts to communicate with the mobile device.

Once Microsoft ActiveSync establishes a connection with the mobile device, the *New Partnership* dialog box appears.

8 In the *New Partnership* dialog box, enable the **Standard Partnership** option.

9 Click **Next**.

The *Specify how to synchronize data* dialog box appears.
In the Specify How to Synchronize Data dialog box, enable the synchronization option that you want to use.

Click Next.

The Select Synchronization Settings dialog box appears.

In the Select Synchronization Settings dialog box, enable the checkboxes the components that you want to synchronize between the host system and the mobile device.

NOTE You do not have to synchronize any data types to install the Telnet Client and download Telnet Client configurations to the mobile device.

The following figure shows the Select Synchronization Settings dialog box.
Appendix A: Using Microsoft ActiveSync

Figure A-4. Selecting the Components to Synchronize

13 Click Next.

The Setup Complete dialog box appears.

14 Click Finish.

Microsoft ActiveSync indicates that the mobile device and the host system are connected and synchronized.
The standard partnership is complete. You are now able to disconnect and re-connect the mobile device to the host system without having to re-create the partnership.

Creating a Guest Partnership

You may use a guest partnership to install the Telnet Client and download Telnet Client configurations to the mobile device.

To create a guest partnership:

1. Connect the mobile device to the host system with a serial or USB cable.

2. On the mobile device, ensure that you have selected the correct connection method.
NOTE For more information about selecting the connection method, see *Selecting the Microsoft ActiveSync Connection Method on the Mobile Device* on page ccxxv.

3 On the host system ensure that you have selected the correct connection method.

NOTE For more information about configuring the correct connection method on the host system, see *Selecting the Microsoft ActiveSync Method on the Host System* on page ccxxvi.

4 If you are using a serial port to connect to the mobile device, ensure that the serial port on the host system is free for Microsoft ActiveSync to use.

NOTE For more information about freeing a COM port on the host system, see *Freeing a COM Port* on page ccxxix.

5 On the host system, launch Microsoft ActiveSync.

6 From the Microsoft ActiveSync **File** menu, select **Get Connected**....

The **Get Connected** dialog box appears.
7 Click **Next**.

Microsoft ActiveSync attempts to communicate with the mobile device. Once Microsoft ActiveSync establishes a connection with the mobile device, the *New Partnership* dialog box appears.

8 In the *New Partnership* dialog box, select the **Guest Partnership** option.

9 Click **Next**.

Microsoft ActiveSync indicates that the guest partnership has been created.
Figure A-7. Microsoft ActiveSync Guest Partnership
Appendix B: Common Configuration Tasks

This section provides information about where to locate and configure common parameters for the Telnet Client, including:

- Configuring Passwords
- Configuring the Number of Concurrent Sessions
- Configuring IP Printing
- Configuring License Server IP Address
- Configuring Telnet Client Display Settings
- Configuring Telnet Client Lockdown
- Configuring Key Macros
- Configuring Screen Panning
- Configuring ActiveText
- Configuring Scan Handlers
- Configuring Autologin for VT Emulation
- Configuring Autologin for 5250 Emulation
- Configuring Telnet Negotiation Strings for VT Emulation
- Configuring Workstation IDs for 5250/3270 Emulation
- Enabling Battery Strength and Signal Strength Icons

Configuring Passwords

Certain components of the Telnet Client are password protected. Users at the mobile device must supply a password to perform the following functions:

- Manually configure host profiles
- Manually configure per-host emulation parameters
• Exit the Telnet Client

**NOTE** By default, an exit password is not configured. If an exit password is not configured, users are not prompted for a password when they choose to exit the Telnet Client application.

The following table provides information about and describes where each of these parameters can be configured in host profiles.

<table>
<thead>
<tr>
<th>Function</th>
<th>Location in Configuration Manager</th>
<th>Parameter Name</th>
<th>Default Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure Host Profiles</td>
<td>Emulation &gt; Common</td>
<td>RF Config Password</td>
<td>SYSTEM</td>
</tr>
<tr>
<td>Configure Per-Host Emulation Parameters</td>
<td>Emulation &gt; Common</td>
<td>Term Config Password</td>
<td>CONFIG</td>
</tr>
<tr>
<td>Exit Telnet Client</td>
<td>Emulation &gt; Common</td>
<td>Program Exit Password</td>
<td>&lt;None&gt;</td>
</tr>
</tbody>
</table>

**Table B-1: Configuring Telnet Client Passwords**

To configure a password:

1. Access the Configuration Manager.

2. In the Configuration Manager, locate the password parameter (see Table B-1) that you want to modify.

3. Use the dialog box for the password parameter to configure the password.

![Program Exit Password](image)

**Figure B-1. Configuring the Terminal Configuration Passwords**

4. Click **OK**.
5  Save the new configuration.

6  Close the Configuration Manager and download the new configuration to the mobile device.

**NOTE** For more information about using the Configuration Manager, see *Using Configuration Manager* on page 72.

---

**Configuring the Number of Concurrent Sessions**

The Telnet Client allows up to four concurrent Telnet sessions. However, by default, the Telnet Client is configured to allow a user to initiate and maintain one session. Use the Configuration Manager to specify the number of concurrent Telnet sessions that the Telnet Client should support.

**To modify the maximum number of concurrent sessions:**

1  Access the Configuration Manager.

2  Locate the Emulation > Common > Number of Sessions parameter.

3  Use the Number of Sessions dialog box to specify the maximum number of sessions.

![Number of Sessions dialog box](image)

**Figure B-2. Modifying the Maximum Number of Concurrent Sessions**

4  Click OK.

5  Save the new configuration.

6  Close the Configuration Manager and download the new configuration to the mobile device.
NOTE For more information about using the Configuration Manager, see Using Configuration Manager on page 72.

Configuring IP Printing

Most mobile devices do not use a printer that is directly connected. Instead, mobile devices print over the network via IP.

Use the Configuration Manager to configure mobile devices for IP printing.

To configure the Telnet Client for IP printing:
1. Access the Configuration Manager.
2. In the Configuration Manager, locate the Emulation > Printing > Printer Protocol parameter.
3. In the Printer Protocol dialog box, select TCPIP.

![Printer Protocol](image)

Figure B-3. Configuring Mobile Devices for IP Printing

4. Click OK.
5. Save the new configuration.
6. Close the Configuration Manager and download the new configuration to the mobile device.

NOTE For more information about using the Configuration Manager, see Using Configuration Manager on page 72.
Configuring License Server IP Address

The Telnet Client requires a valid license for full functionality. You can configure a license at the mobile device manually, or you can configure the client to obtain a license from a license server on the network.

A mobile device will automatically find the license server on the local IP subnet. However, if your license server is located on another subnet, you will need to configure the mobile device with the IP address of the license server.

Use the Configuration Manager to configure the license server IP address.

To configure the IP address of a remote license server:

1. Access the Configuration Manager.

2. In the Configuration Manager, locate the Emulation > Common > License Server Address parameter.

3. Use the License Server Address dialog box to configure the IP address of the license server.

4. Click OK.

5. Save the new configuration.

6. Close the Configuration Manager and download the new configuration to the mobile device.

NOTE For more information about using the Configuration Manager, see Using Configuration Manager on page 72.
Configuring Telnet Client Display Settings

You can modify and customize the way that the Telnet Client displays, including:

- Whether the Windows Start menu displays while the Telnet Client is active.
- Whether the Telnet Client menu displays while the Telnet Client is engaged in a Telnet session.
- Whether the vertical or horizontal scrollbars display during an active Telnet session.

Use the Configuration Manager to customize these (and other) display features of the Telnet Client.

Table B-2 provides a list of display options and the parameters (in the Configuration Manager) that are used to customize these options.

<table>
<thead>
<tr>
<th>Display Option</th>
<th>Location in the Configuration Manager</th>
<th>Parameter Name</th>
<th>Default Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Windows Start Menu</td>
<td>Emulation &gt; Display</td>
<td>Hide Start Menu</td>
<td>&lt;Show Standard Start Menu&gt;</td>
</tr>
<tr>
<td>Hide Telnet Client Menu</td>
<td>Emulation &gt; Display</td>
<td>Hide Menu</td>
<td>&lt;No&gt;</td>
</tr>
<tr>
<td>Hide the Telnet Client Vertical Scrollbar</td>
<td>Emulation &gt; Display</td>
<td>Hide Vertical Scrollbar</td>
<td>&lt;Yes&gt;</td>
</tr>
<tr>
<td>Hide the Telnet Client Horizontal Scrollbar</td>
<td>Emulation &gt; Display</td>
<td>Hide Horizontal Scrollbar</td>
<td>&lt;Yes&gt;</td>
</tr>
<tr>
<td>Create a Key Sequence to Hide/Reveal the Telnet Client command bar</td>
<td>Emulation &gt; Display</td>
<td>Menu Toggle Key</td>
<td>&lt;Default&gt; (No key sequence configured)</td>
</tr>
<tr>
<td>Specify the Font that Emulation Uses</td>
<td>Emulation &gt; Display</td>
<td>Font Name</td>
<td>&lt;Standard&gt;</td>
</tr>
<tr>
<td>Specify the Font Size that Emulation Uses</td>
<td>Emulation &gt; Display</td>
<td>Font Size</td>
<td>&lt;7&gt;</td>
</tr>
</tbody>
</table>

Table B-2: Customizing the Telnet Client Display

To configure a display setting:

1. Access the Configuration Manager.
2 In the Configuration Manager, locate the display option that you want to modify (see Table B-2).

3 Use the dialog box for the parameter to configure the display option.

4 Click OK.

5 Save the new configuration.

6 Close the Configuration Manager and download the new configuration to the mobile device.

**NOTE** For more information about using the Configuration Manager, see *Using Configuration Manager* on page 72.

### Configuring Telnet Client Lockdown

You can configure several Telnet Client parameters to effectively lockdown the Telnet Client and prevent users at the mobile device from launching other applications on the mobile device.

**NOTE** When you configure Telnet Client lockdown, record your passwords and key sequences in a secure location for administrative purposes. By configuring lockdown, you can effectively lock yourself out of the mobile device. If you forget the passwords that you have configured, you will be required to reboot the system and reconfigure the Telnet Client.

Use the Configuration Manager to lockdown the mobile device.

Table B-3 lists the parameters in the Configuration Manager that you must use to effectively lockdown the Telnet Client.

<table>
<thead>
<tr>
<th>Parameter to Modify</th>
<th>Location in the Configuration Manager</th>
<th>Parameter Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCE Hide Start Menu</td>
<td>Emulation &gt; Display</td>
<td>&lt;Hide Start Menu&gt;</td>
</tr>
<tr>
<td>WinCE Hide Menu*</td>
<td>Emulation &gt; Display</td>
<td>&lt;Yes&gt;</td>
</tr>
</tbody>
</table>

*Table B-3: Configuring Telnet Client Lockdown*
To configure Telnet Client lockdown:

1. Access the Configuration Manager.

2. In the Configuration Manager, modify the lockdown parameters (see Table B-3).

3. Save the new configuration.

4. Close the Configuration Manager and download the new configuration to the mobile device.

**NOTE** For more information about using the Configuration Manager, see *Using Configuration Manager* on page 72.

### Configuring Key Macros

Use the Configuration Manager to create, configure, or remove key macros for emulation.

**To configure a key macro:**

1. Access the Configuration Manager.

2. In the Configuration Manager, locate and right-click the **Emulation > Common > Key Macro** parameter.
A menu list appears.

3 From the menu list, select Add.

The Key Macros dialog box appears.

4 Use the Key Macros dialog box to configure the new key macro.

![Key Macros dialog box](image1.png)

**Figure B-5. Configuring a Key Macro**

5 After you have configured the key macro, click OK.

The new key macro now appears beneath the Key Macros parameters in the Configuration Manager.

![Configuration Manager with Key Macro](image2.png)

**Figure B-6. Key Macro in Configuration Manager**

6 Save the new configuration.

7 Close the Configuration Manager.
8 Download the new configuration to the mobile device.

**NOTE** For more information about modifying configuration parameters and using the Configuration Manager, see *Using Configuration Manager* on page 72.

### Configuring Screen Panning

Use the Configuration Manager to configure Telnet Client screen panning.

The screen panning feature of the Telnet Client allows a user to scroll around the screen by tapping and dragging the stylus. By default, screen panning is enabled on the Telnet Client.

Screen panning has two methods of operation:

- **Standard**
- **Reversed**

If you want to use reverse screen panning, you must enable standard screen panning.

**To configure screen panning:**

1. Access the Configuration Manager.

2. In the Configuration Manager, locate and right-click **Emulation > Display > Screen Panning**.

   The **Screen Panning** dialog box appears.

3. Use the **Screen Panning** dialog box to enable or disable screen panning for the Telnet Client.
Appendix B: Common Configuration Tasks

4  Click OK.

5  If you want to enable/disable reverse screen panning, locate and right-click Emulation > Display > Screen Panning Reversed parameters.

   The Screen Panning Reversed dialog box appears.

6  Use the Screen Panning Reversed dialog box to enable or disable reverse screen panning.

   **NOTE** For reverse screen panning to work, you must also enable screen panning.

7  Click OK.

8  Save the new configuration.

9  Close the Configuration Manager.

10 Download the new configuration to the mobile device.

**Configuring ActiveText**

Use the Configuration Manager to configure the ActiveText feature of the Telnet Client.

The ActiveText feature of the Telnet Client identifies certain strings of text and converts them to objects that a user can select-and-click.

The ActiveText feature can identify two types of strings:

- Simple menu item
• AS/400-style function key

By default, both types of ActiveText are enabled on the Telnet Client.

Table B-4 indicates the parameters in Configuration Manager that control the different types of ActiveText.

<table>
<thead>
<tr>
<th>ActiveText Type</th>
<th>Configuration Manager Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple Menu Item</td>
<td>Emulation &gt; Common &gt; Simple Number Menu Active Text</td>
</tr>
<tr>
<td>AS/400-Style Function Key</td>
<td>Emulation &gt; Common &gt; Function Key Active Menu</td>
</tr>
</tbody>
</table>

*Table B-4: ActiveText Parameters in Configuration Manager*

**To configure ActiveText:**

1. Access the Configuration Manager.

2. In the Configuration Manager, locate and right-click the parameter for the type of ActiveText that you want to configure (see Table B-4).

   A dialog box for the ActiveText type appears.

3. Use the dialog box to enable or disable the ActiveText.

   ![Function Key Active Menu](image)
   
   *Figure B-8. Configuring ActiveText*

4. Click *OK*.

5. Save the new configuration.

6. Close the Configuration Manager.

7. Download the new configuration to the mobile device.
NOTE For more information about modifying configuration parameters and using the Configuration Manager, see Chapter 4: Emulation Parameters on page 63.

Configuring Scan Handlers

Use the Configuration Manager to configure scan handlers.

Scan handlers allow you to define special functions that are applied to the processing of a scan. A scan handler allows you to strip data from the beginning or end of a scan and/or to replace certain characters within a scan.

To configure a scan handler:
1 Access the Configuration Manager.

2 In Configuration Manager, locate and right-click the Scanner > Common > Scan Handler parameter.

   A menu list appears.

3 Click Add.

   The Scan Handler dialog box appears.

4 Use the Scan Handler dialog box to configure a new scan handler.

   ![Scan Handler dialog box]

   Figure B-9. Configuring a Scan Handler

5 Click OK.

6 The new scan handler now appears beneath the Scan Handler parameter in the Configuration Manager.
Configuring Autologin for VT Emulation

You can configure the mobile device to send automatic responses to prompts from a host. This allows for automatic login for VT/HP emulation.

Because autologin is specific to each host system, autologin is configured in the Host Profiles dialog box.
To configure a mobile device for automatic login to a host:

1. Access the Host Profiles dialog box.

2. From the list of host profiles in the Host Profiles dialog box, select the host for which you want to configure autologin parameters.

3. Ensure that you have selected a VT-type or HP emulation type from the Emulation drop-down menu in the Host tab of the Host Profiles dialog box. (If you have not selected VT/HP emulation, you will not be able to configure a autologin.)

4. Select the Autologin tab.

5. Configure the Autologin tab.

![Figure B-11. Configuring VT Autologin](image)

6. After you have configured the Autologin tab, click OK.
7 Download the new configuration to the mobile device.

NOTE For more information about configuring host profiles, see Chapter 3: Host Profiles on page 29.

Configuring Autologin for 5250 Emulation

You can configure the mobile device to send automatic responses to prompts from a host. This allows for automatic login for 5250 emulation.

When configuring 5250 autologin for the AS/400, the QRMTSIGN system value must be set before the autologin will function properly. Use WRKSYSVAL QRMTSIGN and change the parameter to *VERIFY. This setting verifies that the user has access to the system, allowing the user to bypass the sign-on. The default is *FRCSIGNON.

Configuring Telnet Negotiation Strings for VT Emulation

A Telnet negotiation string is used to identify a mobile device to a host system and to present a client with the appropriate emulation options.

Because Telnet negotiation strings are host specific, they configured in the Host Profiles dialog box.

To configure a Telnet negotiation string:

1 Access the Host Profiles dialog box.

2 From the list of host profiles in the Host Profiles dialog box, select the host for which you want to configure the Telnet negotiation string.

3 Ensure that you have selected a VT-type or HP emulation type from the Type drop-down list in the Host tab of the Host Profiles dialog box. (If you have not selected VT/HP emulation, you will not be able to configure a Telnet negotiation string.)

4 In the Host Profiles dialog box, select the VT Settings tab.

5 In the Telnet Negotiation String text box, configure the Telnet negotiation string that the mobile device should use when connecting to the host system.
Configuring Workstation IDs for 5250/3270 Emulation

The Telnet Client allows you to dynamically generate a workstation ID for a mobile device. Because workstation IDs are specific to each host connection, workstation IDs are configured in the Host Profiles dialog box.

To configure the Telnet Client to dynamically generate a workstation ID:

1. Access the Host Profiles dialog box.

2. From the list of host profiles in the Host Profiles dialog box, select the host connection for which you want to configure a workstation ID.

3. Ensure that you have selected 5250/3270 emulation from the Type drop-down list in the Host tab. (If you have not selected a 5250/3270 emulation type, you will not be able to configure a workstation ID.)
4 Select the **IBM Settings** tab.

5 Use the **Workstation ID** text box to configure the dynamic generation of a workstation ID for mobile devices that use the host profile.

![Figure B-13. Configuring the Workstation ID](image)

6 Click **OK**.

   The new configuration is saved to the host system and the **Host Profiles** dialog box closes.

7 Download the new configuration to the mobile device.

### Enabling Battery Strength and Signal Strength Icons

Battery-strength and wireless signal-strength indicator icons are available in Telnet Client 5.1 (and greater versions). You may configure the following indicator-icon settings:

- Whether to display the signal strength icon
• Whether to display the batter power icon

• Whether to display the icon(s) on the Windows system tray, the Telnet Client command bar, or elsewhere on the screen

• The relative size (large or small) of the icon(s)

**To enable the battery power indicator:**

1. Access the Configuration Manager for the Telnet Client global emulation parameters.

2. In Configuration Manager, locate **Emulation > Display > Indicators.**

---

**Figure B-14. Configuring Indicators**

3. Use the **Enable Battery Strength Indicator** parameter to enable/disable the battery strength indicator icon.
4 Use the **Enable Signal Strength Indicator** parameter to enable/disable the wireless signal strength indicator.

5 Use the **Indicators Preferred Off-Screen** parameter to configure where the icon(s) are displayed (the Windows system tray, the Telnet Client command bar, or on the screen itself).

6 If you did not use the **Indicators Preferred Off-Screen** parameter to display icons only in the Windows system tray or Telnet Client command bar, then use the **Indicators Screen Settings** parameter to configure the location and relative size (large or small) of the indicator icon(s) on the screen.

7 Save the new configuration.

8 Close the Configuration Manager.

9 Download the new configuration to the mobile device.

**NOTE** For more information about configuring global emulation parameters, see Chapter 4: Emulation Parameters on page 63.

### Configuring Indicator Settings

Table B-5 provides information about configuring the indicator settings to meet your needs:

<table>
<thead>
<tr>
<th>Desired Effect</th>
<th>Parameter in Configuration Manager</th>
<th>Setting</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display icon(s) in Windows task-tray only</td>
<td>Emulation &gt; Display &gt; Indicators &gt; Indicators Preferred Off-Screen</td>
<td>&lt;System Tray Only&gt;</td>
<td>Do not hide the Windows start menu</td>
</tr>
<tr>
<td>Display icon(s) in Telnet Client command bar only</td>
<td>Emulation &gt; Display &gt; Indicators &gt; Indicators Preferred Off-Screen</td>
<td>&lt;Command Bar Only&gt;</td>
<td>Do not hide the Telnet Client command bar</td>
</tr>
<tr>
<td>Display icon(s) in Telnet Client command bar or Windows system tray (whichever is available, starting with the Windows system tray)</td>
<td>Emulation &gt; Display &gt; Indicators &gt; Indicators Preferred Off-Screen</td>
<td>&lt;Command Bar or System Tray&gt;</td>
<td>—</td>
</tr>
</tbody>
</table>

*Table B-5: Configuring Battery and Signal Strength Indicators*
### Display icon(s) on emulation screen (not in the command bar or the system tray)

Parameter in Configuration Manager:
Emulation > Display > Indicators > Indicators Preferred Off-Screen

Setting:
<No>

Notes:
—

### Specify location and size of icons

Parameter in Configuration Manager:
Emulation > Display > Indicators > Indicators Screen Settings

Setting:
Select your preferred option for location and size

Notes:
Set Indicators Preferred Off-Screen to No

<table>
<thead>
<tr>
<th>Desired Effect</th>
<th>Parameter in Configuration Manager</th>
<th>Setting</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display icon(s) on emulation screen</td>
<td>Emulation &gt; Display &gt; Indicators &gt; Indicators Preferred Off-Screen</td>
<td>&lt;No&gt;</td>
<td>—</td>
</tr>
<tr>
<td>Specify location and size of icons</td>
<td>Emulation &gt; Display &gt; Indicators &gt; Indicators Screen Settings</td>
<td>Select your preferred option for location and size</td>
<td>Set Indicators Preferred Off-Screen to No</td>
</tr>
</tbody>
</table>

**Table B-5: Configuring Battery and Signal Strength Indicators**
Appendix C: Wavelink Contact Information

If you have comments or questions regarding this product, please contact Wavelink Customer Service via email or telephone.

**Email:** customerservice@wavelink.com

**Phone:** 1-888-699-WAVE(9283)
## Glossary

### 802.11/a/b/g
The IEEE standards for wireless Ethernet. 802.11 provides for wireless networking speeds up to 2 Mbps at 2.4 GHz. 802.11b provides wireless networking speeds up to 11 Mbps at 2.4 GHz. 802.11a provides wireless networking speeds up to 54 Mbps at 5 GHz.

### access point
A device that acts as a bridge between wireless LANs and wired LANs.

### ad hoc mode
A mode of operation in wireless networks wherein wireless devices communicate directly with each other without the use of an access point. Also sometimes referred to as peer-to-peer mode or an independent basic service set (IBSS).

### AP
Access Point. See *Access Point*.

### automatic WEP
A dynamic implementation of WEP keys, wherein the key used on the wireless network changes periodically. Clients must synchronize their WEP key use with the AP.

### Avalanche Server
An Avalanche Console Server. A software component that provides the core functionality of Avalanche Console. The Server facilitates communication with Avalanche clients.

### Avalanche Client
A mobile device with an installed Avalanche Enabler, which allows the client to communicate with an Avalanche Server and to be configured and managed through Avalanche Console.

### Avalanche Enabler
A software component that is installed on mobile devices which allows you to configure and manage the device through Avalanche Console. The Enabler facilitates communication between the mobile device and a Server.

### Avalanche Enabler SDK
A software development kit that allows you to create Avalanche Enablers for Windows CE devices.
<p>| <strong>Avalanche Console</strong> | Wavelink Corporation's management application that allows you to configure and manage mobile devices throughout your network infrastructure. |
| <strong>Avalanche Monitor</strong> | A component of certain Avalanche Enablers that communicates with the Avalanche Server and, at certain times, checks for available updates. |
| <strong>Avalanche Update Utility</strong> | A component of certain Avalanche Enablers that provides most of the functionality. You can use the Avalanche Update Utility to configure the network parameters of the mobile device, view the progress of a download, and/or install updates that have been downloaded to the client. |
| <strong>Avalanche Software Package</strong> | A specially bundled piece of software, for example a firmware update to a radio card or a commonly used application, that you can download to a client through Avalanche Console. |
| <strong>Avalanche Update</strong> | A download (or modification) that is available to a client through Avalanche Console. Examples of updates include software packages and network profiles. The deletion of orphaned packages from a client through Avalanche Console is another type of update. |
| <strong>BOOTP</strong> | Bootstrap Protocol. A protocol that allows clients to automatically obtain IP parameters from a BOOTP server. |
| <strong>client</strong> | In the context of Avalanche Console, an Avalanche client. See <em>Avalanche Client</em>. In the context of the Telnet Client, a mobile device that connects via the Telnet Client to a host system. |
| <strong>DHCP</strong> | Dynamic Host Configuration Protocol. An IP service that allows DHCP clients to automatically obtain IP parameters from a DHCP server. |
| <strong>DNS</strong> | Domain Name System. A service that provides host name-to-IP address mapping. |
| <strong>.edf</strong> | Enabler Definition File |</p>
<table>
<thead>
<tr>
<th><strong>Emulation Parameters</strong></th>
<th>A feature of the Telnet Client that allows you to pre-configure and install terminal emulation-related functions to a mobile device.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Emulation Parameters, global</strong></td>
<td>Terminal emulation-related functions that apply to all host profiles that are configured on a mobile device.</td>
</tr>
<tr>
<td><strong>Emulation Parameters, host specific</strong></td>
<td>Terminal emulation-related functions that apply to only a specific host profile that is configured on a mobile device.</td>
</tr>
<tr>
<td><strong>Enabler</strong></td>
<td>In the context of Avalanche Console, an Avalanche Enabler. See <em>Avalanche Enabler</em>.</td>
</tr>
<tr>
<td><strong>Enabler Configuration Utility</strong></td>
<td>A software package that allows you to configure the various Avalanche Windows Enabler settings on a client from the Avalanche Console.</td>
</tr>
<tr>
<td><strong>Enabler Profile</strong></td>
<td>In the context of the Avalanche Enabler SDK, a set of parameters that a developer specifies that are used by the Avalanche Enabler SDK to produce an Avalanche Enabler. The parameters of the profile are stored in an <em>.edf</em> file.</td>
</tr>
<tr>
<td><strong>Enabler SDK</strong></td>
<td>See <em>Avalanche Enabler SDK</em>.</td>
</tr>
<tr>
<td><strong>ESS ID</strong></td>
<td>Extended Service Set ID. The identifier of an extended service set for devices that are participating in an infrastructure mode wireless LAN.</td>
</tr>
<tr>
<td><strong>FTP</strong></td>
<td>File Transfer Protocol. A TCP-based service that provides connection-oriented file transfers.</td>
</tr>
<tr>
<td><strong>FTP Server</strong></td>
<td>A host system that provides FTP services. Users are required to log into the FTP service to gain access to files that can be downloaded from the server.</td>
</tr>
<tr>
<td><strong>gateway</strong></td>
<td>A device on a local network through which data to other networks is routed. Also called a router.</td>
</tr>
<tr>
<td><strong>GUI</strong></td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td><strong>host</strong></td>
<td>A server or workstation that hosts a specific software or network service.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>host profile</strong></td>
<td>A service of the Telnet Client that allows you to install pre-configured host information (such as IP address and Telnet service TCP port) on mobile devices.</td>
</tr>
<tr>
<td><strong>IBSS</strong></td>
<td>Independent Basic Service Set. See <em>ad hoc mode</em>.</td>
</tr>
<tr>
<td><strong>ICMP</strong></td>
<td>Internet Control Messaging Protocol. Part of the TCP/IP protocol suite that provides services for testing IP network connections.</td>
</tr>
<tr>
<td><strong>IDA Commands</strong></td>
<td>A special value used to invoke a device action, program action, or emulator action within the Telnet Client Industrial Browser.</td>
</tr>
<tr>
<td><strong>infrastructure mode</strong></td>
<td>A wireless network configuration wherein devices communicate with each other through an access point.</td>
</tr>
<tr>
<td><strong>IP address</strong></td>
<td>Internet Protocol address. A virtual address that uniquely identifies a network connection.</td>
</tr>
<tr>
<td><strong>LAN</strong></td>
<td>Local Area Network</td>
</tr>
<tr>
<td><strong>lease</strong></td>
<td>A DHCP lease. The parameters surrounding the IP address a client has obtained from a DHCP server.</td>
</tr>
<tr>
<td><strong>localization</strong></td>
<td>A service of the TNCE Client that allows you to configure the TNCE Client to display in a specific language.</td>
</tr>
<tr>
<td><strong>MAC address</strong></td>
<td>Media Access Controller address. The hard-coded layer-2 address of a network connection which consists of a 12-digit hexadecimal number. The first 6 hexadecimal characters identify the manufacturer. The last 6 hexadecimal numbers are unique for each network device produced by the manufacturer. The MAC address is also sometimes called the hardware address.</td>
</tr>
<tr>
<td><strong>MB</strong></td>
<td>Megabytes</td>
</tr>
<tr>
<td><strong>Mbps</strong></td>
<td>Megabits / second</td>
</tr>
<tr>
<td><strong>META tag</strong></td>
<td>Tags that allow web pages to enable specific functionality in the browser.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>mobile device</td>
<td>A wireless device or a PC with a wireless network connection.</td>
</tr>
<tr>
<td>net mask</td>
<td>See subnet mask.</td>
</tr>
<tr>
<td>network profile</td>
<td>A set of pre-configured network parameters (ESS ID, IP address, and so forth) that can be downloaded to a client through Avalanche Console.</td>
</tr>
<tr>
<td>orphaned package</td>
<td>A software package that has been deployed to a client through Avalanche Console, but has been disabled or is not recognized by the Server. You must orphan a software package before you can use Avalanche Console to delete it from the client.</td>
</tr>
<tr>
<td>ping</td>
<td>An IP service that is used to test IP connectivity. Part of the ICMP service.</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory. Volatile memory in a computer system.</td>
</tr>
<tr>
<td>real-time statistics</td>
<td>A feature that allows the Telnet Client to send Telnet session information to Avalanche Console. That information can then be viewed from the Avalanche Client Controls dialog box. The real-time statistics feature is only available for Avalanche-deployed Telnet Clients.</td>
</tr>
<tr>
<td>RF</td>
<td>Radio Frequency. Usually used in the context of a type of network connection.</td>
</tr>
<tr>
<td>Resource Editor</td>
<td>A Telnet feature that allows you to import sound and picture files and deploy them to your mobile devices.</td>
</tr>
<tr>
<td>router</td>
<td>See gateway.</td>
</tr>
<tr>
<td>SDK</td>
<td>Software Development Kit.</td>
</tr>
</tbody>
</table>
**selection criteria**  A feature of Avalanche Console that allows you to configure a set of filters that target specific mobile devices on the network. You can filter by MAC address, IP address, device type, operating system, and so forth. Selection criteria are used to target specific mobile devices on the network for Avalanche Updates.

**Session Monitor**  An Avalanche-integrated component of the Telnet Client that allows a user at the Avalanche Console to monitor or control the Telnet Client. Session Monitor is available for Avalanche-deployed Telnet Clients only.

**silent install**  A feature of the Avalanche Enabler that allows for the installation of software packages on clients without the consent of the user at the device.

**silent mode**  A feature of the Avalanche Enabler that allows the Avalanche Monitor to run in the background on the client in a manner that is transparent to the user at the device.

**software package**  In the context of Avalanche Console, an Avalanche software package. See *Avalanche Software Package*.

**SSID**  Service Set Identifier. A unique name, up to 32 characters long, that is used to identify a wireless LAN. The SSID is attached to wireless packets and acts as a password to connect to a specific BSS or ESS.

**static WEP**  Static (or manual) implementation of WEP keys. When the administrator of the network changes the WEP key, users must manually select the correct key.

**subnet**  A logical network wherein each client is participating on the same IP network.

**subnet mask**  A type of filter that allows IP clients to determine which part of their IP address defines the network and which part defines the host.
TCP/IP  Transmission Control Protocol/Internet Protocol. A suite of protocols that provides virtual addressing, connection-oriented and connectionless communication, and a number of other network services and utilities.

Telnet  A TCP/IP utility that is used for terminal emulation and that allows a client to connect and interact with a remote host system.

TFTP  Trivial File Transfer Protocol. A UDP-based service that provides connectionless file transfers.

Telnet Client  Wavelink application that provides client-side terminal emulation services for Microsoft Windows and Windows-based mobile devices.

update  In the context of Avalanche Console, an Avalanche update. See Avalanche Update.

WEP  Wired Equivalent Privacy. An encryption standard for wireless networks that provides the equivalent security of a wired connection for wireless transmissions.

Windows CE  A Microsoft Windows-based operating system for mobile devices.

Windows Enabler  An Avalanche Enabler that is designed for Microsoft Windows 9x/ME/NT/2000/XP systems with installed 802.11a/b/g wireless cards.

WINS  Windows Internet Naming Service. A service that provides Windows name-to-IP address mapping.
Index

Numerics
5250/3270 virtual keyboard cxlvii
802.11/a/b ccliii

A
about
evaluation parameters lxvii
global emulation parameters lxviii
host profiles vi
keyboard creator vii
localization vi
maintenance licenses cxxvii
per-host emulation parameters lxvii
platform licenses cxxvii
screen reformatter vii
scripting vii
SSL vi
Telnet Client iv
Voice-Enabled Emulation viii
access point ccli
accessing
global emulation parameters lxviii
per-host emulation parameters lxxviii
activation method lxx xvii
on barcode, MSR or RFID Scan xc
on key combination lxxviii
on screen update xci
select from menu lxxvii
when session connects lxxix
activetext
configuring cccxxxix
using clii
ad hoc mode ccliii
adding
host profiles xxvi
alphabetized view, configuration manager lxxx
AP ccli
authorization cxxv
autologin for VT emulation,
configuring cclii
automatic WEP ccliii
Avalanche Agent cclii
Avalanche client ccliii
Avalanche Enabler ccliii
Avalanche Enabler SDK
edf, defined ccliv
enabler profile, defined cclv
Avalanche Manager, defined ccliv
Avalanche Monitor, defined ccliv
Avalanche software package, defined ccliv
Avalanche update ccliv
Avalanche update utility, defined ccliv

B
battery strength icon ccxlvi
beeps settings ccx
BOOTP ccliv

C
certificate verification, enabling xxxiv
client ccliv
cold boot recovery x
COM port, freeing cxxix
concurrent telnet sessions,
configuring cccxl
configuration manager
alphabetized view lxxx
find lxxix
using lxxvi
configuration support matrix xii
configuring
activetext cccxxxix
autologin for VT emulation cclii
emulation parameters lxviii
failover xxxviii
host profiles xxv
IP printing cccxiii
key macros cccxvi
license server IP address cccxxiii
number of concurrent sessions cccxxi
passwords cccxxix
scan handlers cxxi
screen panning cccxxvii
session monitor clxxvi
Telnet Client x
Telnet Client display settings cccxiv
Telnet Client lockdown cccxxv
Telnet Client with Avalanche Manager xiii
Telnet Client with Microsoft ActiveSync xvi
telnet negotiation strings for VT emulation cccxlv
TermProxy-only connections xxxvii
workstation IDs for 5250/3270 emulation cccxlv
connecting to hosts cccxxiii
contact information clxi
creating
command-line URL host profile xxx
creating script code xcii
cursor settings ccviii

D
deleting host profiles xxviii
demo license, using cccxxi
deploying
configuration xvii
configurations via Avalanche Manager xvii
configurations via Microsoft ActiveSync xxii
Resource Editor files cccxiii
deploying keyboards cxxvii
deploying scripts ciii
developing
web pages clxxiii

DHCP ccclv
diagnostics utility
accessing cliv
performing a keyboard test clvii
performing a scan test clviii
performing a Windows keyboard test clix
diagnostics utility, using clv
disconnecting a Telnet session cccxix
display settings cccv
display settings, configuring cccxxiv
DNS ccclv
document
assumptions iii
conventions iv
E
edit autologin cxciv
editing scripts c
emulation parameters
about vi, lxvii
configuring lxviii
defined cclv
global lxviii
global, defined cclv
manually configuring cccv
modifying lxviii
per-host lxvii
per-host, defined cclv
using configuration manager lxvii
Emulation Parameters, global ccclv
Emulation Parameters, host specific cclv
Enabler cclv
Enabler configuration utility cclv
Enabler profile cclv
enabling
certificate verification xxxiv
indicator icons ccxlvi
session monitor clxxvi
SSL xxxii
ESSID ccclv
executing scripts
  on barcode, MSR or RFID scan cv
  on key combination cv
  on screen update cv
  select from menu civ
  when session connects cv
  exiting the Telnet Client cxl
  exporting cii
  exporting scripts cii

IBM settings xlivi
language settings lvii
manually configuring clxxvii
modifying xxvii
more 5250 options cxci
more VT options cxciii
overview xiii
TermProxy settings xl
VT settings l
WEB settings xlvi

IBM Host settings cxcviii
IBSS cclvi
ICMP cclvi
IDA Commands, defined cclvi
importing keyboard graphics cxiii
importing scripts ci
indicator icons ccxlvi
Industrial Browser
  basic navigation clxxii
  host profile settings clxxii
  overview clxv
  using clxxii
infrastructure mode cclvi
initiating a Telnet session cxxxxvii
Initiating an Additional Telnet Session cxli
installing
  SSL support package on host system xxxi
  SSL support package on mobile device xxxi
  Telnet Client ix
IP address cclvi
IP printing, configuring cxxviiiii

key macros, configuring cxcxxvi
keyboard creator
  about vii
  launching cvii
overview cvii
keyboard files cix
keyboard test clvi
keyboards
  adding cx
  creating cx
  deleting cxii
  deploying cxvii
importing graphics cxiii
keys cxiii
  positioning rows cxvi
  sizing cxii
  sizing rows cxvi
keys
  adding keys cxiv
  configuring cxiii
  creating cxiii
  deleting cxvii
  positioning cxvi
  sizing cxvi

L
LAN cclvi
language settings lvii
launching
  Resource Editor cxix
  session monitor cllxviii
Telnet Client cxxxiii
Telnet Client from Avalanche cxxxv
Telnet Client from Windows cxxxiv
lease cclvi
license server IP address, configuring cxxxxiii
licenses
  maintenance cxxvii
  platform cxxvii
licensing
  demo license cxxxi
  manually licensing the Telnet Client cxxviii
methods cxxvi, cxxvii
overview cxxv
the Telnet Client cxxv
types cxxvii
using license server cxxix
localization
  about vi
  defined cclvi
lockdown, configuring cxxxxv

M
MAC address cclvi
maintenance licenses
  about cxxvii
MB cclvi
Mbps cclvi
message settings cxcix
META tag, defined cclvi
Microsoft ActiveSync
  creating a guest partnership ccxxiv
  creating a standard partnership ccxxix
  freeing a COM port ccxxix
  selecting connection method on host system ccxxvi
  selecting mobile device connection method ccxxv
mobile device cclvii
modem settings lviii
modifying
  emulation parameters lxxviii
  host profiles xxvii
  real-time statistics clxxxv
Modifying an Existing Host Profile xxvii
more 5250 options cxii
more VT options cxiii
multiple concurrent sessions cxli

N
net mask cclvii
network profile, defined cclvii
O
options menu clx
orphan package, defined cclvii
orphaned package cclvii
overview
  host profiles xxiii

P
partnership
  creating a standard partnership ccxix
  guest partnership cxxiv
passwords, configuring cxxix
performing script capturing xcvi
per-host emulation parameters
  about lxvii
  accessing lxxiii
  beeps settings cxx
  cursor settings ccxii
  display settings ccv
  font settings cciii
  IBM host settings ccxviii
  Industrial Browser settings ccxiv
  manually configuring ccxvii
  message settings ccxix
  printer settings ccxi
  telnet settings ccx
  view settings ccxi
  VTXX settings ccxvii
ping cclvii
platform license cxxvii
printer settings ccxi
deploying files cxxiii
editing files cxxii
launching cxix
overview cxix
playing sounds cxxi
using cxx
RF cclvii
router cclvii

S
saving scripts cii
scan handlers, configuring ccxli
scan test clviii
screen panning
  configuring ccxxxviii
  using clii
screen reformatter
  about vii
  using clxii
script capturing xcvi
script code cxxi
script editor lxxiii
  launching from Avalanche Manager lxxxiv
scripting
  about vii
  creating variables xcii
scripts cii
  activation method lxxxvii
  creating scripts lxxxvi
deploying cii
  editing c
  Field Data ID c
importing c
overview lxxxiii
saving cii
SDK cclvii
selecting
  host profiles xcv
Microsoft ActiveSync connection on host system ccxxvi
Microsoft ActiveSync connection on mobile device ccxxv
selection criteria cclviii
session monitor
configuring clxxvi
enabling clxxvi
launching clxxviii
session override clxxix
tracing sessions clxxx
using clxxvi
signal strength icon ccxlvi
silent install cclviii
silent mode cclviii
sizing keyboards cxii
software packages, defined cclviii
SSID cclviii
SSL
about vi
and host profiles xxxi
enabling xxxii
enabling certificate verification xxxiv
installing support package on host system xxxi
installing support package on mobile device xxxi
standard partnership, creating ccxix
static WEP cclviii
subnet cclviii
subnet mask cclviii
switching between active Telnet sessions cxliii

T
TCP/IP cclix
telnet cclix
Telnet Client cclix
about iv
authorizing cxxv
autologin for VT emulation ccxliii
cold boot recovery x
components v
configuration support matrix xii
configuring x
configuring activetext cccxxxix
configuring display settings cccxxiv
configuring IP printing cccxxii
configuring key macros cccxxvi
configuring license server IP
address cccxxiii
configuring lockdown cccxxv
configuring number of concurrent sessions cccxxi
configuring passwords cccxxix
configuring scan handlers cxxli
configuring screen panning cccxxviii
configuring telnet negotiation strings for VT emulation cccxliv
configuring with Avalanche Manager xiii
configuring with Microsoft ActiveSync xvi
configuring workstation id ccxlv
deployment methods v
diagnostics utility clv
disconnecting a session cccxxix
exiting cxl
functionality vii
initiating a Telnet session cccxxvii
installing ix
launching cccxxiii
licensing cxxv
licensing with license server cxxix
manually configuring emulation parameters cxxv
manually configuring host profiles clxxvii
manually licensing cxxviii
multiple concurrent sessions cxxli
options menu clx
overview v
real-time statistics clxxxi
session monitor clxxvi
using cxxxiii
telnet negotiation strings, configuring ccxliv
telnet settings ccx
TermProxy
and host profiles xxxvii
configuring failover xxxviii
configuring TermProxy-only connections xxxvii
TFTP cclix
tracing sessions clxxx

U
updates, defined cclix
using
activetext cliii
configuration manager lxxvi
find lxxix
Industrial Browser clxxii
real-time statistics clxxxi
Resource Editor cxx
screen panning cliii
screen reformatter clxii
session monitor clxxvi
session override clxxix
standard virtual emulation keyboard cxlv
Telnet Client cxxxiii
Telnet Client diagnostics utility clv
Telnet Client options menu clx

V
variables xcii
view settings ccvi
viewing real-time statistics clxxxii
virtual keyboard
5250/3270 cxlvii
using cxlv
VT/HP cxlix
WEB cclix
Voice-Enabled Emulation